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Beginner Tutorials

So you've come to learn the Blender, eh? You've made a great choice. This is one of the most powerful 3D animation and 3D 
creation tools out there, especially if you're short on cash. Learning how to use Blender can be a daunting task, so don't give 
up! But with the help of this wikibook, you can someday become a power-user and put those Maya folks to shame.

If you ever get stuck for some reason in a tutorial, there are a number of places you can turn for help. The best way to get help 
is, with an Internet Relay Chat (IRC) client such as X-Chat (http://xchat.org) , connect to irc.freenode.net and talk to blender 
users in the following channels:

#blenderwiki (irc://irc.freenode.net/blenderwiki) 
#blender (irc://irc.freenode.net/blender) 
#blenderchat (irc://irc.freenode.net/blenderchat) 
#blenderqa (irc://irc.freenode.net/blenderqa) 
#gameblender (irc://irc.freenode.net/gameblender) 

If you can't get help there, click the "discussion" tab at the top of the page that you're having trouble with, and explain your 
problem on that page. Wait at least 24 hours for some help.

If you're still not getting help, try asking for help in the BlenderArtists.org forums (http://blenderartists.org/forum) .

Tutorial Syntax

Next Page: Blender Interface
Previous Page: Beginner Tutorials

As you go through these tutorials, you will find yourself running into cryptic codes quite often. These codes refer to keys you 
need to press on the keyboard and buttons on the mouse you need to press. They are pretty standard throughout the Blender 
community at this point. You may wish to print this page for quick reference throughout this book.
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Keyboard

Special/Function:

ALT the Alt key on the keyboard
CTRL the Ctrl (Control) key on the keyboard

CMD the Command key on the keyboard (Macintosh) (the one with 
the apple drawing)

F1 through F12 the F1 through F12 keys on the keyboard
SHIFT the Shift key on the keyboard
SPACE the Spacebar on the keyboard

TAB the Tab key on the keyboard
ENTER the Enter key on the keyboard

ESC the Escape key on the keyboard

Alpha-numeric:

AKEY through 
ZKEY the corresponding letter on the keyboard

0KEY through 
9KEY

the corresponding number on the keyboard (above the letters)
on the keyboard—not on the numberpad

Numeric pad:

NUM0 through 
NUM9

the corresponding number on the numberpad—not on the 
keyboard above the letters ('Num Lock' usually needs to be 
enabled)

NUM+ and NUM− the corresponding key on the numberpad

Note that in Blender, there is a big difference between the numbers on the number pad of your keyboard, and the 
numbers along the top of the keyboard.
For laptop users: You should be able to use the numlock function on your keyboard to convert the 7-9, U-P, J-;, and M-/ 
keys into a numeric keypad. On most modern Windows laptops there is a blue "Fn" key near the left "Ctrl" key. Hold that
and press the blue "NumLk" (usually F11) key. If not, see your owner's manual. If your laptop does not have some way to
emulate a numeric keypad, you can use the "Emulate Numpad" function built in to Blender. Point at and drag down from 
the bottom edge of the "File", "Add", "Timeline" menu bar, to pull out a new panel. One of the buttons on that panel is 
"System and OpenGL". Click the "Emulate Numpad" button, to make your regular keys on top of the keyboard behave 
like ones on a number pad.
For Macintosh laptops, the F6 key without any modifiers turns on Keypad lock, wherein the right hand alpha keys 
emulate a numeric keypad. You must be sure to use F6 again in order to restore normal keyboard operation. You might 
find it a bit more convenient to instead hold the [fn] key on the bottom left of the keyboard to momentarily shift the keys 
to their number pad function.
For Windows 2000/XP users, do not press right Shift five times in a row as it turns on the Windows Sticky Keys. Doing
so will mess up the ability for your keyboard to recognize commands. If the box for sticky keys appears, press cancel
(better yet, if you don't need accessibility features, go to Start → Settings → Control Panel; select Accessibility Options,
and for each of the options, StickyKeys, FilterKeys, and ToggleKeys, (1) clear the "Use …" checkbox, and (2) press the
"Settings…" button and clear the "Use Shortcut" checkbox).

3-button Mouse

LMB the left mouse button
RMB the right mouse button
MMB the middle mouse button
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[Note: If you don't have a MMB, you can use Alt-LMB to do the same.]

Gnome users, it is suggested not to use the "Find Pointer" function in Gnome's mouse settings. If your mouse pointer is 
being highlighted when you press and release CTRL go to "Mouse" in Gnome's "Desktop Settings" and uncheck the box 
under "Find Pointer". Otherwise it will impair your ability to use certain functions such as "snap to grid" or using the 
lasso tool.

Apple 1-button Mouse substitutions

LMB the mouse button (default)
RMB Apple (aka Command) key + the mouse button
MMB Option (Alt) key pressed + the mouse button

[Note: While Mac OS X natively uses the "Control" key to emulate the RMB, recent Blender versions for Mac OS X use the 
"Command" key for RMB, and the "Option" key for MMB. This behavior is also noted in the "OSX Tips" file that comes with 
the Mac version.]

Wheel mouse

SCROLL refers to scrolling the wheel of the mouse

Path menu

SPACE → Add → Mesh → UVsphere

means :

hit SPACE and, in the menu that comes up, choose Add then Mesh then UVsphere.

Next Page: Blender Interface
Previous Page: Beginner Tutorials

Become Familiar with the Blender Interface

Next Page: Blender Windowing System
Previous Page: Tutorial Syntax
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Next Page: Blender Windowing System
Previous Page: Tutorial Syntax

Learn the Blender Windowing System

Next Page: The User Preferences Window
Previous Page: Blender Interface

An Interface, Divided, Will Surely Stand
The Blender interface can be a bit intimidating at first, but don't despair. We will explore the power and flexibility of the 
Blender windowing system, and how to adapt it to suit your needs, one step at a time. First, we're going to talk about 
manipulating the 3D Viewport and the Buttons Window.

The Blender Windowing System is a treat. I know, it looks like some sort of space-ship control panel and you
have never seen anything like it. Once you learn it, however, you'll wish all your programs worked this way. 
Move on to the next page to learn more.
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The 3D Viewport's grid represents Blender Units (BU). A BU can be as large as you would like it to be: an inch, a centimeter,
a mile, or a cubit. A BU lets you decide the scale.

Window Headers
Every window has a window header. The window header can be at the top of a window, at the bottom of a window, or hidden. 
Let's take a look at the window headers for our 3D Viewport and our Buttons Window.

Go ahead and open Blender if you haven't already. You'll hopefully be presented with something that looks a 
lot like this. You should be able to see two major divisions. There are actually three, but the third one is 
hidden. We'll talk more about the hidden one later.

3D Viewport

This top larger portion is the 3D Viewport window. It 
allows you to see and manipulate the 3D objects in your 
3D scene.

Buttons Window

This section on the bottom is the Buttons Window. The buttons in the Buttons Window will allow you to 
manipulate the 3D objects you see in the 3D Viewport in many different ways.
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The active window is the window that will respond to what you type on the keyboard when you're using keyboard shortcuts. 
One of the windows in Blender will be active at all times.

Making another window active is simple: simply move the mouse over one of the windows to make it active! Try changing the 
active window by moving your mouse rapidly between the 3D Viewport and the Buttons Window now. You'll notice that the 
window's header lights up when it becomes active.

Changing the Window Type
There are many window types other than the 3D View and the Buttons Window, and you can easily switch any window to any
other window type at any time.

The header for the 3D Viewport is highlighted 
in red. Notice that it's actually at the bottom of 
the 3D Viewport, and not at the top.

The header for the Buttons Window is 
highlighted in blue.
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Resizing Windows
Resizing windows is easy and fun.

You'll notice that as you increase the size of one window, you decrease the size of the other. Blender does not allow the 
windows to overlap, as they would in other programs. This is why Blender's interface is known as a non-overlapping window 

To change window types, simply click the leftmost button on the 
window header (highlighted here in red) and a menu will appear. 
Choose the Buttons Window from the list. You will now have two 
Buttons Windows on the screen!

At this point, having two Buttons Windows will not 
do us any good (but it will be useful later). Click the 
button again to change the window back to 3D View.

step 1

Hold your mouse over the border between the two windows that is indicated by the red box below, and the 
mouse pointer will change to up/down arrows (or a hand on Mac OS X).

step 2

Click the border with the LMB (meaning Left Mouse Button) and drag up and down.

step 3

Once you've decided where to resize to, release the LMB.
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interface.

Splitting Windows

Joining Windows

step 1

Splitting windows is 
just as simple as 
resizing them. Click the
same border that you 
did last but this time 
with the RMB (Right 
Mouse Button).

step 2

A menu will then 
appear. Choose Split 
Area from the menu.

step 3

You'll see a preview 
line appear that will 
follow your cursor. Try 
dragging your mouse 
over both the 3D 
Viewport and the 
Buttons Window. You'll
notice that this preview 
split line will follow 
you from window to 
window.

step 4

You can finalize where you 
want to split by simply 
pressing the LMB. You 
should then have two 
windows where before there 
was only one!
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Next Page: The User Preferences Window
Previous Page: Blender Interface

The User Preferences Window

Next Page: The Buttons Window
Previous Page: Blender Windowing System

Showing the User Preferences Window

step 1

To rejoin the windows 
you just split, simply 
click on the border you 
just created with the 
RMB, and choose Join 
Areas from the menu.

step 2

An arrow will then appear so that you can indicate in which 
direction you would like to join the windows. As you move your 
mouse from the left window to right window, the arrow will 
change directions. Joining to the left means that the window on 
the left will be erased, while joining to the right means that the 
window on the right will be erased.

Join the windows in either direction for now.
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The first window we'll teach you in detail is the User Preferences window. This window is mostly hidden by
default, because most of the time you won't need all of its contents. Only the header (outlined in red) is 
visible here.

step 1

To make the User Preferences window visible, you just need to resize it. You do that the same way that you 
resized the other windows in the previous tutorial. Click with the LMB on the border along the top of the 3D 
Viewport, and drag.

step 2

Release the LMB to resize the windows. You should then have the entire User Preferences window visible!
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Configuring and Saving Your Preferences

Setting Up Auto Save

Adjusting The Theme

Clicking LMB on the "Themes" button will show a drop-down menu in the top left of the user preferences window which can 
be used to select different themes. Below this are buttons labeled "Add" and "Delete" that can be used to (surprise!) add and 
remove themes. Note the delete button does not appear for the default theme. The other controls that appear in the user 
preferences window while the themes button is active are to adjust the parameters that are specific to the current theme.

More Undo Levels

The first thing you'll want to do is enable Auto Save. 
Auto Save will help you avoid the loss of important 
work in case Blender crashes, your power is cut off, 
etc.

step 1

To show the Auto Save options, click the 
Auto Save button (outlined here in blue).

step 2

Next, adjust the Auto Save Settings:

Auto Save Temp Files - enabled by default, 
this turns the Auto Save system on and off. 
Leave it on.
Minutes - how often should your work be 
auto-saved?
Open Recent - use this to recover your work 
if Blender crashes.
Save Versions - how many versions of the file
should Blender auto-save?
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Emulating the Numpad

By default the Numpad keys control the 3D viewport, while the normal numeric keys change the view layers. Emulating the 
Numpad, in effect, allows the user to control the 3D viewport using the normal numeric keys on the keyboard. This replaces the
default function of the keys, but does not affect the Numpad.

This is useful for computers/laptops where there is no physical Numpad available.

Saving Your Preferences

The next thing that we want to do is take a look at the Undo Settings. By default, Blender will remember 32 
of your previous actions in memory and allow you to undo all the way to that point. If you have a good 
computer with a lot of memory, you might want to increase that limit (up to 64), while if your computer is 
old and sickly, you may consider decreasing it to 10 or 20.

step 1

To show the Undo Settings, click the Edit 
Methods button.

step 2

The Undo Settings will then be visible. Use the 
slider to change the number of steps to any number 
(between 0 and 64). Keep in mind the amount of 
memory your system has, as we discussed above. 
Too many undo steps can slow your computer down,
but the more you have, the easier it is to go back to a 
previous spot.

step 1

Navigate to the 'System & OpenGL' tab (outlined in blue) to open the menu.

step 2

Click on the 'Emulate Numpad' button (outlined in red) to enable it. If it is already in this darker 
shade of green, it is already enabled.
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Next Page: The Buttons Window
Previous Page: Blender Windowing System

The Buttons Window

Next Page: The 3D Viewport Window
Previous Page: The User Preferences Window

What's with all the buttons?!

Finally, you may want to keep your preferences as the default 
preferences whenever Blender starts up, unless you prefer to set 
them up everytime.

step 1

Expand the File menu. To do so, click on the 
File button on the User Preferences window.

step2

Click on the Save Default Settings button in 
the File menu to save your preferences.

alternative

Alternatively, you 
may press the 
Ctrl+U keys' 
combination to 
achieve the same 
purpose.
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Mini-Windows

Button Types

The Buttons Window is one of the most powerful tools that Blender has. When you have objects selected in 
the 3D viewport, there will be a number of operations you can perform on the objects by pressing the buttons 
in the Buttons Window. For example, suppose you have modeled a person. People have different skin colors, 
eye colors, hair colors, and more, so you will create a material to make the person appear as you would like it
to appear. The buttons window also handles sky color, render settings, animation, and a whole lot more.

There are many groups of buttons available to you in the Buttons 
Window. The buttons outlined here in red allow you to change the 
type of buttons that are currently being displayed. Click several 
buttons and notice the entire Buttons Window changes when you 
choose a different type.

You can only display one type of buttons at a time in your Buttons Window. This may seem like a limiting 
factor, but keep in mind that you can create as many different Buttons Windows with your interface as you 
would like and they can all be displaying different buttons, giving you quick access to anything you need to 
do.

You'll notice that within the Buttons Window there are Mini-Windows (ie: panels) such as those outlined 
here. Many manipulations can be performed with these windows, but for now we will only teach you the 
most important two.

The first thing you can do is click the top of the Mini-Windows with the LMB and drag them around. Try it! 
Also, try dragging and dropping them onto other Mini-Windows to make them join together.
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Logic Buttons

Script Buttons

These permit connecting various events in Blender to scripts, thus extending Blender's functionality. Scripting itself is an 
advanced topic.

Shading Buttons

Nothing here yet, but there will be soon!

Object Buttons

You can press F7 to cause the Object Buttons to appear. It should be noted that these are not the same buttons that appear when
you choose Object Mode in the 3D Window. Some tutorials may refer to pressing the F7 key to change to "Object Mode," and 
some will say you should press the Tab key to change to Object mode.

The Tab key changes from Edit Mode to Object Mode in the 3D Window, and F7 changes the Buttons Window to show the 
Object Buttons.

Edit Buttons

These are buttons used to edit objects in edit mode. You can press F9 to get the edit buttons. To get to edit mode (In the 3d 
window) Press TAB

Scene Buttons

Here we have selected the first buttons type, the Logic Buttons. We won't be using these buttons much for a 
long, long time. They are for use with the Game Engine.
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nothing here yet: Basically these are for rendering (taking pictures) and animating (making movies). We'll get back to these.

Next Page: The 3D Viewport Window
Previous Page: The User Preferences Window

The 3D Viewport Window

Next Page: Other Windows
Previous Page: The Buttons Window

The Blender 3D Viewport Window is where you will be spending most of your time. Blender 3D gives you 100% control of 
how you're seeing your world. Here are a few things you can do to learn how to use the 3D Viewport.

Rotating the view

Make sure the 3D Viewport window is active by placing the mouse pointer anywhere inside of it.
Hold down the MMB and drag the mouse from side to side and up and down.
Hold ALT+LMB for the same effect (on some Window-managers on Linux this won't work, it'll only move the Window.
You can change this behavior in most cases in the Window Manager's settings)
To rotate so that "upwards" stays "upwards", use CTRL+ALT+SCROLL

NOTE: if you have your own setting for the MMB in mouse configuration, you must reset this to use the MMB as a real 
Middle Mouse Button (no Doubleclick or something else). Otherwise you must use the alternate ALT+LMB for the same effect.

NOTE: for single button mouse users make sure that Emulate 3 Button Mouse is on in the View & Controls menu

It's a cube! Holding down the MMB is the quickest and easiest way to rotate your view and get a new perspective on things. 
Right now you're looking at the cube in what's known as Wireframe Mode. Pressing ZKEY (yes, on your keyboard, the Z key) 
will toggle back and forth between Wireframe Mode and Solid Mode. Pressing NUM5 while NUM LOCK is on will toggle 
between Orthographic and Perspective (perspective looks more natural). This does not affect how your final product will 
appear, only the way you see your scene while you're creating it.

As you move the view around, you will see that there are three objects in your 3D scene by default:

Object 
Icon Name Description

Camera

The camera location and rotation will determine what you will see at render time. To see in your 3D 
viewport what the camera will see, activate that window by pressing NUM0 (remember the 0KEY is 
different). You may need to make sure NUM LOCK is on on your keyboard. To switch out of the 
camera view, drag the MMB.

Lamp A lamp is simply a light source. It will not be rendered, but the light it provides to the scene will be 
rendered.

Cube This object will be rendered. The camera should be pointing at the cube so that you will see it at 
rendertime.

Later you will learn more about how to use each of these.
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[NOTE: If you are using a keyboard which doesn't have a numpad, e.g. a laptop, see 
laptop commands below.]

Holding the mouse over your 3D Viewport and pressing the NUM7, NUM1, and 
NUM3 buttons will bring you back to perfectly aligned top, front, and side views 
respectively. Pressing CTRL+NUM7, CTRL+NUM1, and CTRL+NUM3 will result 
in displaying the bottom, back, and other side views, respectively. Try each of these 
views, and watch the camera and light move around with respect to your new viewpoint
(make sure your NUMLOCK is on. Otherwise, this will not work).

Similarly, holding the mouse over a viewport and pressing NUM2, NUM4, NUM6, 
and NUM8 will rotate (by 15 degrees) the view down, left, right, and up respectively.

The object the viewport orbits around can be changed to a new object by first selecting it with the RMB and then pressing 
NUM. (the period key on the numpad) or NUM, (the comma key on the numpad) on some keyboard layouts.

[NOTE: selecting an object with the RMB will only work if your viewport is set to 'Object Mode'. Press the TAB key to toggle 
between 'Edit Mode' and 'Object Mode'.]

Again, remember in Blender that there is a big difference between the number keys on your numberpad and the number keys 
along the top of the keyboard. For example, NUM7 refers to the number 7 on the numberpad, while 7KEY refers to the number
7 that's above the YKEY and UKEY on the standard US keyboard. If you accidentally pressed 1KEY, 3KEY, or 7KEY during
this step and it appears that everything disappeared, you have been changing the layer that you are viewing instead, press the 
'key (backtick key -- on US keyboards, this is the key to the left of the 1KEY) to return to viewing all the layers, or press the 
1KEY to get back to viewing layer 1 which should have been originally active.

[NOTE: the 1KEY through 0KEY and alt-1KEY through alt-0KEY switch layers. Hold shift to select more than one layer. 
`KEY selects all 20 layers. Layers will be covered later.]

For laptop users: the num lock

As previously mentioned in this tutorial, recent laptops (some PC and all recent Mac) have a set of regular keys (from M in the 
lower left to 9 in the upper right) with additional markings corresponding to a regular numpad. This behavior can be toggled 
with F6 (or the key labelled num lock, this may require pressing FN+numlock key) (FN+F11 on many modern notebooks). If 
nothing else works, or as an alternative, you can temporarily activate the numpad behavior by holding the FN key (lower left 
corner of the keyboard) and using the keys as a numpad until you release FN. This allows convenient use of the numpad camera
controls without interfering with the normal use of that set of keys. Also you may pull down the User Preferences window, at 
the top (menu bar window), choose the "System and OpenGL" button, and click on "Emulate Numpad" to use the normal 
numbers as if they were the number keys on the pad (NUM0 == 0KEY at that point).

For simply rotating around the object, press Alt+LMB and drag.

If you envision using your laptop for this kind of work, or indeed any work involving numeric data inputting, it may be worth 
investing in a USB Numeric Keypad, as Blender uses the numeric keypad quite a bit. Prices range from between $15 to $20 for 
a basic keypad.

Panning the View

To pan the view, you have your choice of alternatives:

SHIFT+MMB
SHIFT+ALT+LMB

—and move your mouse. Alternatively, if you have a scroll wheel you can use SHIFT+Scroll to pan up and down and 
CTRL+Scroll to pan left and right.

Numpad
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You also have choice of keyboard alternatives:

Panning is an important skill to master; try it now.

Note that you must press SHIFT before MMB, otherwise your view will rotate instead of panning.

Also note, that in Windows XP the simultaneous pressing of SHIFT+ALT is used to switch the keyboard layout (for example 
QWERTY becomes AZERTY and vice versa). So when you find your keyboard layout all messed up, press SHIFT+ALT
again, until it fits.

Using SHIFT+MMB instead is recommended.

Zooming the View

Zooming in and out the view is also important. Again, Blender offers you several ways to do what you need to do:

If your mouse has a scroll wheel, scroll it.
CTRL+ALT+LMB and scroll up and down (not left or right)
CTRL+MMB
NUM+ and NUM-

Try these all out. Can you see this being useful?

Pro Tip

If you can, find a mouse with side buttons. Anything like Microsoft's Intellimouse, or Logitech's Mediaplay, that have 
back/forth buttons, will do. Map those buttons to the MMB. This makes camera control feel a LOT more intuitive (plus it
frees up a finger).

Placing the 3D cursor

Click the LMB to the right of the cube, half-way between the edge of the window and the cube. The red and white circle (the 
3D cursor) moves to where you clicked. Orbit the view again and notice that the 3D cursor marks a point in 3D space.

In any given rotational perspective, the set of possible 3D points where you can place the cursor is defined by the plane of your 
screen. If you're looking at the standard plane straight-on (meaning the standard plane is exactly parallel to your screen), you 
will place the cursor at the same height above or below the standard plane no matter where you click. Don't worry, you'll 
understand this point soon enough.

A more interesting experiment is to rotate the standard plane so the left end is farther away from you (and thus farther away 
from the plane of your screen) than the right. In this view, placing the cursor on the left will put it more toward the front of the 
plane, and placing it on the right will put it more toward the back.

Make sure the 3D View is in "Orthographic" mode by clicking "View" and selecting "Orthographic", and then try the following
exercise: put the 3D cursor inside the camera (the pyramid-shaped object situated to the bottom left from the cube by default in 
top view). Be sure to view the scene from different angles to make sure the cursor is in fact inside. Now put the cursor back 
inside the cube. (Reader's Note: Make sure not only that you are in object mode but also that the '3d Transform Manipulator' is 
off. This is toggled by the small index finger button in the 3d View Window/Bar. Toggle it a few times to get the hang of the 
difference.)

          CTRL+NUM8                NUM:      Up
CTRL+NUM4           CTRL+NUM6          Left      Right
          CTRL+NUM2                         Down
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If you're finding this difficult, try this: Press NUM7 to get to the top view and click on the position at which you want to place 
the 3D cursor. This will set two of the axes of the cursor precisely (X and Y), but the Z could be above or below the point you 
want. To fix this, press NUM1 to get to another view, and click again on the position to place the cursor at. With these two 
clicks, Blender will have all the 3 coordinates of the cursor position and you will have placed it exactly.

(Yet another reader: When you want the cursor back into the cube, just select the camera with RMB, put the cursor into the 
cube following the steps above, and re-select the cube with RMB.)

(Reader:- I've discovered it helps a lot if you are in Object Mode and not in Edit Mode. I wrote the following before 
discovering this:- The problem with this exercise, for me, is that left clicking on the cube selects the cube instead of moving the 
3d cursor. If I click on the cube outside of its central white circle I can get the cursor to move there, but only to outside of this 
white circle, and even then this only works sometimes.)

(I failed at this until I had zoomed in close enough to the cube. When I was too far zoomed out I kept selecting the cube rather 
than creating an edit point. Another reader: I had the same problem and found it was because the cube was selected. I made 
sure I was in object mode, right clicked on the camera to select the camera instead of the cube, and I could then position the 
edit point in the cube. However, doing this messed up the next part of the tutorial because you cannot switch into edit mode 
with the camera selected! Perhaps the suggestion of trying to put the 3D cursor in the cube should be dropped as it raises too 
many questions at this stage.)

(Yet another reader: you can deselect all by pressing the AKEY or the select button in the 3D View)

(And one more reader: I found that I would select the cube when left clicking on it if, when in object mode, the "Use 3d 
transform manipulator" setting was enabled. To toggle this setting, you click on the gray pointing hand in the 3d panel header.)

(Reader-use wireframe mode works better to get the cursor in)

Reader - To get it back in the cube: 1. make sure you're in object mode 2. select the cube 3. Object -> Snap -> Cursor to 
selection (cursor refers to the 3D cursor here so it puts it right in the middle of the cube)

Adding and Deleting Objects

Make sure you are in Object Mode. If not, press TAB. When an object is selected, the TAB key switches between the edit and 
object modes. A status bar at the top-right of the user preferences window will indicate the current mode by displaying 'Ob' or 
'Ed' depending on the currently toggled mode. Another way to check which view you are in is to check the bottom of the 3D 
view.

Click RMB (Cmd+LMB on Mac) on the cube to be sure it's selected. Press the XKEY or 
DELKEY to delete it. [Make sure you have your cursor in the center of the cube before 
deleting it. See the previous section (in the reader's notes) if you don't know how to do this] A 
window will prompt you to erase object. Click "Erase Selected."

To add an object, press SPACE. A menu comes up which is called the Toolbox. Select Add
→ Mesh → Monkey. (or just Add → Monkey if you are in Edit mode) [If you prefer the
monkey to be facing frontwards, make sure to be in FRONT view (numpad 1) before adding
the mesh]

A new object will be added, and you will be in what's known as Edit Mode. Press TAB to get out of Edit Mode, then CKEY to
center the screen on the cursor (where the monkey appeared). Press ZKEY a couple of times, which toggles the 3D Viewport 
between drawing the monkey solid and drawing it wireframe. Zoom in and out for a closer look (scroll the MMB, NUM+, or 
ALT+CTRL+LMB).

Next Page: Other Windows
Previous Page: The Buttons Window

Other Windows
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Next Page: Learn to Model
Previous Page: The 3D Viewport Window

Just when you thought that you were getting the hang of the Buttons window and the 3D Viewport window, there are several 
more windows to learn about. Have no fear; we will gently guide you through this book and teach you about these windows as 
the need arises. For now, your only need is to know of them, to be aware of your many options.

In the 3D viewport window, you'll see a button on the header all the way to the left that has a grid on it (if not, click on 
a window separator with the RMB or MMB and choose "Add Header"). That button allows you to switch window 
types. Click on it with the LMB and you will see a number of different window types to which you can change. Try 
some of the different window types; you will learn about their relevance in time.

Change the window back to the 3-Dimensional Viewport before moving on to the next tutorial.

Next Page: Learn to Model
Previous Page: The 3D Viewport Window

Learn to Model

Learn to Model

Next Page: Beginning Tips
Previous Page: Other Windows

The most basic part of 3D development is modeling, because this is where you create content, or 'models.' Creating 3D models 
is fun and sometimes challenging.

On the next page, you will take the first step in learning how to model. If you're excited, great! But if you're scared, don't worry; 
it starts out very easily. Give yourself time and patience; Pixar and Dreamworks will still be in business when you're ready for 
them!

Next Page: Beginning Tips
Previous Page: Other Windows

Beginning Tips

Next Page: Quickie Model
Previous Page: Learn to Model

These are some basic tips that are often asked for in one form or another. Sometimes it is in reference to something completely 
different, but the basic methodology will work.

Starting with a box
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Tutorials will often start with the default cube you see right after opening Blender. Here are 
different ways to reset the scene without quitting the application:

type CTRL+XKEY;
or select File -> New from the menu, and then confirm that you wish to erase your 
current scene.

The cube shows as a square in the 3D viewport (if you rotate the view with MMB, you'll see it 
is actually a cube). It is selected by default.

Note: If your scene has changed since you first opened Blender and you click File>Save 
Default Settings, your current scene will now be used as the default when you click File>New.
This is very handy Indeed.

Subdivision Surfaces

Subdivision surfaces, or subsurfing, is a common technique in 3D modeling. It uses a mathematical process of simulating a 
curved plane in space according to the placement of control points, or vertices. What this means is that you can create an object 
with a smooth surface that is easily controlled by relatively few vertices.

Adding a Subsurf modifier

First, choose the Editing panel set:

click on the  icon in the panel list : );
or press F9.

Then find the Add Modifier button in the Modifiers panel (scroll with the mouse 
wheel to find it). Pressing this button will pop up a list of available modifiers, from 
which you should select Subsurf. Older versions of Blender had a Subsurf button in 
the Mesh panel.

You'll see a Subsurf panel appear inside the Modifiers panel (see picture), and the 
cube in the viewport will take on a rounded look as the modifier's default settings 
are applied.

Tweaking the subdivision levels

Among the options in the Subsurf panel you will find two important options : Levels and Render Levels. The higher you set 
Levels, the more times the smoothing algorithm will be applied, and the smoother your mesh will look. Levels only affects the 
cube in the 3D view; you must use Render Levels to specify the number of levels used when rendering.

Try increasing Levels from 1 to 2 and see how the cube deforms.

Default cube

The Subsurf modifier
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But I want a box!

Often, you will want to render with your model having some sort of subsurf turned on. Face it, most things in real life just do 
not have super sharp edges. It is often the case that objects in the real world will have some sort of softer edge on it (unless it is 
a knife edge, or a block of material that has been machined in the shop!). It is just this fact that is often overlooked by people 
starting out in 3D : CG can sometimes look too perfect, resulting from impossibly sharp, clean, and well defined edges.

This effect can be fixed by telling Blender that we want our cube to retain more of its original shape. We'll do this using a tool 
called Edge Creasing. Each edge in a Blender model has a crease value associated with it, which is used to tell the Subsurf 
modifier how sharp we want that edge to be. By default, all edges have a crease of 0, which is why our cube has lost all its 
sharp edges.

Show subdivision surface's cage

Now, remember what we said about the Subsurf modifier remembering our original cube 
shape? Press TAB to go into edit mode and you'll see that the original cube has come back to 
haunt us as a wire frame around the smoothed cube.

Before we fiddle with the creasing, set the Subsurf Levels up to 3 so you can see the effect 
more clearly.

Choose an edge to crease

Enter Face mode:

by pressing CTRL+TAB (choose Faces);

or clicking on this icon: .

Select one of the sides of our wire cube with RMB (this can be done by clicking near the dot in the centre of the face).

Note that, although we are in Face mode, it is really the edges that we are creasing ; selecting a face is just a quick way of
selecting its four edges.

Crease selected edges

Levels set to 1 Levels set to 2

Subsurfed cube in Edit mode
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Now press SHIFT+E and your mouse will be tied to the cube with a dotted line. Move it 
gently left and right to see the effect it has on the mesh.

Click LMB to apply the changes, click RMB to cancel out last crease change.

Finally build a real box

Either cancel the above edge crease or start from scratch to get back to our simple subsurfed 
cube. Then press the A key twice to select all faces. Crease them with SHIFT+E like before, 
until your cube looks like the image on the right.

Press TAB to cancel out of edit mode. Behold: your smooth cube.

Note for beginning users : where the SubSurf option makes your model a lot smoother, it also skews the base mesh you are 
calculating from. This can cause large amounts of duplicate vertices and in many cases, very messy meshes when they aren't 
being SubSurfed. Be very careful when using this option, as it can cause problems down the road if you're not watching your 
source mesh. This form of surface calculation can also skew skins, making an object very hard to skin later on. This is 
something you will not run into for a long while in this tutorial, but it is a concern to keep in mind.

Next Page: Quickie Model
Previous Page: Learn to Model

Quickie Model

Next Page: Quickie Render
Previous Page: Beginning Tips

Your first model is easy.

Selecting objects

Start with the default scene. Clicking the RMB (Cmd+LMB on Mac) over an object selects it and the outline becomes pink. 
The cube should already be selected by default. You can use AKEY (Tap the "A" Key) to select or deselect all objects.

Edit Mode

Editing edge creases

All edges creased for a 
bevelled effect
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Right now you're in what's known as Object Mode. In Object Mode you can move the cube 
around the 3D environment in relation to other objects. Note that with the RMB you can also 
select the lamp or the camera, in which cases you won't be able to go into Edit Mode (Cameras and
Lamps are edited differently). With the cube selected, hit TAB. This puts you in what's known as 
Edit Mode. In Edit Mode, you can change the shape and size of the cube. You could turn the cube
into a puppy… or at least some day you'll be able to.

TAB - toggles in and out of Edit Mode of the selected, active object.

Selecting vertices

Now that you're in Edit Mode, you have access to the individual vertices. Vertices are control points that you can connect to 
create edges and faces. Edges connect two vertices, and faces connect three or more vertices.

Vertices show up as pink dots when they're not selected, and yellow dots when they are selected. If all the vertices are yellow 
(selected), press AKEY to deselect all vertices (AKEY toggles between selecting all or selecting none). Go ahead and hit RMB
(Cmd+LMB on Mac) over one of the vertices and you should see it change to yellow, which means that it is selected. If 
instead you see a blue dot with arrows, see below to overcome this:

Make sure the 3D transform manipulator is off, if not: depress the hand button  on the header.

If you cannot select a vertex:

Hit the ZKEY and make sure you are in transparent mode.
If you can't get the cursor over the vertex, adjust your mouse/trackpad's tracking speed to minimum.

If all you see is a big blue dot:

Change the pivot in the pivot menu (two boxes to the left from the one with the hand on it  ) to "Active Object",
Then hit RMB (Cmd+LMB on Mac) over one of the vertices again

Now you should see just one yellow dot instead of the blue dot and arrows. Also try rotating the view to see what's actually 
going on.

Moving vertices

With a vertex selected, press GKEY and move your mouse around: you should see the selected vertex moving with the pointer!
Click the LMB to drop the vertex at the current spot, or press ENTER or SPACE key. While moving, you can cancel the move
and drop the vertex back where it came from by pressing RMB (Cmd+LMB on Mac).

You can also grab a selection using the mouse by holding RMB (Cmd+LMB on Mac) and dragging it around: release the 
button at the desired spot. Then, clicking on the same button cancels the move.

Now use the MMB to rotate the view around to see the incredible impact your small change has undoubtedly made.

GKEY - "Grabs" the current selection and allows you to move it around with the mouse. Use LMB, ENTER, or SPACE to 
drop it in place. Use RMB or ESC to cancel the move.

Next Page: Quickie Render
Previous Page: Beginning Tips

Quickie Render

The cube after editing in 
edit mode.
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Next Page: Mesh Modeling
Previous Page: Quickie Model

If you haven't completed the previous tutorial, (the Quickie Model tutorial), do so now. Keep 
the same file open from that tutorial because we will be using it here.

Now that you've created your first model, undoubtedly you'll want to render it. Rendering is 
quick and easy. Make sure you're in object mode (press TAB if you're not), put the 
mousepointer in the 3D view window and press F12! On Macintosh OS X 10.4 and Gnome 
you can use ALT-F12 to avoid the Dashboard and the Gnome Search Dialog, respectively.

You can also click on Render>Render Current 
Frame.

(If you've accidentally put the render window behind 
the main window, you can get it back several ways: 
you can use the Windows taskbar or, under Windows
and most other operating systems, you can use ALT+TAB (CMD-~(tilde) on Mac).)

A render is the creation of a picture from the camera's point of view, taking the environment's effects on your scene into 
account, and generating a realistic picture based on your settings. This first render will finish very quickly, but you'll 
find that as your 3D scenes become more complex, the rendering can take a very long time.
If your cube is completely black, you may not actually have a light source in the scene. Some versions of Blender don't 
create a lamp (source of light) by default, and you'll need to add one. To add a lamp, enter object mode (TAB) and then 
press the spacebar while your mouse is over the 3D window. Select Add>Lamp which will give you a choice to add 
several different types of lamps. Remember to place the lamp in position where it is not inside the cube. This can be 
achieved using the RMB and pressing G.
You can interrupt the rendering at any time by pressing ESC while the rendering window has the focus.

This is a relatively quick render. It can be cleaned up a bit but it will give you a good idea of what your model currently looks 
like. Feel free to use the F12 key as often as you would like.

At some point you will probably want to save your renders. Above the 3D Viewport, select File>Save Image… or just hit F3. 
A menu with a directory list will appear; the upper text line denotes the directory and in the lower one you type the name of the 
image, like "myfirstrendering.jpg". Note that earlier versions of Blender (before 2.41?) will not add the ".jpg" extension 
automatically if you leave it out.

Next Page: Mesh Modeling
Previous Page: Quickie Model

Mesh Modeling

Next Page: Modeling a Simple Person
Previous Page: Quickie Render

Your first quick and dirty 
render should look something 

like this.
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Mesh modeling is the most common type of modeling in all of Blender-dom. If you did the 
Quickie Model tutorial, then you've already participated in mesh modeling. A mesh is simply 
a collection of vertices that define a three dimensional object. This exercise will further help 
explain mesh modeling.

Get a piece of paper and a pencil.1.
Draw three dots that are no more than 2.5 cm (about an inch) apart roughly in the shape 
of a triangle in the center of the paper.

2.

Each one of these dots is called a vertex. (The plural of vertex is "vertices")3.
Now connect two of the dots with a line segment. The line segment is called an edge.4.
Draw two more edges so that the three vertices are all connected. You should now have 
a triangle drawn on the paper. Fill the triangle in. This is called a face.

5.

Now draw another vertex (dot) on the paper. Connect it to two of the vertices (dots) you previously drew. You have 
another triangle. Fill it in to create another face.

6.

Could you imagine doing this same sort of activity in 3D space? Essentially, mesh modelling is just that. The details are on 
subsequent pages in this tutorial.

You can keep filling up the paper with more vertices, edges, and faces if you want. You may want to try and create something 
interesting with your triangles. Blender also supports faces with four vertices (called quads), but faces with five or more 
(so-called N-gons) cannot be created.

Look closely at a 3D video game character some time. Believe it or not, every part of the character is created from little 
triangles joined together (of course, the triangles are much harder to see in newer games using more detailed technology).

When you're creating your models, remember that the whole point of having edges and vertices is so that you can have control 
points in 3D space for your faces. When the scene is rendered, only the faces will be seen. Any edges or vertices not connected 
to a face will not appear.

Next Page: Modeling a Simple Person
Previous Page: Quickie Render

Modeling a volcano

Modeling a Volcano

(note: you must have the newest version 2.43. You can download it here: http://www.blender.org/download/get-blender/)

This may be a little inefficient as I'm a beginner, however it is a good starting tutorial.

If you are using a windows pc, you can take a screenshot by pressing the "PrintScreen" key to the right of the F12 key near the 
top of your keyboard. Next go to the EDIT MENU and select PASTE. This will paste the image of the screen onto paint.

To see the finished volcano click here: [1] (http://sites.blockstar.com/tcrazy/Volcanoes.html) 

Setting up

The first thing you will want to do is delete the starting cube.(Do this by selecting the cube and pressing x)

Your scratch should look like 
this.
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After deleting the cube press space>ADD>mesh then choose PLANE. A pink plane with yellow outline should be there. Then 
zoom out (using the middle mouse scroll) and press [s] for scale. Bring your mouse out toward the corner of your viewport and 
left mouse click.

Sculpting the Island Volcano

You should now still be in edit mode. Once in edit mode press [W] and click on the second option "subdivide multi" and set it 
to about 50. Now look down on the bottom left of your screen where it says edit mode. Click the arrows next to it and click 
sculpt mode.
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There should now be 4 columns on the bottom of your screen. The third one says "multires" click add multires. Then click add 
level. This is basicly subdividing without really creating vertices so your computer should be able to handle it better.

There is a lot missing past here. You will not be able to model or animate anything if you are a Newbie.

to make the volcano have fire, you should first build a model that looks like fire. just make a bunch of spheres, make them clear
with a fire texture or you can do it your way. put whatever it is in a certain position that you would like for the fire and press I. 
then click the locrot button. make sure that you are in frame number one. for complete details on how to do this, see a blender 
tutorial about animation. move to another frame of your own choice, press i and then locrot. continue this cycle and then render 
it for the animation. once it is done rendering, press play and there is your spurting volcano!!!

Nu kurš keksis šito ielika?? Es 10 min. notērēju tik tālu tikdams... Bļaģ nahujā!!!

Modeling a Simple Person

Next Page: Detailing Your Simple Person 1
Previous Page: Mesh Modeling
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Creating a New Project

Now we will help you create a simple person.

With Blender open, select File>New, or CTRL-X. A confirmation to "Erase All?" will 
appear. Click on it to accept. You should have your default beginning cube. Select the cube 
with RMB (CMD + LMB on Mac). Press NUM1 to go into front view. Right now you're in 
Object Mode. The cube should be selected, so you can toggle between Edit Mode and Object 
mode with TAB. Make sure you are in edit mode and then proceed.

Reminder: The option button shown on this image tells what mode you are in at any given 
moment:

Reminder: RMB - Right Mouse Button, LMB - Left Mouse Button, MMB - Middle Mouse Button.

Methods of Selection

Once in the front view in Edit Mode, you need to select the top four vertices. The 
image to the right shows the view rotated a bit with the correct vertices selected. 
Try all five of these methods of doing this:

Before we begin, you'll need to rotate your view a bit (MMB or for 
Mac Users ALT + LMB) so that you can see all of the vertices. Also, 
make sure the "Limit Selection to Visible" button is selected, the second 
furthest right icon of the 3D View header in EDIT Mode. This button is 
not visible in wireframe Mode, so toggle from it with ZKEY if you 
cannot find it.

Note: In Blender 2.42 for Mac OS X running on a MacBook, there is a display problem with the box and circle selections: the 
selection box and circle do not appear on screen (this is valid for both the Intel and the PowerPC versions).

1. Box Selecting

Note: This tool draws a square that you resize to select the top four (vertices/dots); you are not selecting the 3D (cube/box).

De-select all (by pressing the AKEY)1.
Press 'Tab' to edit the cube2.
Press AKEY to deselect all parts of the editable, highlighted cube.3.
Press the B KEY to activate what is known as the Border Select tool (it starts as two lines to choose a point).4.

Now, when you click and hold LMB and move the mouse cursor, a selection border will appear. When you release the mouse 
button, the vertices that are inside it will be selected. Select the top four vertices. If you made a mistake, you can start again 

Your simple person will look 
like this.

Object Mode Button/Indicator

Limit Selection 
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after hitting A KEY to deselect the selected vertices. Make sure all the vertices are deselected (pink, not yellow) before trying 
the next method.

AKEY - Toggles between selecting all or selecting none.

BKEY - Activates box-select tool.

2. Circle Selecting

Press the BKEY twice to activate the Circle Border Select tool. A circle appears around the mouse cursor; you can resize
the circle by scrolling the MMB. Another way of resizing the circle is to press the NUM+ and NUM- keys on the
numeric pad (useful if you don’t have MMB or if you're using a Macintosh without a mighty mouse). You can select 
vertices by moving the circle over them, holding LMB, and dragging the mouse. You can deselect vertices one by one by
pressing ALT + LMB, or MMB over the vertices. (This works with Circle Border Select Tool activated. You normally 
deselect vertices by pressing SHIFT + RMB.)

If ALT + LMB moves the current window, then to deselect a vertex use CTRL + ALT + LMB or MMB instead.

Try those now. The Circle Border Select tool will be active until you press RMB, ESC or SPACE. Press AKEY to deselect 
the vertices before trying the next method.

BKEY+BKEY - Circle Select. If you press BKEY a second time after starting Border Select, Circle Select is invoked. Use 
NUM+ or NUM- or MW to adjust the circle size. Leave Circle Select with RMB or ESC.

3. Lasso Selecting

Like many graphics programs, Blender 3D has a Lasso Select tool. Hold CTRL + RMB and attempt to draw a circle 
around the four vertices you would like to select with the mouse cursor. Release the RMBwhen you're finished. Press 
AKEY to deselect the vertices before trying the next method. CTRL + SHIFT + RMB is the lasso's method to de-select.

4. One By One Selecting

You can also select the four vertices one by one. Select the first vertex at the top of the cube with RMB (CMD + LMB
on Mac). To select additional vertices, hold SHIFT while pressing the RMB (CMD + LMB on Mac).

5. Face Selecting

In addition to those selection methods, there is yet another option -- to the right in your viewport 
header you can see selection modes. Click on "Face select mode" (Looks like a triangle) and select the 
top face of the cube with the RMB (CMD + LMB on Mac). Switch now to "Vertex select mode" 
(looks like 4 dots in a diamond formation) before proceeding further. As you will see, all four vertices 
forming the top face are selected (this is also called "selection transformation").

Alternatively, (with the mouse pointer in the 3D Viewer) you may select CTRL + TAB and select 
"Vertices" from the floating drop down menu.

Noob Note: If you press NUM1 to get back into the view you need, and then click the face selecting triangle, you can press 
RMB on each vertice that you need from there. After that if you stay in Face Selecting mode you can press EKey and CTRL 
and that is the fastest way of expanding.

Learning Extrusion

Note: The pictures below are in orthographic view. When Blender (2.42) opens, its default view is the perspective view. 

Selection 
Modes
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If you want the orthographic view, press NUM5. Also in Blender 2.42a and 2.43a when extruding objects as shown 
below you may not have the region option so just ignore choosing region and continue.

Restore the front view by pressing NUM1.

With the top four vertices selected (which will appear like the 
top two in your screen), hit the EKEY. A menu will come up; 
choose Region Then move the mouse with MMB to see four 
NEW vertices attached to the four that were selected before 
(you can move them around with the mouse and drop them in 
place with LMB, SPACE, or ENTER).

If Blender gets into a state where you can only select "Only 
Edges" and "Only Vertices," you have not selected four vertices
that make up a face. It maybe due to the fact that some of the 
vertices are doubled. Try selecting all vertices while in edit 
mode and typing WKEY to display the "specials" menu, select 
Remove Doubles.

Another way to remove doubles is to select your object, press AKEY to select all vertices, and click "Rem Doubles" under the 
"Mesh Tools" tab in your buttons window. You can also change the limit of how far Blender should look for vertices that are 
close together.

Also, if the menu doesn't ever pop-up, you are in face selection mode. Move back to vertex select mode by clicking the icon.

Make a simple leg using extrusion

The EKEY "extrudes" the vertices. If you've never heard that word before, you'll want to remember it. This is one of the most 
widely used modeling tools available.

More likely than not, wherever you extruded the vertices to is not the right spot for this tutorial. Hit the UKEY or 
CTRL+ZKEY (CMD+ZKEY Mac) to undo your last edit. You should see just your original cube with the top four vertices 
selected.

With the top four vertices selected, hit the EKEY again. Again, choose Region. This time, as you're moving the extruded 
vertices around, hold down CTRL and you'll see that they will only move to certain spots. This is called "snapping". The 
vertices "snap" to values in predetermined increments. We'll talk more about snapping later, but for now, set the vertices in the 
right spot so that it looks like two cubes of equal size stacked on top of each other.

The new extruded vertices should still be selected . Hit EKEY and choose Region a second time, then use CTRL to snap the 
vertices into place. Repeat the process until you have five boxes of equal size stacked on top of each other. And that, my friend,
is a very simple leg!

Hint: Don't stretch one box all the way to make the desired shape - You must create all stacked boxes in sequence, or 
you won't get the nodes (a more detailed mesh) that is required.
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Hit AKEY to deselect the current vertices. Select the four vertices in the upper 
right hand corner of the leg. Again, you'll need to rotate your view a little with 
the MMB (ALT+LMB on Mac) to be able to see all the vertices. To select two 
or more vertices, press RMB for the first vertex. Then, press SHIFT and hold it 
while pressing RMB for the next. After selecting the top two vertices, select the 
two vertices that are immediately below them. In total you should now have four
vertices selected.

Hit EKEY, choose Region, and you guessed it, hold CTRL to set them in the 
spot so that the box is the same size as all the others. Do it one more time. Now 
you have the left leg and the connector between the legs.

Make the Right Leg

If you find that extruding is as easy as it is simple - then you are right. The remaining steps to 
building our person are done by using the same concepts of extrusion to continue to extrude 
faces of our shape to build the rest of our simple body...

To create the right leg, first press AKEY to deselect all vertices. Select the four vertices that you 
are going to need to extrude downward in order to create the right leg. Extrude them the same 
way we've been doing. Do it several times until the right leg looks just like the left leg.

Torso

Now on to the torso! Hit AKEY to clear your selection, go into front view with NUM1, select the four 
vertices at the top of the box connecting the two legs.

Alternatively, it may be easier to change to "Face select mode" and select the top face of the box with the 
RMB. You will notice that in this case pressing the EKEY will automatically select "Region" as your 
extrusion method since you have selected the face itself rather than just its vertices.

Either way, extrude the connector box up five times the same way we've been doing it.

Arms

We're going to make the arms stick straight out to the left and right for now. Go into 
front view, clear the selection, select the four vertices on the left side of the torso, not 
the top two, but the four directly below the top two. Extrude out five times by choosing 
Individual Faces.

Now make the right arm after the same fashion.

Toggle solid mode on using ZKEY (see below), and check that all is well. It's easy to 
fix the model if some faces are missing. To create a face from four vertices, select the 
vertices and press FKEY. Alternatively, use Mesh menu in the viewport > Make 
Edge/Face.

Head
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Now to give our person a head. Using the LMB select a point just above the top of neck. To make sure you have the correct 
point selected switch between the views top, front and side (using the NUM7, NUM1, and NUM3 keys respectively), and 
reposition your point as needed. Once you have the correct point in 3d space selected, press the SPACE key to bring up the 
menu. Select Add → Icosphere. In some versions you may be asked how many subdivisions you want. Just click 'ok'. You 
should now have a small sphere at the top of your person. To resize the head so that it is a bit more proportional to the body, 
select from the menu Mesh → Transform → Scale or just press the SKEY. That's all there is to it.

Newbie's footnote: It took me a while to figure out how to reselect the vertices comprising the head in the event that they get
deselected. The only way to do this that I found (other than painstakingly trying to select them individually) was to first select
one vertice of the head, then click Select → Linked Vertices (or CTRL+L). All the head's vertice's should then be selected 
again, and none of the body's.

Additional footnote: If you need to reselect the vertices of the head, in OBJECT mode, select the head with the RMB, then 
press TAB to switch to EDIT mode. Press A to select all vertices/lines/faces (depending upon which mode you're in - press 
CTRL+TAB to swap the modes). Don't forget - pressing A will select all or deselect all. [PAE]

Another footnote: If you are having trouble getting the cursor centered over the model (as I did) press Shift+S to bring up the 
snap menu and select Cursor -> Grid.

Summary: Keys & Commands

These are the keys and commands used on this page:

Key Mode Description
RMB or CMD+LMB (Mac users with one mouse 
button) Object Select an object

NUM1 Go to front view

TAB Toggle between Edit Mode and Object 
Mode

BKEY then LMB and drag Box selection

AKEY Toggle between Select All and Select None

BKEY BKEY (pressed twice) then LMB and drag Circle selection

CTRL+LMB and drag Lasso selection

RMB then SHIFT+RMB One-by-one selection

(click the vertex/edge/face selection buttons) Change the selection mode

CMD+TAB (CTRL+TAB in Windows) Change the selection mode

select vertices then EKEY Extrude

CTRL while extruding Enable snapping

MMB or ALT+LMB Rotate the 3D view

ZKEY Toggle wireframe/solid view

FKEY Make Edge/Face from selected vertices

NUM3 Side view

SHIFT+SKEY Snap cursor or selection to the grid

GKEY Grab the current selection and move it

ZKEY (or XKEY or YKEY) grab mode 
(GKEY) Constrain motion to the Z (or X or Y) axis
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To enter a value on a bar you can:

click on the left or right arrows 
on either side of the bar to add 

SKEY Change the scale (size) of selection

SPACE Brings up the menu

Next Page: Detailing Your Simple Person 1
Previous Page: Mesh Modeling

Detailing Your Simple Person I

Next Page: Detailing Your Simple Person 2
Previous Page: Modeling a Simple Person

This tutorial uses the simple person model from the previous tutorial. If you didn't do it, go back and do it now---or find it 
pre-made just for you here (http://www.nusoy.com/blender) .

If your model does not appear to be solid, it is currently being drawn in wireframe mode. For this tutorial, you need it to be 
drawn solid. Return to Object Mode (TAB) and press the ZKEY to see the model in solid mode.

Subsurfaces

You should already have the "Editing Panel" displayed in the 
"Buttons Window". If not, click on the "Editing" button (shown 
pressed in the image on the right) or press F9 to have the Editing 
Panel displayed. On Macintosh OS X, use CMD+F9 to avoid engaging the Exposé window effects. Note that the "Editing
panel" is a different thing from "edit mode"; don't confuse them. Depending on whether you're in "edit mode" or "object mode" 
the "Editing Panel" will display different tabs. With the object (your man) selected (RMB) press TAB to view how the 
available buttons in the panel change.

First of all select the model. We're going to turn on subsurfaces, or Subsurf.

Quick Troubleshooting: (Comment by a newbie: In my attempts to follow this tutorial, I 
could only ever do the following steps separately to the head ("Sphere") and the rest of the 
man ("Cube,001"). It all becomes easier if one selects both these objects in object mode, and
select "Join Objects" from the Object menu in the header of the 3d view window.) 
(Comment by another newbie: This doesn't happen if the sphere is created while still in edit 
mode-Blender automatically adds it to the current object being edited.)(Comment by yet 
another newbie: Why don't you just use the a key to select both the sphere and the cube then 
from there object> join objects? It's alot easier than selecting them seperatly, and much quicker)

To enable Subsurf, you must go to the "Buttons Window" → "Editing Panel"(F9) → "Modifiers" subpanel → click "Add
Modifier" → "Subsurf" from the list. You should immediately see your model change to look more round and less edgy. New
options for "Subsurf" are now shown in the Modifiers subpanel. You may also perform this action by pressing SHIFT+OKEY
while in object mode.

Note that the "Modifiers" subpanel will be displayed in both "edit mode" and "object mode".

What just happened? Each face was just divided into four smaller faces that are 
progressively angled, which has helped soften the sharp edges of the model where 
faces touch each other. Click the horizontal bar labeled "Levels" and change the value
to '2'.
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or subtract a unit.
click in the middle of the bar 
and enter a value with the 
keyboard.
Hold down LMB and move 
your mouse to the left or right 
while hovering the mouse cursor
over the number.

The model will change again because each of your original faces is now divided into 
16. If you change the value to '3' each plane will be divided to sixty-four smaller 
planes, but don't do it unless you've got a computer that you're sure can handle it 
(newer computers should be able to handle it pretty easily). Note that subdivisions 
work with base 4, i.e., Level: 1 yields 41 = 4 divisions; Level: 2 yields 42 = 16
divisions; Level: n yields 4n divisions.

Notice the other bar labeled "Render Levels" below the "Levels" bar? That controls 
how many subdivisions to do at rendertime, while the value we've been changing 

handles the number of subdivisions while working in the Blender. Before moving on, set the first subdivisions value to 2 and 
the rendertime subdivisions to 3.

A Modifier is defined as the application of a "process or algorithm" upon Objects. They can be applied interactively and 
non-destructively in just about any order the user chooses. This kind of functionality is often referred to as a "modifier stack" 
and is found in several other 3D applications. The x in the upper right of the subsurf modifier will remove the modifier from the
modifier stack. The arrows at the left of the x will move the modifier (and its effects) higher or lower in the modifier stack.

The Optimal Draw button removes the extra wireframe lines which display as a result of having additional geometry. This 
button is especially useful to clarify and speed up the display of densely subdivided meshes. The blank roundish button towards
the top of the Modifiers panel, just to the left of the up and down arrows, applies the modifier to the editing cage. Press this 
button now to remove the translucent, boxy cage, so you can edit the smooth mesh in the next parts of the tutorial. [EDIT: You 
actually need the boxes for the next section of the tutorial, so DONT press this button yet, just note its function and remember 
it for later]

Noob Note: I feel it may be the author's choice to use this button now to get us to create a memory of using it so it's ok to do it 
now.

Note: You have the option of pushing the button to see its effects, but do NOT keep the button pushed down before the next 
step. Editing the body of the simpler person will not allow you to edit the simple person as the instructions explain. And avoid 
use of the apply button unless specified otherwise.

Troubleshooting: If one or two of your sides don't subsurf, try selecting all vertices while in edit mode and typing WKEY to 
display the "specials" menu, select Remove Doubles. Another way to remove doubles is to select your object, press AKEY to 
select all verticies, and click "Rem Doubles" under the "Mesh Tools" tab in your buttons window. You can also change the 
limit of how far Blender should look for vertices that are close together.

Unless you have a good reason, don't press Apply on a Subsurf modifier.

If you do, the modifier will be applied to the mesh. While this is useful for some modifiers, for Subsurf this will add many extra
vertices and is generally not needed.

IN THIS OCCASION, DO NOT APPLY THE MODIFICATION OR YOU WILL NOT BE ABLE TO CONTINUE TO 
THE NEXT PART OF THIS TUTORIAL

Noob Note: You can undo this modification by pressing CTRL+Z twice.

For a complete modifiers documentation go to http://wiki.blender.org/index.php/Manual/PartII/Modifiers

For a complete subsurf modifier documentation go to 
http://wiki.blender.org/index.php/Manual/PartII/Modelling/Modifier/SubSurf

For a complete subsurfaces documentation go to http://wiki.blender.org/index.php/Manual/Subsurf_Modifier

Smooth Surfaces
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Subsurfaces do a good job of smoothing out objects and creating good curved surfaces. 
However, even with subsurfaces the model does not appear completely smooth; at this point it
even appears scaly.

In Edit Mode, hit the AKEY once or twice so that all the vertices are selected (if you're not in 
Edit Mode, select the object and press TAB). Find the button that says "Set Smooth" (the 
center-right button inside the "Links and Materials" subpanel in the Editing [F9] panel) and 
click it. You will see the Blender smooth out the rough edges where faces were touching 
before. Next to it is the button labeled "Set Solid." Click it as well. You will see the simple 
person go back to the solid rendering. The simple person looks better smooth, so click the "Set
Smooth" button again. (more information about this at [2]
(http://en.wikipedia.org/wiki/Flat_shading) and [3]
(http://en.wikipedia.org/wiki/Gouraud_shading) ). (Noobie: My person was in wireframe 
view, so I have to hit ZKEY to change it to solid view to see the difference.)

You need to keep this file open for the next several tutorials. Move on to the next page.

Next Page: Detailing Your Simple Person 2
Previous Page: Modeling a Simple Person

Detailing Your Simple Person II

Next Page: Creating a Simple Hat
Previous Page: Detailing Your Simple Person 1

This tutorial uses the simple person model from a previous tutorial. If you didn't do it, go back and do it now or find it 
pre-made just for you here (http://www.nusoy.com/blender) .

Selection modes

Up to this point, you've been selecting vertices and manipulating them. In the first chapter, we 
touched on selecting faces. In fact there are three selection modes: vertices, edges and faces.

Make sure you're in Edit Mode (TAB) and in Solid Mode (ZKEY). Press CTRL+TAB. A menu will 
come up where you can choose Vertices, Edges, or Faces. Choose Edges. The three selection modes 
can also be selected with the statusline buttons shown to the right.

Under KDE, CTRL+TAB changes the desktop so you will have to use the statusline buttons instead. 
(Older versions of Blender do not have this feature. Instead, just select all vertices connected to the 
edge you want to select).

It is important to remember that whether you're in vertices, edge, or face selection mode, 
moving or otherwise manipulating your selection will cause connected vertices, edges, and 
faces to be moved as well. This is because you cannot separate faces from edges or edges from 
vertices.

Scaling with axis constraint

We want to position the 3D cursor between the hips of the simple person, then use that cursor for scaling.

Your simple person after 
setting smooth.
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Use the 3D View's menu Select → Deselect All (AKEY) to make sure everything is deselected. Reset to View->Front (NUM1) 
and choose View→Perspective (NUM5). Adjust the Edit Mode settings as shown in the picture above by matching the buttons 
that are pressed then selecting the 2 edges.

Troubleshooting - If you do not see the cubes around your person, make sure you are in Edit mode (hit tab) or clicking the 
button just to the left of the "move modifier up in stack" button (^) for the Subsurf modifier. Failing this, try deleting the 
subsurf modifier (the X right above apply in the Modifiers box) then redoing it (Add Modifier -> Subsurf). Or just unselect 
"Apply modifier to editing cage during Editmode" Which you were told you should select earlier but actually you shouldn't 
have.

By default, when editing in solid mode, the vertices, edges and faces that are on the back side of the model are not visible or 
selectable. This can be toggled by clicking the "Limit selection to visible" button located on the header of the 3D View window
to the right of the Vertex, Edge and Face selection mode buttons (while in Edit and Solid mode). Toggle the "Limit selection to 
visible" button on and off a few times and observe how the edges of the wire cage appear and disappear as you click. Disable it 
for now.

Ensure that you've disabled "Limit selection to visible". Now, select one of the edges just above the "hips" of our person, where
the legs connect to the torso. This would be an edge of one of the cubes to the left or right of the model's pelvis. Notice that the 
3D transform manipulator jumps to the edge you selected. Now also select (SHIFT+RMB) the edge on the other side of the 
pelvis. The 3D transform manipulator should jump halfway between the two edges. If, instead, it jumps to the second selected 
edge, change your Rotation/Scaling Pivot (Two left from the hand button on the 3D view header). "Median Point" should work.

Once the 3D transform manipulator is in the center between those two vertices, bring up the Transform → Snap menu (SHIFT 
+ SKEY) and select Cursor → Selection (KEY4). This will move the 3D cursor to the location of the manipulator.

Activate Use 3d manipulator(CTRL + 
SPACE) then choose Scale Manipulator 
Mode (CTRL + ALT + SKEY). Since the 
Transform Orientation is set to global, the 
manipulator's orientation is the same as the 
world's orientation shown in the lower left 
corner of the 3D View pane. The axes are 
colored RGB for XYZ, i.e. the X-axis is 
red, the Y-axis is green, the Z-axis is blue.

It's important to note that not only is there 
a global XYZ axis, but each of your 
individual objects has its own XYZ axes as
well. We'll get into that in the next section.

Grab the cube-formed red handle and drag 
it with LMB to symmetrically widen up the selection along the selected X-axis. While scaling, press CTRL to snap to the grid 
or ESC to abort the current manipulation. When it comes to scaling in the Blender, 1.0000 means 100%, 0.6000 means 60%,
and so on. Scale up to 2. Note, you cannot scale along the Z-axis, as the current selection's Z-dimension is zero — if you want
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to symmetrically lift the hips, switch back to Translate Manipulator Mode (CTRL + ALT + GKEY).

So far, you didn´t use the prepared 3D cursor's
position, but the selection's center. Now, set the 3D 
Cursor as Rotation/Scaling Pivot. Since the 3D 
Cursor was positioned to the selection's center, the 
manipulators' behavior stays the same. Finish 
forming the hips (what else is there to do???).

Select both the edges on the underside of each of the
arms where they connect to the torso (the armpits, 
the edges run from front to back). This is easier to 

do after you have rotated the view about the world's X-axis (View Navigation →
Orbit Down (NUM2)). See the manipulator not jump to the selection, but stay at the 
3D cursor. Form the armpits. For better visual comparison to the width of the hips, 
switch to View → Orthographic (NUM5) before scaling along the red X-axis. Note,
you can now scale along the blue Z-axis, as there is a distance along Z between the 
selection and the pivot.

Select the belly cube (if you use View → Border or CTRL + LMB lasso selection 
make sure to deselect the arm pits). This time, don't use the Scale Manipulator, but 
the Scale Tool. Press SKEY to scale, and then once SHIFT + ZKEY to lock the 
Z-axis. Now, the scale tool is constrained to the X- and Y-axis, the selection is not scaled along the Z-axis any longer, thus, 
scales equally along X and Y. The axes that the scale tool is constrained to are drawn through the pivot in brightened color. 
SHIFT + XKEY or SHIFT + YKEY work accordingly. Finish scaling by LMB.

Continue selecting different sections of the torso and 
scaling it to your liking. Here is an example of a 
man-figure:

Modeling the arms

When you've got the basic shape of the torso, move on to the arms. Note that just like you can constrain scaling to the X, Y, or 
Z axis by pressing XKEY, YKEY, or ZKEY, you can constrain movement to an axis as well. Press the GKEY and then press 
the appropriate axis key. As you work on the arms, be sure to use the different viewing angles so everything is correct (MMB
to rotate, NUM1 for front view, NUM3 for side view, NUM7 for top view). Also, be sure to use CTRL+ZKEY to undo if you 
mess something up.
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We'll start by making him put his hands up. First, make sure you're in Edit mode; if 
not, select the figure and press TAB. Also, make sure you are in Vertices Select 
Mode (CTRL+TAB). Before you begin, also uncheck the roundish button to make 
the arms into cubes again. You can change them back after you are done.

Now, select the 8 vertices on one arm that are furthest away from the torso (make 
sure you deselected the armpits or whatever other part you were previously 
modifying) and press XKEY, and press "vertices" in the upcoming menu. Suddenly 
the box disappears, and at the end of the arm, there's a hole! Don't panic. :) We'll fix
that in a moment.

Select the top four vertices of the end-"box" (by pressing BKEY and dragging the 
box around the 4 vertices of the cube) and extrude up three times by pressing EKEY
and CTRL to create three boxes the same shape.
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Now to fix the hollow elbow. Simply select the four vertices at the gaping hole (turn 
on "Limit Selection to Visible" mode to make this easier), press 
SPACE-"Edit"-"Faces" and finally pick the option named "Make Edge/Face" 
(Making a face/edge can also be done by pressing FKEY, but the other way gives 
you a better impression of what you just did). Notice that the hole was covered by a 
face.

Now, click the "Set Smooth" button to make it a smooth face.

Do the same with the other side. Make sure to deselect all the selected vertices from the 
other arm by pressing AKEY. It is important to follow the steps in the same order; doing 
otherwise may result in arms of different lengths. Better undo your work and redo every step
while selecting both sides symmetrically.

If the surface of the model looks bunched where you add the face to cover a hole, use CTRL+Z to undo the face. Try selecting 
all the vertices at the opening (or even select the whole figure) and select Rem Double, located in the Mesh Tools section of 
the buttons window, and try to add the face again.

Doing a Rem Double does make a difference, try to use this function correctly.

(Reader SixFt12:- After trying Rem Double, if it still looks bunched then without undoing it, select the whole figure with the 
AKEY and use Ctrl+N to recalculate normals outside.)

Modeling the legs

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P


Blender 3D: Noob to Pro - Beginner Tutorials/Print version - Wikib... http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P...

43 of 263 5.5.2007 21:39

First we switch to the Face Select Mode. Press 
CTRL+TAB and select Faces. To select the two 
bottom faces of the feet (the soles of the feet), click 
RMB and hold down SHIFT when selecting the 
second one. Each face comes with a small square 
denoting the face center that turns orange when 
selected, while the outline highlights yellow.

Select the 'Subdivide' Command (hit SPACE then, 
in the menu that comes up, Edit → Edges →
Subdivide). This command subdivides the faces 
each into four smaller ones all of equal size. You 
can also subdivide a face(or an edge) by clicking 
the "Subdivide" button under the Mesh Tools tab in
the buttons window. In the next step we need to 
switch to the Edge Select Mode by pressing 
CTRL+TAB.

Press the AKEY to clear your selection.

Select (remember : click RMB and hold down the 
SHIFT when selecting the other one) the two 
bottom front edges on each leg that make up the tip 
of the feet (therefore, there are four selected edges 
in all).

Switch to the side view with NUM3 and press the GKEY. Now move the 
selected edges away from the legs as far as you like. Press MMB for 
orthogonal movement.

edit: Pressing the YKEY will also restrict movement along the Y-axis only, 
however orthogonal movement can be easier.

Congratulations! We 
now have feet!

Modeling the 
head
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When you've got an acceptable shape for the legs, you should do something 
about that head. A little too spherical, don't you think ?

Press the AKEY to clear your selection, move mouse cursor over the 
head.
Place the mouse cursor over the head and press the LKEY. This 
selects edge, face, or vertex that the mouse cursor is closest to, as well 
as all edges, faces, or vertices that are linked to it. The faces for the 
head and the faces for the body pass through each other; however, 
none of the vertices in the head are linked to any of the vertices of the 
body via an edge or a face.
With the whole head selected, press SKEY and scale it on the Z-axis 
in order to get a better shape. I think 1.5 is enough. Remember that 
you need to press ZKEY to restrict the scaling to the Z-axis only 
(Pressing CTRLKEY also helps). It is helpful to restrict the axis you 
are scaling on in order to get a nice shape.
After elongating the head, you may find that it is too low. To fix this, 
press the GKEY (to move the head) and ZKEY (to restrict movement 
to the Z-axis). Play around with it a little until you like the result.

(Reader Spooner:- You may want to select 'Median' as your pivot, the same way you selected '3D Cursor' before, otherwise you 
will encounter the same trouble these other gentlemen did.)

(Reader Colin Connaughton:- I think the author left something out here. When the head is selected, before scaling the head, I 
believe, you need to use the 'SHIFT S (in Windows) to call up the popup menu, and then choose 'Cursor -> Selection' as 
described near the top of the page, to put the cursor into the center of the head.)

(Reader Hayden:- I agree with Colin as the head moves away from the body when scaling without using Shift s)

(Reader Twofingers:- There's no mistake. You simply make sure you've got 'median point' selected as the reference pivot when 
scaling (or press CTRL+, to choose it). Since scaling gives you some shape distortion I assume your pivot is set as '3D cursor' 
at the moment.)

(Reader Josse:- A more logical course of action would be to put the cursor (and thus the 3D transform manipulator) at the 
underside of the head. That way the neck will keep the same length, while you can scale the head at will. Snap it to the grid (use
7NUM, as it is unlikely that the underside of the head is precisely at a BU) while you're at it, to avoid deforming the head if 
you wish to scale along the Y-axis or X-axis as well.)

Next Page: Creating a Simple Hat
Previous Page: Detailing Your Simple Person 1

Creating a Simple Hat

Next Page: Putting Hat on Person
Previous Page: Detailing Your Simple Person 2

This tutorial uses the simple person model from a previous tutorial. If you didn't do it, go back and do it now---or find it 
pre-made just for you here (http://www.nusoy.com/blender) . Alternatively, if you just want to make the hat without putting it 
on a person at the end, you can go ahead and do that without having completed the other tutorial.

Adding an object
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The first step to hat-making is editing a simple mesh circle.

For this section we'll be using the orthographic view (NUM5). Press NUM3 to get a sideways 
view of the model. Pan the view with SHIFT+MMB until your view is a good distance above
the simple person's head. We're going to add the hat as a separate object, so if you are in Edit 
Mode, press TAB to go to Object Mode. Click LMB on center of the view to place the 3D 
cursor (you can use SHIFT+SKEY then Cursor → Grid to snap the cursor to the grid after 
placement), then do SPACE → Add → Mesh → Circle, with 12 vertices. (In the latest version 
the default is 32 vertices but you may use the arrows to set it back to 12 [click and drag left or 
right to change number])

After the circle is added, you will automatically be placed in Edit Mode. The end result 
should be something like the picture (if you're in vertex mode).

Deleting a selection

Switch to Edge select mode (CTRL+TAB) and have only the three edges selected as seen to
the right (first click RMB and hold down the SHIFT when selecting the second one and the 
third one).

Delete these edges by pressing XKEY → Edges.

Creating the hat profile

Now switch back to Vertex select mode (CTRL+TAB →
Vertices), and try to make the line to look something like what's 
shown to the right. To do that, you have to Use:

AKEY to select/deselect all vertices
RMB to select/deselect a vertex
SHIFT+RMB to select/deselect multiple vertices, or 
BKEY for the border select tool
GKEY to move a selection
CTRL to move at regular intervals

Notice: In edit mode be sure that the proportional edit is off, an orange circle in the header (at the bottom) of the 3D View 
indicates whether the proportional edit is on (orange) or off (gray), to have full control of each vertex seperately you should set 
proportional edit off (gray) by pressing OKEY (maybe several times). More about proportional edit in a later tutorial, for this 
step switch the proportional edit off.

Spinning the hat

Make sure the 3D cursor is placed exactly at rightmost vertex (clear the selection first, select the rightmost vertex with RMB
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and then SHIFT+SKEY and Cursor → Selection and finally clear the selection again thanks to AKEY).

Make sure "Limit Selection to 
Visible" is off. Change to the top 
view with NUM7, select all 
vertices of the hat by using the 
BKEY. Click on the Editing 
button (hotkey F9; CMD+F9 for 
Mac users).

Under Mesh Tools tab locate 
Screw, Spin and Spin Dup
buttons and fill the fields below:

Degr:360, Steps:12, Turns:1

Now hit Spin to have the polyline
create a surface spun around the Z-axis.

Note that Spin like other blender operations works differently based on the rotation of the 3d view you are on. it will rotate the 
mesh around the axis that is perpendicular to the plane of the active 3d view and that pass for the 3d cursor. In this case (top 
view) the rotation axis is parallel to the Z-axis.

So if you have more than one 3DWindow open your mouse cursor may change to a "?", either way click in the window in 
which you want to perform your rotation (the top view window).

Final touches

Deselect all with AKEY, go to the 
top view with NUM7. Use Edge 
select mode (CTRL+TAB), then 
click on the four frontmost edges of
the hat with RMB (for the first one) 
and Shift RMB (for subsequent 
ones) to select them. Go into top 
view with NUM7. Hit EKEY →
Region to extrude the edges, and 
drag them down. You can press the 
YKEY to limit the extrusion to one 
direction.

Now it's time to subsurf. In the 
Editing buttons, On the Modifiers
panel Add Modifier → Subsurf. 
Rotate the view around and you will
notice that your hat has a "split at 
the seam". Because of the settings 
we chose for the spin, there are 
several pairs of vertices that share 
the exact same spot in 3D space. To
correct this problem, in edit mode hit AKEY to select all vertices and then hit WKEY → Remove Doubles. Now all our seams 
will display correctly, and you have removed the unnecessary overlapping vertices in your mesh hat. Whew! You now have a 
lovely new hat! Pat yourself on the back, good work! You can neaten it up a little more by hitting WKEY → Set Smooth to 
give it a nice smooth finish.
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If you do not remove doubles, your hat will look like this.

Keep this simple person/simple hat file open because you will be using it still in the next tutorial.

Next Page: Putting Hat on Person
Previous Page: Detailing Your Simple Person 2

Putting Hat on Person

Next Page: Mountains Out Of Molehills
Previous Page: Creating a Simple Hat

This tutorial uses the simple person model and hat from a previous tutorial. If you didn't do it, go back and do it now---or find 
it pre-made just for you here (http://www.nusoy.com/blender) .

Once you have created the hat, and are satisfied with the 'form' of it, now it's time to change the rotation, location, and size of 
the whole object in 3D space. Switch to Object mode and select the hat.

Rotation

First, change the rotation of the object. To change the rotation of the hat, press RKEY. Now you can move your mouse around 
to change its rotation. It will rotate on a different axis depending on what viewpoint you are rotating it from. The rotation axis 
will always be perpendicular to your viewpoint, so it looks like you're rotating a 2 dimensional image. Press the RMB, or ESC, 
to bring you back to the original rotation.
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When you press the RKEY, you are actually entering a rotation mode that can be altered by further key strokes. For instance, 
pressing the YKEY after the RKEY will rotate the hat about the Y-axis. Pressing the ZKEY will rotate it about the Z-axis, and 
the same goes for the XKEY. By pressing the ZKEY, YKEY, or XKEY just once, you will rotate the object in relation to the 
scene. If, however, you press the same key twice, it will rotate in relation to its origin, giving you an XYZ arrow pointer thing 
that displays the angle of the origin.

Important to note is that the shape will rotate around its origin, or center point, indicated by a small, pink dot that was created 
when you created the shape. It should be in the center of your vertices, but if it isn't, there are a couple of ways to get it back. 
One is to go into edit mode, select all vertices, and move them around the center point. Another is use the LMB to put the 
cursor where you would like the center point, go into object mode and press the "center cursor" button in editing panel (F9). Or 
you could hit SHIFT+SKEY, select Selection → Center. The final method is to click on the Editing button (F9) and click 
either the Centre or Centre New button. The Centre button will automatically move the object's vertices to the dot, and the 
Centre New button will move the dot to the center of your vertices.

Hit the NUM1 on the numberpad to get the front view. Hit the RKEY, followed by the ZKEY and move your mouse. This will
rotate the hat perfectly around the Z-axis. Hold down the CTRL button so it only rotates in 5 degree increments and click the 
LMB when you come to the correct position. (Do this with the X- and Y-axis if needed).

Alternatively, you can click and drag the LMB in a circular motion around the object, to "draw" an arc. This is called a mouse 
gesture and has the same effect as pressing the RKEY.

Location

After you have the hat in proper rotation, you will want to move it to the proper position. You do this the same way you move 
an individual point. Press the GKEY (for "grab") and move the mouse. Pressing the X, Y, or Z key will have a similar effect as 
it did with rotation, restricting the movement to the X, Y, or Z axis. Pressing the MMB while moving will also restrict the 
movement. Pressing the RMB will reset the object to its original position, without making any changes.

Alternatively, you can click and drag the LMB in a straight line to activate moving the object. This is another mouse gesture 
and the same as pressing the GKEY.

Size

You may notice that the hat is a little big for the person we created. No problem, we'll just change the size. You do this by 
pressing the SKEY, for "scale". You can scale the object just along its X, Y, or Z axis, making it thinner, shorter, fatter, or 
wider.

Alternatively, you can click and drag the LMB back and forth from the object to scale it. Start at the object, move your mouse a
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little away from it, then drag back to the object to draw a line and go back over it. This is, you've guessed it, a mouse gesture as 
well and the same as pressing the SKEY.

So, just remember:

SKEY is for Scale
RKEY is for Rotation
GKEY is for Grab (Move)

Putting it on

Once you have the hat in position, you will want to "put it on". To do this, we make the man the 'parent' of the hat. What this 
means is that, when we move the hat, we just move the hat. However, when we move the man, we move the man AND the hat.

Save your work before doing the following because the program may crash and be unusable if you accidentally 
press PKEY instead of CTRL + PKEY. (Note: PKEY starts the Blender game engine. If you do accidentally 
press PKEY, ESC should stop it and bring you back.)

Make sure that you are in object mode and the hat is selected. Hold down shift and select the man by pressing the RMB. Both 
the man and the hat should now be selected. Hold down CTRL and press PKEY and select "make parent" in the confirmation 
box to make the man a parent to the hat. Now you will see a line from the hat to the man, indicating that the man is the hat's 
parent. If you move the man, the hat will move along with him. Otherwise if you only move the hat, the man will stay at its 
place. Don't forget to pay attention to the order of your selection. The first selected object becomes the child of the second one.

Next Page: Mountains Out Of Molehills
Previous Page: Creating a Simple Hat

Mountains Out Of Molehills

Next Page: Creating Models With Photo Assistance
Previous Page: Putting Hat on Person

Now that we've created our simple person, it's time to give him somewhere to go. In this tutorial we'll create a mountain range 
using a few simple, and handy tools.

Start off with a new project, using File → New, or hit CTRL+XKEY. If you have a default cube or plane just delete them now 
(select them with RMB and press XKEY).

Creating a simple plane

Our first step is to create a large plane that we'll use for the ground and grow our 
mountains out of.

Press on NUM7 to enter top view. This way our plane will be lying flat when 
we create it.
Click LMB where the axes cross. This will be the center of the plane we will 
add.
Now add the plane with SPACE → Add → Mesh → Plane. This will be our 
canvas.
Scale the plane up by about 15. First put the mouse close to the center of the 
plane and press SKEY and drag the cursor away and watch the numbers in 
the bottom left of the 3D Window. Hold CTRL to increment by 0.1 for a 
more precise measurement. Alternatively, to enter the exact amount yourself 
press SKEY, then simply type 15 and hit ENTER.
Now we need to add some vertices to work with. In the buttons window, make sure we have the Editing buttons open (or 
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hit F9 in the buttons windows to switch there). Under Mesh Tools hit the Subdivide button 4 times. Alternatively, in the 
3D View window you can press WKEY and select Subdivide (Or just hit ENTER).

First mountain

Now that we have the ground, it's time to start growing our mountains.

Make sure you have nothing selected (AKEY).
Select a random vertex with RMB. I usually start at the one that is 3 down from the top, 3 in from the left (the 4th vertex 
if you count the edges).
Change to the side view with NUM3.

Press OKEY to change to proportional edit mode or use the button which 
shows a grey ring on the header of the 3D View. The button will change 
its color to orange. You can also use SPACE →
Transform→Proportional Edit
Once you've turned proportional edit mode on, another button appears to 
its right, the falloff button. Select Smooth Falloff here. Alternatively you 
can use the menu on the header of the 3D View (Mesh → Proportional
Falloff → Smooth) or, using SHIFT + OKEY will switch between Sharp 
and Smooth Falloff (in versions prior to 2.37) or cycle through all 6 falloff 
types (in versions 2.37 and up) while using the Proportional editing tool.
Press GKEY to grab the vertex. We should now have a circle surrounding the vertex, this is our radius of influence. 
Basically any vertices inside this circle will be affected by any changes to the vertex itself.
Use the Mouse Wheel or PAGE_UPKEY and PAGE_DOWNKEY to adjust the radius of influence to include just 
over 2 vertices on each side of our selected vertex. (Depending on your version of Blender, you may need to use ALT + 
NUM+ and ALT + NUM- and may need to hold down the LMB while using the Mouse Wheel to adjust the radius of 
the influence.On Mac, hold the "fnKey" down and hit "page-up" or "page-down"). In 2.41 you must 'grab' the vertex first 
- only then can you alter the sphere of influence.

Move the vertex up about 8 units on the Z-Axis. Do this 
by dragging the cursor up a little, and press the MMB; this 
should restrain the movements along the Z-axis. Now use 
CTRL to move it precisely. Alternatively you can use 
ZKEY to restrain movements to the Z-Axis and type 8 and
hit ENTER. In older versions of Blender you may need to 
hit the NKEY before typing the number 8.

Congratulations, we just created our first mountain. Now it's time
to see what other things we can accomplish with the proportional
editing tool.

Peaks vs. hills

The 2.37 and onward releases offer 6 types and 2 modes of proportional
editing. The previous release only has 2 of these types: Smooth and 
Sharp Falloff. We'll take a look at the difference between these two 
now.

Change to top view again with NUM7.
Select another vertex away from the first. Lets say 4 from the 
bottom 4 from the right (counting the vertices on the edges).
Change back to the side view with NUM3
Select Sharp Falloff from the menu on the bar of the 3D View. 
Alternatively, using SHIFT+OKEY will switch from one to the 
next of the 6 proportional editing modes while using the 
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Proportional editing tool.
As before, move the vertex up 8 units on the Z-Axis (Note: The radius of influence will still be the same size as when we 
last used it).

GKEY
ZKEY
Type 8 and hit ENTER

Now we can see the differences between the sharp and smooth 
falloff. The same number of vertices are affected in both cases, only
the degree to which they are affected is altered.

The different proportional editing modes can be selected from the 
box immediately to the left of the proportional editing type box. 
The mode box contains three options: Off, On, and Connected. 
"Off" means that proportional editing will not be used. "Connected"
means that only vertices linked to the selected vertices will be 
affected by the radius of influence. "On" means that all vertices will 
be affected.

Shaping the world

Now that we've created a couple of Mountains, it's time to see how we can use proportional editing to shape them.

First make sure we're in side view (NUM3).
Then on the smooth falloff mountain, the first one we created, select the vertex that is immediately down and left from 
the topmost point.
Press RKEY to rotate, and hold CTRL and rotate everything by -90. Alternatively, use RKEY, NKEY, and type -90
and press ENTER

Feel free to play around with scaling or rotating from different view points.

Smoothing things out

Now that we have a couple of budding 
mountains, you probably think they look kind of
choppy. Sure they would be good if we were 
making an 8-bit console game, but we're 
working with 3D here, we want things to look 
sharper (or maybe smoother) than that. There 
are a couple of approaches to this. The first is to 
use more vertices when we create our plane. 
And I won't lie, it works. But it's also a HUGE 
resource hog. It would take your home 
computer hours of work just to keep things 
updated, let alone run it. So instead, we fake it. The easiest way to do this is to turn on SubSurfaces (we saw this in Detailing 
Your Simple Person 1.) For our purposes, let's set the subdivision (Subdiv) to 2. Also, ensure our SubSurf algorithm is set to 
Catmull-Clark (this is the default setting).

Now, you'll notice that with SubSurf on, we lose a lot of hard edges that we had, essentially we have no sharp corners anymore.
I don't know about you, but to me that doesn't make for a very interesting mountain range. So to restore our corners, we are 
going to use Weighted Creases for Subsurfs.

First turn off proportional editing with the OKEY, and ensure we're in side view with NUM3
Next, while still in edit mode, change to Edge Select mode with CTRL+TAB and select Edges. Alternatively press Edge 
Select Mode button at the bottom of the object window.

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P


Blender 3D: Noob to Pro - Beginner Tutorials/Print version - Wikib... http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P...

52 of 263 5.5.2007 21:39

Under the Edit buttons under Mesh Tools 1 ensure that Draw Creases is selected. (Mesh tools one may be off the screen, 
if so, use the scroll wheel when over the Edit Panel to reveal it.

Noob note: "Mesh Tools 1" is a separate panel from "Mesh Tools."
On our Sharp Falloff mountain, the second one we did, select the two edges on the right. (see image below)
Press SHIFT+EKEY or SPACE → Edit → Edges → Crease SubSurf, then 
move the mouse away from the edge until the edge Crease reads 1.000 in the 
3d views header. If moving the cursor there seems to be impossible, just hit 1
and enter.

As you move the cursor away from the edge you will notice two things. The first is 
that the edge becomes thicker as we move from it; this is showing how much of a 
crease we have (with Draw Creases turned on). The second is that you will notice 
the subsurfed mesh moving closer to the edge as the sharpness increases.

Naturalness

Push CTRL+TAB and select vertices. then go into front view NUM1 and select the second vertex from the top in the center, 
then go into side view NUM3. Push GKEY and drag the vertex inwards, not too far or your mountain will come out of itself on
the other side. Just bring it in enough to make a small indent.

Then grab the top vertex and pull it down a small amount. You will notice that there is a small "crunch" in your mountain.

Don't forget to select all, press WKey and hit the set smooth button to smooth everything out.

OK, so your mountains are starting to shape up. But they still look a bit too neat. You could spend time moving each individual
vertex but the chances are your model will still lack the natural feel. What we need is some chaos. Thankfully this is quite easy 
to accomplish. Firstly select the vertices that make up your mountains, all of them and a few around the base (box and circle 
select will make this easier). Select a few vertices between the mountains too. Next we use something called fractals. Fractals 
are chaotically (ie randomly) generated variables. In short you can use these variables to give your mountains a "wobbly" look. 
Fractals are located in the Mesh Tools section of your edit buttons (next to Noise, Hash and Xsort). Click it and you'll be asked 
for a value. This value is the strength of the fractal. 1 is very low and will barely change your model. 100 is very high and will 
twist your models into very odd shapes indeed. Have a play with different values until you find one that you like. Around about
15-30 should do it. Hit OK and hey presto, your mountains have been transformed from clinical neatness, to lumpy chaos.

If you make too many fractals, your computer will slow down. However, the more fractal you add, the more bumpy and 
realistic it looks!

Noob Note : Repeatedly using the fractal tool seems to rapidly multiply the amount of vertices on your canvas. I suggest using 
the tool once, and if the result isn't satifying, undo the result (CTRL + Z) and try it again with a different fractal strength. Even 
after undo, your selected vertices remain selected.

Adding your guy with the hat

To insert your guy with a hat, you can simply go to file > append or link(shift+F1). Then select the file from the previous
tutorial. You will then see a list of objects you can insert or ‘append’. First go into the 'Object' folder. Unless you renamed
him/her, your person will probably be named “cube.” [TO DO: How can I append the Object "cube" into my project ??] Repeat
the process to get the hat(probably named “circle”). To reset the parental relationship, see the instructions at the end of the
previous tutorial. To scale them to the appropriate size, go to object mode by pressing TAB (unless of course you are already 
there). Select the object you want to resize, then press the SKEY and use the cursor to scale as you see fit. To undo any 

 (Under Construction [TO DO: finish me])
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mistakes, use CTRL+Z.

Next Page: Creating Models With Photo Assistance
Previous Page: Putting Hat on Person

Creating Models With Photo Assistance

Next Page: Modeling a Gingerbread Man
Previous Page: Mountains Out Of Molehills

The first tutorial is about using guide images to place vertices in their proper places in 3D space. The second tutorial is on how 
to take good reference pictures. These tutorials assume that you have completed all previous tutorials.

Making A Pyramid
First we are going to create a pyramid the easy way. Then we are going to show how to use different viewpoints and images as 
a guide to place vertices correctly in 3D space.

You should have the default cube. If not, start a new project.

Go into Edit Mode (if in Object Mode, press TAB).
Select side view (NUM3).
Make sure no vertices are selected by pressing AKEY.
Go to Box Select mode (BKEY) draw a box around the top vertices of the box
Merge vertices by Pressing ALT+MKEY → At center and the top of the box is merged to a single point
Unselect all vertices (AKEY).
Box select (BKEY) the bottom 4 vertices
Hollow out the bottom of the pyramid by deleting the bottom face XKEY → faces (remember that if you want to change 
to face select mode press CTRL + TAB → faces)

Now that we have the pyramid the easy way, let's learn how to use photos as references to build models. First, unselect all the 
vertices by pressing AKEY. Next, select the bottom four vertices of the pyramid and delete them with DEL or XKEY. The 
only vertex left will be the vertex which makes the tip of the pyramid. This will be used later.

Window Layout

Split the Main 3D view window in to 4 windows. Explained in guide: Noob to Pro/Blender Windowing System.

Change the point of view in each window so that they end up like this:

NUM1 NUM7
NUM3 NUM0

Reference Pictures

Make a picture of a white square and of a white triangle in the GIMP, Paint :) or some other image editor.
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Read the following section carefully: Make sure that the
drawing of the square is square and not just rectangular. 
Make the triangle the same width and height as the 
square. Make sure the apex of the triangle is directly 
above the midpoint of its baseline. Suggested method of 
construction#1: Make the square. Save it, but keep it 
open. Delete everything except the bottom line. Make 
the triangle from the lower corners (ends of the baseline)
and make sure the two new lines meet exactly above the 
midpoint of the baseline. Make sure the triangle is 
visible against a black background as shown in the 
image. Save as a new file. Suggested method of 
construction#2: Download the black and white triangle image on the right of the 
screen and use that, make a square by filling it white and resaving it.

Save the files to a place that is easy to access. Blender only supports the TGA, PNG, 
and JPG image formats.

Background Images

Load the white square into the NUM7 window by going to the 3D view window and 
pressing View → Background image → (click on the icon of a file) find your file and
click "select image"

Load the white triangle into the NUM1 and NUM3 windows.

If necessary, zoom out so that you can see the whole picture.

Now you have a guide for making a pyramid.

The square and triangle relationship

Save the triangle with a black 
background
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If you can not see the picture, switch to Ortho view by hitting NUM5

Side One

The vertex that is left will be the topmost point of the pyramid. Use the GKEY to move the vertex around. To get it in the right 
spot, line it up at the top most point in the NUM1 and NUM3 windows. If you look in the NUM7 window the vertex should 
appear to be in the center. Make sure to keep the vertex highlighted for the next step.

(note: it might be helpful at some point to zoom in and use the X,Y and Z movement restriction)

Now, we are going to place more vertices in the scene. Since we want to have the new vertices connected to the first one, we 
will make sure the first vertex is selected and use CTRL and click LMB to create a new one. In the NUM3 window, place a 
vertex on the lower left edge of the triangle by holding CTRL and clicking there. This should create a line between your 2 
points. If needed, use GKEY to line it up in that window and also at the lower right point in the NUM7 window.

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P


Blender 3D: Noob to Pro - Beginner Tutorials/Print version - Wikib... http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P...

56 of 263 5.5.2007 21:39

Next, with only one of the vertices selected, in the NUM1 window place a vertex on the lower left edge of the triangle using the
same method. Line it up in that window and at the lower left point in the NUM7 window.

Now, select your 3 vertices (use AKEY) in the NUM1 window and press the FKEY. You should see a triangle appear.
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Side Two

Press AKEY to deselect all vertices and select the vertex at the top of the pyramid again. Repeat the process from Side One to 
make the next side. Place a vertex in each of the other corners of the square using CTRL and LMB. Line them up in two 
different views with the corners of the triangle and square. Make sure only the top vertex and the two new vertices are selected 
and type FKEY. This will fill in a face opposite of the first face in the pyramid. 

Sides Three and Four

To fill in the other two sides select the top vertice and the corners on a side where there is no face yet. Again, use FKEY to fill 
in a face. Repeat this for the last side to have all four sides created.

Bottom

In the NUM7 window select all four corners and make a face. You should have a solid pyramid! Now, select all 4 faces and hit 

X faces.

Taking the Best Reference Photos
Remember what I said about turning a cube into a puppy? We'll do that now.
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Step One: Get the pictures of the model

[note: The images here do not line up. Some need to be rotated, and others do not match in size. They will be kept so that you 
can get the "real feel" for this project.]

If you have a puppy and a digital camera, take three pictures of the cute little rascal, and upload them. If you don't have a 
puppy, any object or small animal will do. Ideally, the photos will be looking straight down at the top of the puppy, a side view,
and a front view, and, most importantly, the puppy should be in the same pose in all three photos! Or at least close to the same 
pose...we all know puppies don't stand still very long.

You could use two mirrors. One is placed next to the puppy at 45 degrees to the camera and 45 degrees to the puppy. Another is
placed above the puppy, also at 45 degrees to the camera and 45 degrees to the puppy. This produces three images, one of the 
puppy (NUM1), one of its reflection seen 90 degrees to the right (NUM3), and one of its reflection seen from overhead 
(NUM7). Take the photo from a long distance away with a zoom lens to get close to an orthographic projection
(http://en.wikipedia.org/wiki/Orthographic) .

Or how about a toy wolf taken from 6 views: Left view (http://img51.imageshack.us/my.php?image=10011325wu.jpg) Right 
view (http://img162.imageshack.us/my.php?image=10011337aj.jpg) Front view
(http://img107.imageshack.us/my.php?image=10011347fw.jpg) Back view
(http://img107.imageshack.us/my.php?image=10011350gu.jpg) Bottom view
(http://img162.imageshack.us/my.php?image=10011363ql.jpg) Top view
(http://img119.imageshack.us/my.php?image=10011375bc.jpg) 

Using your favorite image editor such as PhotoShop or the GIMP, the images need to be down-scaled to a reasonable size (I 
made mine 512x384), and then matched to each other. To match them, draw construction lines (pulled from the rulers above 
and to the left) on the left view for example to pick out key features. I picked the tail, front of back foot, eye level, tip of the ear, 
front of the nose:

I found when I picked out these features that this first image needed to be rotated slightly. That completed, I proceeded to scale,
rotate and shift the other two views (top and front) until they matched fairly well as layers on top:
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Once I had the proper results, I saved the resulting images, and these are the ones we will use in Blender.

The results are the files you'll need for Step Two:
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Just right-click and save them some place where you can find them to load them into Blender for Step Two. You may notice the
photos aren't perfect, but we'll use them just to show how you should deal with your real photos. When you are creating your 
own pictures to import, note parallax (http://en.wikipedia.org/wiki/Parallax) . In this example, parallax is present, and we'll 
attempt to compensate.

Step Two: Get the Picture into Blender

Getting the image into blender is the easy part. The more difficult part will be creating the mesh, but first things first. Create a 
new file (File -> New) to see the familiar default objects. Don't bother deleting the cube, we'll end up using it. Split the 3D 
Viewer into four views and assign them the following cameras.

Num 7 Num 3
Num 1 Num 0

Each window will show you different XYZ coordinates with the Num 0 view being what your object will look like to the 
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camera object.

Now that the screen is set up, let's load the images. In the top left viewport (XY), click 'view' on the viewport's header (the 
menu at the bottom). From the menu provided, select 'Background Image ...'. A small window will appear.

Click the 'Use Background Image' button and several more buttons will appear. Now click on the folder icon located to the right
of 'Image:'. A new full-viewport window will appear. Explore this window a bit and end up selecting the image file of the wolf 
from the top view. What you should get is the picture of the toy wolf from above with the default cube on top of it. Rotate your 
view of the cube. The picture disappeared! But don't worry - the picture is still there. Press Num 7 to realign the viewport and 
see the picture again.

Now load the front view of the wolf into the top right viewport (YZ) as you did the top view. Repeat the procedure and load the
side view of the wolf into the bottom left viewport (XZ). As a note, each picture is specific to the viewport it was loaded into. 
When you switch between axes views, the picture will not change. Try this out by changing the top left viewport to Num 3 and 
Num 1. Return the viewport to Num 7 before continuing.

The pictures are now loaded into the Blender viewports. If you look at the pictures on the grid, you may notice that the front 
view of the wolf isn't quite center. That is okay, Blender has a way to fix it.

Move your cursor over the Num 3 viewport and press Shift + SpaceBar, this expands the current viewport(Num 3/ front view) 
to a fullscreen view, then open the Background Image window for the front view again. Notice that there are picture 
manipulation options available. One of these includes picture offsets. Click on right side of the 'X Offset: 0.00' to increase the 
offset to 0.20. The picture will be shifted over slightly so now the wolf is more centered. Press Shift + SpaceBar again to 
return to the four viewport view you created earlier.

Figure 2.2.1 Viewport picture setup

The setup work is now done! Let's start on actually making the wolf model.

Step Three: Rough Model Fitting

This is a brute force model creation using techniques discussed previously in this book. This section is meant to explore and 
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become more comfortable with them. Do NOT try to follow the example to the tee. Your wolf and my wolf will probably not 
look the same since you may want to add more or have less detail.

WARNING: If you are following this book all the way through, and are just getting started with blender, the following step 
(step 3 as a whole that is) may likely take several hours to complete. The best strategy is to take breaks, be patient, and with 
time you'll figure out the best way to go about this step.

The rough fit stage requires either some planning or on-the-spot decisions. Think about where the wolf will have parts of its 
body flex or require parts jutting out.

The first step is to create a blocky wolf. Start out with a column of blocks using the extrude face command (select face, 
EKEY). Don't worry about snapping the vertices to the grid since we are working with an organic figure.

Figure 2.3.1 Body column formation

The next step is to split the ears and legs off of the body. Do this by subdividing the appropriate faces. Save often, and if you 
make a mistake, go ahead and use the undo option (CTRL ZKEY). Also, if you find yourself looking at redundant faces, 
combine them (FKEY).

Figure 2.3.2 Appendage formation
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]

If you are having trouble with this, try mousing over the perspective window (the one you designated with Num 0) and using 
the MMB to rotate the view so that you are looking at the underside of the wolf. Click on the face underneath the wolf that is 
alongside his front legs (use the side view to check this). We are going to subdivide this face in order to grow legs off the new 
faces. To subdivide, press the WKEY and choose subdivide. You will see that the face has been divided into four. Take one of 
these faces and extrude it as many times as is necessary to make the right leg. Then do the same again for his left leg. Use the 
pictures as a guide.

Doing the ears is similar, except instead of working underneath you will start with the face on top of the wolf which is directly 
over the ears. Select this face and subdivide it once. Deselect everything using AKEY, then select one of these four faces and 
extrude it upwards once to make an ear. Do the same for the face alongside it to make the other ear.

Finally, extrude the tail end of the wolf one more time, so that your wolf has as many divisions as the picture above.

Let's start refining the model starting with the tail. Try putting your viewports in wireframe mode by pushing Z, it may make 
things much easier. Line up the vertices over the wolf in each viewport by lasso selecting multiple vertices (CTRL LMB, 
Drag). then move to the right location with grab (GKEY).

Figure 2.3.3 Working on the tail
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Continue onto the hind legs of the wolf. It is trickier to manipulate the legs so keep rotating a viewport to look at the model 
from multiple perspectives. Remember that we are working in three dimensions.

Figure 2.3.4 Working on the hind legs

Continue working up along the wolf fitting the blocks to the pictures. If you have problems seeing the picture because the 
model is in the way, let's hide the model. In Edit Mode, select the entire model by AKEY or by pressing LKEY when you have
the cursor over the model. Simply pressing HKEY will hide the selected items. To unhide the view, use ALT HKEY. By 
hiding and unhiding the model, or parts of the model, you should be able to keep using the picture as a guide.

Once you have the first pass done, you'll notice that the model just won't fit all three pictures correctly. This is due to parellax. 
The most obvious example is the side view. The four feet should be level, as they are all standing on a flat surface. Since they 
are not, we'll just ignore some of the aspects of each picture and continue with the model. (This is a helpful example to show 
what you need to consider when taking your own pictures.)

Figure 2.3.5 Completed rough fit
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EDIT** by Tittipoco Thu 03.05.2007

Attention: The top right Viewport is said to be "NUM 3 - Side" but the Picture shows the wolf from the front! So care and 
change the picture with the left window at the bottom or change the Viewportsettings

Step Four: Refining the Wolf Model

Now that the rough fit is done, let's smooth out the wolf. Add a Subsurf modifier and set the Levels to 2. The wolf will now be 
smoothed, but we want to add some of the hard lines back into the model. This may be accomplished with creased edges.

First, turn on the view creased edges by toggling the 'Draw Creases' button in the Mesh Tools 1 window. Enter Select Edges or 
Select Faces mode (CTRL TAB). Highlight the edge or face you want to crease and press SHIFT + EKEY. Use the mouse 
and pull away from the center until the Crease value is close to what you want. A value of +1.000 will give you the sharpest 
look and is useful for places such as the bottoms of the paws. When an edge has been creased, the edge will be highlighted in 
yellow (positive crease) or black (negative crease). These highlights are shown due to the 'Draw Creases' button being turned 
on.

In this example, I creased edges along the paws, tail, ears, and nose to give them some sharpness.

Figure 2.4.1 Creased edges
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The last step is to refit the model to the pictures. You may have noticed that when the model was smoothed, the result didn't 
quite fit to the pictures. Now is a great time to tweak the vertices to fit to the pictures or add to/modify the model.

And here is my basic wolf based on three pictures!

Figure 2.4.2 Final toy wolf model

Alternative Wolf Modelling

(user comment) I was doing this tutorial and though I´m still a noob at this I thought I could contribute a little to this. I
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decided only to do half a wolf and then mirror it to create a complete wolf. I started out with creating the silhuette of the 
wolf body in the side view, and then in front view I started to shape the wolf head, tail and legs...

And at any rate this is what I ended up with. Not the best wolf ever, but as I said before I´m still pretty noobish.
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From this point forward there are multiple ways to do the exact same thing, however for simplicity's sake and so that I can be 
more detailed I will be using one method (the one which I use) and be using GIMP.

I found it best to size all the photos to a known width, with an easy to find center. (Mine happened to be 850x638 pixels, I
don’t recommend that but you can choose any size you want really, as long as all of them are the same size). Then drag the
construction lines to form a crosshair in the middle of the photo. To do this, click on the top ruler, and drag down to the middle
(Exact middle) of the photo, then click on the side ruler and drag across to the middle (Again exact middle) of the photo.

If you are having troubles finding the exact middle of the photo, move the cursor to the very bottom left of your photo and the 
height of your photo will be listed at the bottom left of the GIMP interface. The numbers are listed in an (x,y) format so you 
want the first number to say 0 and the second to be the largest you can make it by dragging your cursor. The second number is 
the height, and half of that is the middle of your photo. You can do the same with the top ruler to find the vertical middle of 
your photo. Only this time the co-ordinates at the bottom left of the GIMP interface should list the second number (y) as 0, and 
the first number should be as large as you can make it by moving your cursor (to the upper right of the photo).Once you have 
your width again half of that will be the middle of your photo.

Then using construction lines put one at the top of your object, and the bottom of your object. Find the "height" of your object
by the distance between them. Remove the construction lines from the top and the bottom, and place a new construction line
above the horizontal center line by the half of the "height"(of your object). Now place a construction line on both sides of your
object and find the “width” (distance between the new vertical lines), then remove those construction lines and place a new
construction line vertically half of the "width"(of your object) to the right of the vertical center line. Now cut the object out, and
drag it so that the point you used as the "top" is on the horizontal construction line that is above the middle. Then Drag the
photo left or right until the right edge of the object is on the vertical construction line you put in right of the middle
construction line.
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Now the center of your object is at the center of your photo. This is a very important thing because when blender loads in the 
picture you will need this so that all of your pictures match up with each other 3d. You should repeat these steps with all 3 
photos. I also dont recommend doing it in GIMP's "layered mode" as that caused more pandemonium for me. I recommend 
opening each photo in a new window .

Taking your pictures is the most important part, because if the pictures are not all in the same scale (object size to photo size) 
then your photos will not line up and you won't be able to place a dot on the same location from front view, side view, and top 
view.

As a recommendation I would recommend making your first model from a Lego man. That is what I did and it is very simplistic
easy practice. To take my photos I took about 10 minutes to construct a photo platform for my object. It consisted of a
cardboard box with two sides cut out. I covered the inside area with computer paper. I then used a 2”x4” and a ruler to make
sure that the box stayed the same distance from the camera for all shots, as well as marking where the Lego man’s feet were
positioned inside the box with a pencil. This will provide good pictures, providing you keep the camera at the same distance
and zoom for all three photos.

Next Page: Modeling a Gingerbread Man
Previous Page: Mountains Out Of Molehills

Modeling a Gingerbread Man

Next Page: Penguins from spheres
Previous Page: Creating Models With Photo Assistance

In this tutorial you will learn how to make a simple gingerbread man. In a later tutorial you will be able to make an animation 
with this gingerbread man.

In this tutorial we will tie together everything we've talked about up to this point, including extruding, subdividing and 
rendering, and throw in basic lighting.

Modelling

First, start Blender and zoom in until you can see everything (scroll with the MMB or press CTRL+MMB). Make sure you are
in orthographic mode : press NUM5 to go into orthographic mode.

Select the cube by clicking RMB on it. To review, when an object is a whitish color, it is selected.
Now press TAB. When you press TAB it will switch you between Object Mode and Edit Mode. If you pressed TAB you
will see pinkish dots. The pink dots are called vertices. (You will know if you are in Edit Mode if you can see those 
dots.) When you select vertices with the RMB, they will turn yellow.

Select all the vertices (AKEY once or twice) and then click on the editing tab  in the header of the buttons window 
(or you can just press F9) to go to editing.
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Once you are there you will see a new menu at the bottom of the page, click on the subdivide button in the section called 
Mesh Tools (while all the vertices are selected). You will see that your cube now has more vertices. This tool is used for 
dividing an object so that you can do more complex models. [Note] In newer versions, you can also hit SPACE and, in 
the menu that comes up, Edit → Edges → Subdivide. [Note] You can also press the WKEY, and click subdivide

Now press AKEY to unselect all the vertices, go to the front view (NUM1) and press BKEY and drag a square around 
the top left and middle left vertices or press BKEY twice and you will see a circle around your mouse - all the vertices in 
the circle will be selected by pushing LMB.

Take a closer look on the selected vertices by viewing the model from a different angle (remember that you can use 
MMB to achieve this). If you find that you have only selected two vertices and not six, there are 2 ways of solving your 
problem. You could hit the ZKEY to toggle between wireframe mode and solid mode or you could hit (and deactivate) 
the Button in the selection mode buttons (note that this button is shown only if you're in solid mode). 
Repeat the previous step and see the difference.

After selecting the 6 vertices press EKEY and select Region. This will extrude the selected vertices. Put the new vertices 
on the adjacent gray line of the grid one unit to the left (press CTRL to snap to grid). Do this two times so that it looks 
like below (the snapshot has been taken in a front view (NUM1)) :
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Clear your selection (AKEY).

Now select the other two vertices (six in 3D again) on the opposite side and do the same there as explained above. Now 
the arms are complete, as you can see in the illustration below.

  

Now we will do the legs.

First, unselect all the vertices : use AKEY.

Select the bottom left two vertices, extrude it and put them in between the gray line (the gray lines in the grid 
representing the Blender units) and the second gray line below. If holding down CTRL you will notice that the two 
vertices snap to the grid in the background and you won't be able to select in between them, but jump between one and 
two of them. Press SHIFT as well and you'll be able to go in tenths of the units. (You can also just enter the number 1.5 
to extrude it 1 1/2 units out. On Mac, enter the number 1, press fn with the key that is right under Lkey and Mkey on 
Azerty (the one with /:,), and press the number 5)

  

Extrude it again and put it on the third gray line (or, once again, enter 1.5). It should now look like this:
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Use the BKEY to select the bottom 4 vertices (12 in 3D) of the leg, and use the GKEY to pull it out to the left by half a 
square so that it looks like this

  

Do this again for the right leg.

Use BKEY to select the vertices at the groin (where the two legs join)

Press GKEY and pull it down by 1/2 a square (type GKEY, ZKEY and write -0.5 - in older version you have to type 
type GKEY, ZKEY but also NKEY and write -0.5 then)

(I had some problems here, trying to move the vertices. There were too many vertices in the same place, and that creates 
strange forms. To erase the duplicate vertices on top of each other, you can either select the entire model, or just the vertices 
you want to clean. Then press WKEY and choose Remove Doubles.)
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Press TAB to go out of edit mode (you will know if you are out of edit mode if the vertices are not visible). You are now 
in object mode.

Click RMB on the object to select it then press SHIFT + SKEY and select Cursor → Selection. This will make sure the 
cube you'll add next will be near where you want it.

Press SPACE and put your mouse on the mesh option and select cube. In others versions, you can also hit SPACE and , 
in the menu that comes up, choose Add → Mesh → Cube.

Press GKEY and put your new cube about 1/3 of the way down the neck (to achieve this, you can press GKEY and 
ZKEY : enter 1.33).

Now we will make it look more like a ginger bread man by making it thinner.

Go to side view with NUM3.

Press SKEY for scale and press YKEY for Y-axis and then move your mouse to the middle until the it is about 0.3 (use 
CTRL for fixed values).

Remember X-axis is the Red arrow/line, Y-axis is the Green one, and Z-axis is Blue (like RGB video mode).
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In OBJECT mode, use RMB on the body and press SKEY and then YKEY and make it as flat as the head.

Use the MMB to spin the view around and examine your handiwork.

At this point, it doesn't look entirely like a gingerbread man, does it? It's a bit too ... chunky. For the last bit, we'll smooth it out.

Make sure you've selected the body in object mode.

Select the editing panel in the buttons window (or hit F9).

In the Modifiers tab, Add a "Subsurf" modifier. You can also push SHIFT + O

Set the level of the subdivisions to 2, and the number of render levels to 3.

You can press the ZKEY to switch back and forth between wire-frame view and solid view.

In the 'Link and materials' section, select 'Set Smooth'.

(Note that here I had the same problem as before, with superposed vertices. Select all vertices, then press WKEY and select 
Remove Doubles to clean your model. You will see that it will look much better after removing the extra vertices with Remove 
Doubles)
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Press the ZKEY to return to wire-frame view.

Now repeat the process above to smooth the head.

Looks a lot more like a gingerbread man, now, doesn't it?

Camera Positioning and Rendering

This guide will show you how to intuitively get the best shot of your 3D scene with no effort !

Press TAB for Object view mode.
Press NUM0 to get the Camera View.
Select the camera by clicking RMB on the outermost rectangle.
Press GKEY and move your mouse to adjust the position of the camera (XKEY, YKEY, ZKEY and CTRL may be 
useful here).
In addition, you can press NUM7 to get the Top View and press RKEY to rotate the camera to the best angle.
After you are happy with the position, press F12 to render it.

(user comment) When rotating the camera, I found it much easier to split
the view into two areas, and set one view to top (7) and the other view to camera (0).

(user comment) Remember to move the light to a better position, or your gingerbread man could be
a little dark.
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Penguins from spheres

Next Page: Die Another Way
Previous Page: Modeling a Gingerbread Man

This section needs more images, also, there seems to be much confusion by newer members following this tutorial, 
experienced members, please modify for more clarity

Step 1 – setup

When blender starts, there is a cube created automatically. Delete this cube by pressing XKEY and then press LMB. You will
also want to make sure the 3d cursor is in the center of the screen. Check that you’re in Object mode. If you are in Edit mode, 
press TAB to switch to Object mode.

Step 2 – the body

Make sure that you’re in the top view, by pressing NUM7.

We start by creating our main body from a sphere. Press SPACE → Add → Mesh → UVSphere and 
choose 16 segments and 16 rings from the pop-ups.

Blender automatically switches into Edit mode when you create a mesh object, but this is ok, since 
we will start editing the mesh now. Press NUM1 to switch to the front view. We’re going to make it
a bit taller. Press and release SKEY, then ZKEY to restrict resizing to the Z-axis. Then Press and 
hold CTRL to snap resizing to even decimal points, and move your mouse upwards until the size 
counter in the lower left corner of the view says 2.000, then press LMB. (You can also type "2" 
instead of using the mouse)

This is our main body.

Step 3 – the head

I normally use reference pictures, but this time we will try to make it without one. We’re going to try and shape the penguin
head from the top of the sphere.

Start by switching to the top view (NUM7) and select the two smallest circle segments. Make sure Limit Selection To Visible
selected, or you will end up with the top and the bottom both selected. (Limit Selection To Visible is second right-most button 
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at the bottom of the 3D window)

There are many ways of doing this, but I’m going to use the lasso tool which is unique. Start by pressing the AKEY to deselect 
all vertices. Then Press and hold the CTRLkey, and select the segments by pressing and holding LMB and move your mouse 
in a circle around the vertices that you would like to select.

(Alternate selection tools:

Press the BKEY once and LMB-drag to get a rectangular selection tool;

or

Press BKEY twice to get a circular selection tool [scroll the MMB to change 
circular selection size], LMB to select, RMB when done

or

RMB on the top most vertex to select it then press CTRL + NUM+ until done

)

NOTE: To use the handles (blue arrow, green arrow, etc) you need to turn on 3d transform manipulators. Push CTRL + 
SPACE and selected 'Enable' if you don't see them

NOTE: You can also have the same effect by pressing GKEY, and ZKEY.

Now switch to the front view (NUM1) and pull the blue arrow with your mouse while holding the CTRL, and move the 
vertices 0.3 unit upwards.

Now switch to the side view (NUM3), press and release RKEY (for rotate) and rotate 
these vertices 30 degrees counter-clockwise. (Hold CTRL while rotating to restrict 
rotation to even number degrees). (In the version 2.42 you can also rotate by pressing 
RKEY and the number of degrees in the clockwise direction)

Switch to the top view, select an additional ring of vertices by holding down CTRL
and pressing the NUM+ key (You may contract the selection by pressing CTRL + 
NUM-), and move these vertices an additional 0.3 unit upwards, and rotate them in
the same way 30 degrees counter-clockwise in the side view. Then repeat this two
more times, and we’re looking at something that really doesn’t look like a penguin
unless we have a really good imagination.

START - unclear section (I skipped this, and the penguin looks just like that one at the bottom 
right)

Now switch to side view (NUM3) and move all of the selected vertices to the left 0.4 units by 
pulling the green arrow and holding CTRL to restrict movement to even tenths of units. This 
straightens out the neck.

Correction- Newer versions do not automatically adjust to tenths of units when you press 
control. Instead of pressing control, just select the green arrow and move it to approximately 
(-.4). You can tell the number of units by looking at the bottom left hand of your window.
END - unclear section
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Now lets create the beak. We’re going to make this simple. Just switch to the front view
(NUM1), and select the front most vertex (the one that originally was the top vertex of the 
sphere) by pressing RMB right on top of it. Then switch to the side view (NUM3) and pull the 
vertex to the left 1.2 units using the green arrow. (You can also move the vertices from the 
keyboard with the following sequence: GKEY, YKEY, -1.2, ENTER)

The main body of the penguin is now finished. The next step is to create some flappers for our 
poor little guy.

Step 4 - the wings

We are going to create his wings by extruding faces on each side of the penguin.

Switch to side view 
(NUM3) and switch to
face selection. Then select two faces that will make up the
penguin’s shoulder by selecting the first one with RMB, 
and then holding SHIFT and selecting the second one.

(Note: which faces to be selected needs to be specified 
to avoid confusion)

Now switch to front view (NUM1), press EKEY (popup: 
choose Region), hold CTRL to snap, and extrude the 

penguins shoulder 0.3 units.

We now want to do the same thing with the bottom two faces of the newly extruded faces. 
Press the AKEY to deselect everything. You can either:

rotate the view with your mouse (MMB), or
press NUM2 two times to rotate the view so that you can see the bottom of the 
shoulder, or
press CTRL+NUM7 to view the bottom.

Select the two faces using RMB and SHIFT+RMB, switch to front view (NUM1), press the EKEY to extrude (Choose: 
Region), and hold CTRL while extruding the wing about 1.4 units.

Now do the same thing with the left wing (no, the penguin’s OTHER left wing). CTRL+NUM3 to view the back (or rotate with 
MMB, or press NUM4 several times).

Note: I noticed while doing this that the snap length is not completely consistent.
Sometimes my extrusion snaps to whole units, and sometimes to tenths of units. I’m not
quite sure why this happens. For me, it helps to go back to front view (NUM1) while doing 
the actual extrusion. (You can extrude with exact units when you just type the number of 
units while you are extruding)

ad Note: under blender v 2.41 if you want to snap in smaller 'jumps' also press shift (both 
shift and ctrl are now pressed) User Note: I found that you have to zoom in a certain 
amount to get tenths of units. And vice versa for whole units. [Weasel note: in v 2.41 you 
can extrude by EKEY then use 2KEY to specify two units regardless of point of view and 
zoom.]

ad ad Note: You can tell when blender changes from using 1.0 snapping to 0.1 snapping 
when the grid divides itself in to tenths. Furthermore, if you zoom outward the grid will 
change to measure by tens and even hundreds, etc. Extrude + CTRL uses the grid size by 
default.

Looks odd for you're looking at 
the selected faces from the 

inside.

Error creating thumbnail: 
Invalid thumbnail 
parameters
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Now we’re going to smooth out that shoulder. That can be done in many ways, I’m going to show you just one. Rotate your
penguin so that you can see its shoulder from above. Press AKEY to deselect all vertices. Then switch to vertex selection and 
select two of the vertices with your right mouse button.

(User Note:Clearer instuctions would be helpful, hard to understand which two 
vertices)

[Weasel note: Then use NUM1 to switch to the front view, then select the front two 
vertices of the penguin's left shoulder.]

(Another Note: In front view (NUM1; as in pic above) select the topmost vertex (and 
the one right behind it) of the rightmost vertices.)

(Yet Another Note: The paragraph above and below this one may seem very confusing. The instructions need to be
more specific regarding which vertices to select. I found it out, but your instructions didn't help me decide which 
vertices I should have chosen.)

Press ALT + MKEY, a pop-up appears, choose At Center in order to merge the two vertices at center. Then repeat for the two 
middle vertices of the shoulder and finally for the backmost pair; clear your selection (AKEY) each time before merging.

The do the same on the opposite side of the penguin.

Note: I had some trouble merging my vertices; somehow there had been duplicates when I performed the extrusion.
Press AKEY to select all vertices, and choose WKEY and Remove doubles before doing this. In my case, 12 
vertices were removed.
(User comment: You probably selected 'individual faces' instead of 'region' when extruding. twofingers)

The next step is then to do a similar change to the wing tips; I select two vertices and 
merge them with ALT + MKEY. I’m leaving the middle segments for now, I don’t
want them wing tips to be too pointy.

I finish off the wings by selecting the two backmost vertices of the wings, and move 
these upwards using the blue arrow by -0.1 unit.

(User comment on using the arrows: I mentioned earlier that the grid snap
seemed inconsistent. It now seems that when I’ve got the 3d manipulators
enabled (the arrows), the grid size is 1.0 units. When I have them turned off, the
grid size is 0.1 unit. I don’t know why, and I haven’t found where to change
this. The previous picture shows where to turn the 3D manipulators on/off, and
which arrow to drag (using LMB) to achieve Z-axis movement.)

(User comment: if you spin the view it becomes 1.0 snapping, go back by 
pressing NUM1 and you should get 0.1 if not make sure View →
Orthographic is checked and not Perspective this can also be done with 
NUM5)

(User comment: I've had trouble with the three axis arrows. When I click on the
'hand' icon, the three lines come up but with little blocks instead of arrows at 
the ends, which I believe means that they will scale instead of move. So, I have had to use GKEY for 'grab' and 
then ZKEY or YKEY or whatever to move along an axis.)

(Note from another user: Next to the hand click the triangle to go to Moving Mode).

(Another user comment (not from the first): Whenever I try using the arrows I always find that I click on 
something else, so I have to change angle and after that, it's not really worth using it anyway)
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Step 5 - the feet

(Note from user: this section needs clearer instructions and more picures. In fact, when deleting vertices it refers to 
pictures which do not exist, and other parts are unclear)

I’m going to start off by tearing our little guy apart. Change to the front view, and make sure that the “Limit selection to
visible” is turned off.

Make sure no vertices are selected (by pressing the AKEY) and select the lower segments as 
in the picture (hold the CTRL while dragging to select). Then press XKEY and choose 
Vertices, and our penguin is hollow.

(User Note: I guess (according to the following pics) "lower segment" refers to the 
bottom vertex of the penguin and the vertices adjacent to the bottom vertex.)

Now select the bottom most vertices in the same fashion, and press SHIFT + FKEY to Fill 
the hollow bottom of the poor bottomless penguin.

Note: A nicer way to close off a symmetrical hole, like a circle: Extrude EKEY, cancel move RMB, merge ALT+MKEY, 
select "at center". This leaves a nice circle of triangles.

The next step is to provide the little guy
with feet. To do this, we’re going to extrude
two of the front faces. Switch to face select
mode, and turn ON “limit selection to
visible” and select the face to the left and

right of the middle two faces of the penguin. Then switch to side view
(NUM3).

Press 
EKEY
to 
extrude, choose Region, and press YKEY to restrict
extrusion to the Y-axis. Then extrude the feet

approximately 0.6 units. Now select the two front faces of the feet using “face select mode”, and look for the “Mesh tools” in
the Edit buttons panel. If you can’t see it, press “F9” to switch to the Edit buttons panel. Then press “Subdivide”.

Here the subdivision happened before the 
extrusion.
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Now select the middle triad of vertices on both feet, and using YKEY to restrict movement 
to the Y-axis, drag them using your LMB approximately 0.3 units in towards the penguin.(if
you have problems with this use 'remove doubles' again)

(Note: Either Drag LMB or type GKEY to move the selection. Then restrict movement 
typing YKEY.)

Now lets flatten the feet 
a little. Switch to front 
view (NUM1), select 
the bottom two vertice 
rows using CTRL and the LMB lasso. (Make sure that
“Limit selection to visible” is turned off.) Then Press and
release SKEY (resize) and press (and release) ZKEY
(Limit to Z-axis) and resize the bottom and the feet to 

approximately 0.4 units.

[Note: The bottom two vertice rows of the penguin itself: that means rows that include top 
and bottom of the feet.]
(Note too: 0.4 units does not mean Blender units but the scaling factor. Thus both vertex rows
come closer together maintaining the median height.)

His feet still look rather peculiar, so please go ahead and move the vertices around on your own if you like. Just remember to
restrict movement in the X- or Y-axis to make sure that he’s standing steady. (Remember: You can use the GKEY to move 
selected vertices, followed by the XKEY or YKEY to restrict movement to respectively the X- or Y-axis.)

The pictures below do not reflect this, but all penguins have a tail of sorts. For his tail (the 
end of the tuxedo) rotate to your penguin's backside. (Note: you can use CTRL + NUM1 as a 
shortcut to view the back) Make sure you have select vertices on, and select the three middle 
vertices in the second row up from the bottom. Switch to the side view (NUM3). Press and 
release EKEY to extrude and select "Edges". Extrude your edges around 0.3 units away from 
the penguin, and down 0.121 units so that the bottom of the tail is equal to the bottom of the 
penguin. The tail is not necessary to have a complete penguin look, it only makes the 
complete look more complete. Then Press the CTRL + WKEY to save.

(Note: With my penguin I had to move the tail down only 0.074 units. I'm not sure the tail 
was meant to be constructed the way the pictures show. Maybe someone can say some more 
about that.)
User Note: I found it easiest to select the centermost, lowest vertex and moving it on the Y axis only, this creates a crude but 
very effective tail (that doesnt look all that bad when subsurfed).

Step 6 - Subsurfing

Go into Object mode, and make sure the penguin is selected. Then check for the Modifiers toolkit in the Edit buttons panel. 
Press Add modifier → Subsurf. And look at the penguin now, he’s much smoother. You can alter the levels of the subsurfing if
you like, but I’ll settle for level one. Under the Links and Materials toolkit, you can press the Set Smooth button as well, which 
makes the Penguin really slick.

Now that's what I call a penguin. But then again, there are no penguins where I live, so I might be wrong.

(note by norleaf: I had some weird effects when sub-surfing on the bottom of the penguin and the tail I made for him... I found 
that removing the subsurf, then selecting those faces that had looked odd and flipping the normals (using WKEY and selecting 
Flip Normals) then sub-surfing again solved the problem.) Note: Same problem here, this fixed it, but no need to remove 
subsurf. Also, Flip Normals only had effect when faces were selected. An explination of Flip Normals would be helpful here.) 
(note by edwina: Sometimes it is necessary for all normals to be pointing outwards. This can be achieved easily by selecting all 
vertices with AKEY and pressing CTRL + NKEY, then confirm the dialogue box. CTRL + SHIFT + NKEY will turn them 
all inwards, which can be useful for some things.)
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This is what the 
penguin (sans tail) 
looks like, textured and 
ready. Orbisonitrum

The eyes are there, just 
not easily visible in the 
thumb. At the top of 
the white part, two 
faces on the chest were 
subdivided to give the 
white more of a curve 
at the top. The faces 
were selected that were 
going to be white, and 
the I used seperate (P) 
to make them a 
different mesh. I used a 
white material for the 
chest, black for the 
body, and grey 
uvspheres for the eyes. 
Apparantly, an easier 
way to colour the chest 
can be found at 
Multiple Materials
(http://www.blender.org/documentation/htmlI/x4448.html) 
please feel free to 
replace this with your 
own image of the 
penguin you made, 
with comments on how 
you put your own style 
into it --Most recent is 
Bnty 11:35 PST, 19 
May, 2006

A pretty basic picture 
of a penguin. I 
subdivided the stomach 
and eyes, but then I 
also added some 
eyeballs by making a 
UVSphere, cutting the 
top of it off, and then 
placing it inside of my 
penguin's head. All the 
colors have specular 
colors, giving the 
penguin a slight blue 
glow under the black."

Next Page: Die Another Way
Previous Page: Modeling a Gingerbread Man

Die Another Way (dice modeling)

Next Page: Die Easy
Previous Page: Penguins from spheres

This tutorial needs updating to address Blender version 2.42. [colouring section in particular is not relevant to 2.42]

Introduction
In the following tutorial you will be creating a die. You will use:

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P
http://www.blender.org/documentation/htmlI/x4448.html
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polygon mesh
face loop cutting
spin dup
subdivision surfaces
subdivision creases
bevel
set smooth
multiple materials
extrusion
merge vertices
remove doubles
constraints

There are two methods to create the circles for the die: subdivide first and manual sizing. In either case, start with the default 
Cube.Image:Pic1.png

Subdivide First
The die needs to have a 3x3 matrix for the colored dots (pips). A quick way to do this is to simply Subdivide the cube twice 
before doing anything else. The disadvantage may be that the spaces for the pips may not be exactly the size that you want. If 
not, see the next section: Manual Sizing of Pips.

Manual Sizing of Pips

Step 1

Hit tab to go into edit-mode and select all faces to prevent bevel messing up normals. Hit WKEY → Bevel, Recursion → 1
(you'll see why later) then choose bevel size (hit spacebar for manual input). Bevel of 0.15 is ok.
note: if you have chosen to subdivided twice the die and to jump to Step 10, put bevel of 0.17 in order to have pip's edges of 
length 0.34

Step 2

In editmode, go to the Editing tab (F9) and look at the mesh tools 1 panel. Turn on Edge Length and note the length of one of 
the sides of the square faces. This should be 1.7 if the above settings were used.

Button "Edge Length" may be outside the screen so you may need to close another set of buttons before you can 
get to it.
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Step 3

A typical die has a grid of 9 possible positions for the pips and the gap between the pips is the pip radius (or half the diameter). 
So, there are conveniently 10 units on each edge of the square faces, where the gaps use 4 of the units and the 3 pips use two 
each. This means the gaps are of size 1.7/10 = 0.17 and the pips (1.7x2)/10 = 0.34.

Image:Medidas.jpg

Step 4

In short and long what worked for me (Blender 2.43, PC; cube is beveled but has no pips so 
far):

Select axis aligned view: NUM1
Enter loop cut: CTRL+RKEY (OR KKEY→1KEY OR KKEY→Loop Cut OR 
CTRL+EKEY→Loopcut OR CTRL+EKEY→NUM5)
Enter loop number: 9KEY (OR NUM9 OR SCROLL up 9 times OR NUM+ 9 times)
Select loops' placement: LMB (OR ENTER etc.) on one of the big faces
Select edge select or vertex select: CTRL+TAB→NUM2 (OR CTRL+TAB→Edges
OR CTRL+TAB→NUM1 etc.)
Select loop to remove: ALT+RMB on an edge on the loop (etc.)
Remove loop: XKEY→7 (OR XKEY→Edge Loop)

Change view and repeat steps as necessary.
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Creating Pips
The die needs the pips added. Everyone knows how the pips on a die look, right?

Extrude and Merge

Select one of the faces where a pip would go and extrude the face by hitting EKEY and then ESC. Do not click after hitting 
EKEY. This actually replaces the first face with another one. Merge the second face by using ALT + MKEY to merge the 4 
corners into the center. It will tell you Removed 3 vertices. You should get the following:

 Do this for the configuration of the dots on that side. So for example, 5 would look like this:

Notes :

It is also possible to directly use the GKEY, the XKEY, YKEY or ZKEY (depending on what xy or z 
direction you are working on) and typing 0.17 (perhaps add a minus '-' if it goes up instead of in the die). 
After SubSurf it will look nice.
In previous note, if you grab the square surface, the pip is too large. If you grab the vertex at the center of the 
X, step 11 says exactly that. .

You could create this pip spot on all 9 spots and copy this side of the die to the other six. The amount of 
time spent doing all of that may be just as long as doing each side individually.
You would need to delete the other 5 faces, copy the dented face 5 times, place each face precicely by 
rotating and moving, and remove doubles.

Create Pips

Select one of the edges of the pips to check the size is 0.34.

Remember the pip radius was 0.17. We need to use this value to lower the centre point of the pips. Select all the 5 centre points

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P
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at once to save time and move them inwards by 0.17. The side I put the 5 pips on here was the top so I move the vertices 
inwards by pressing GKEY, ZKEY, -0.17 and hitting ENTER. I then get this:

Smooth Out

TAB out of Edit Mode. If you haven't done this already, hit Set Smooth in the Editing panel and turn on subdivision surfaces
Image:DieAnotherWay12a.png
It should look something like this:
Image:DieAnotherWay12b.png

In present versions, you just need to use "Add Modifier" on the Modifiers tab (in Edit-mode), to add a SubSurf modifier.
In the image below Levels is set to 3.

Make Sharp Edges

On a die, the edges of the pips are usually sharp so we'll use subsurface creasing to do that.

Go back into editmode and with the edge select mode on, select all the perimeters of the pips like so (it may help to turn off 
subsurf for the moment):

Press SHIFT+EKEY to enable creasing and move the mouse until the display says crease is at 1.  After pressing
SHIFT+EKEY, you can then set crease values in the information box that you get by pressing NKEY when objects are 
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selected. This can be useful to check if all the edges have the right crease because it gives you the average crease value and if it 
is less than 1, there is an edge wrong.

Repeat

Repeat steps 10, 11 and 13 (that is Extrude and Merge, Create Pips and Make Sharp Edges) for all the sides of the die. 
REMEMBER, a die is numbered so that opposite sides add up to 7. In my example, that means I put 2 on the bottom etc. Once 
you finish, if you turn on subdiv level 2, you will get something like this:

Camera Setup

You can make a test render now to see that the pips are the right size and that the bevel is right. So, turn the subdivision level 
for the rendering up to 3. To help position the camera so that you centre the die, you can make the camera look at the die by 
adding a track-to constraint to it. I prefer to track an empty though, because it is more flexible.

Make an empty by going into top down view (NUM7) and hitting SPACE → Add → Empty. It's always best to go into one of 
the set orthographic views so as to align new objects to the axes. If you add something misaligned, just go to the object menu 
then clear/apply > clear rotation (or ALT+RKEY). Because the empty was created at the origin, you might not be able to see it 
as it is inside the die. Hit ZKEY to enable wireframe mode and select the empty. Just move it outside the cube until we get the 
constraint set up.

To add a track-to constraint, select the camera first then SHIFT+RMB the empty and press CTRL+TKEY and choose 
"TrackTo Constraint" from the list. Move the empty back inside the die. You can edit constraints in the object tab (F7). Add a 
couple of lamps (both intensity 1) to get the scene like this or feel free to experiment with a more advanced lighting setup:

Another way to position the camera is by selecting it and then looking through it as you move it. Look through the camera by 
pressing NUM0. Use the GKEY to pan across and rotate around the local axes of the camera by pressing say 
RKEY,XKEY,XKEY to rotate in X-axis. To zoom in and out press GKEY, ZKEY, ZKEY and then move your mouse 
forwards or backwards. Another useful keystroke (for pre-2.43 especially) to know is that when you are in camera view, 
pressing Gkey and then MMB, movement will be contrained to the way you are facing. The mouse wheel zoom moves your 
view towards and away from the camera, without actually moving the position of the camera.

Render

To render, set the size of the image you want. 800x600 is a decent size so put these settings in the format panel in the Scene tab
(F10). In the render panel, make sure 100% is selected. If it's 50%, the render will come out as 400x300. For preview renders, 
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don't turn on OSA, which is anti-aliasing because it slows your renders down significantly. Try to only use it for a final render.

Another important point is to set the image format. This is done in the format panel. The listbox has a number of image types. I 
find that png is generally the best because it is lossless and offers the highest compression among the lossless formats. It also 
supports an alpha channel for transparency. When rendering an animation, it is better to render as an image sequence than as a 
movie because it is easier to edit these and repair broken frames. Quicktime supports loading of image sequences and you can 
save as a movie using a wide range of compression formats.

To save the render, go to the file menu → save image and type in the full name of the image including the extension e.g. 
die.png.

The output should now be looking something like this:
Image:DieAnotherWay16.png

Color

Multiple Materials

To give it some colour, we will need to use multiple materials because a typical die has pips 
that are a different colour from the die itself.

In the Buttons Window  go to the Editing panel  (F9) again and make sure the die is 
selected. In the Links and Materials subpanel there is a section for materials (the left; the 
right one is for vertex groups) and the box left of the question mark should read "0 Mat 0" 
(the first number is the number of material links for this object; the second number is the 
number of the currently selected material link).

The die may have more than zero materials if you had assigned materials to the object already. By 
pressing the New button add enough materials to make 2 in total.

Go back to the Shading panel  (F5) and there is a box at the very top 
of the Links and Pipelines subpanel with the number 2 beside it. If there
is no such subpanel select Material buttons  (cycle shading buttons 

using F5 too). Click this number and select Single user in the dialog to make the two materials you've just created independent. 
Use the arrows on the left side of the box to switch materials.
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Note: There should be at least two materials now. One has the materials initial name 
the other has a number appended to its name (e.g. Material and Material.001).

Use the Material subpanel to make material 1 bright red by just picking red in the colour 
picker (the rectangle to the right of the Col button) or by setting the RGB sliders (left of the 
Col button). Make material 2 white by doing the same. Or pick whatever colour you prefer 
and material settings.

Note: It is possible that the two materials were not 
automatically linked to the material links of your die. If so use the Links and Pipeline
subpanel to link the materials to the respective material links. First select the link then 
the material.

Assign Materials

These colours need to be assigned to the right parts of the die.

Go into Edit Mode and turn off subsurf to make selecting easier. Do this in the Editing panels 
(F9) Modifiers subpanel. Right after the subsurf modifiers name there are three buttons 
(darkgrey). Press the rightmost to deactivate the modifier in the edit mode.

Now select the inner faces of the pips - if you accidentally don't press SHIFT, press 
CTRL+ZKEY or UKEY to undo.

Note: Here you may find Lasso Select useful.

Make sure you are in Edit Mode  (TAB)
Select Face select : CTRL+TAB→3KEY
Select Limit selection to visible : should be the second button from the right 
in the header of the 3D View
Go through the axis align views and select the faces:

Align view: NUM1 (CTRL+NUM1, NUM3, CTRL+NUM3, NUM7, 
CTRL+NUM7)
For each view, lasso select the pips' faces: hold CTRL and drag LMB
around the pips' middle vertex (no need to press SHIFT, Lasso Select
automatically adds the new faces to the previous selection).

If all went well you should be able to read Fa:84-449 in the User Preferences
right after the Blender version number. (84 = 4*(1+2+3+4+5+6))

Once they are all selected, go to the Editing panel F9
again and in the Link and Materials panel select the colour for the pips by selecting the 
appropriate material link. There is an Assign button below - press it to associate the pips' 
faces with the selected material and it will make the pips white but the die remains red.
Turn subsurf back on (Modifiers panel→subsurf modifier→enable in edit mode) and
render F12 with OSA (only put it up as high as you need for the resolution of the image 
you are rendering).

Extra

The reason I modelled the die this way is because it is also very easy to change the sizes of 
the components e.g. the bevel and the pip size. You do this by selecting the vertical or 

horizontal segments and just scaling them in one axis. Here we will reduce the pip size and the bevel by half.

Go into front view (NUM1), turn off clipping and select a line containing pips. Then just scale in one axis e.g. SKEY, XKEY, 
0.5. Remember to have your pivot point set to median:
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Image:DieAnotherWayE1.png
Do this horizontally and vertically around the die. You should need to scale 9 times for the pips and 6 times for the bevel:

Image:DieAnotherWayE2.png
You may need to add extra geometry once you are satisfied with the sizes of the dots and the bevel so that the edges of the die 
don't look warped due to the subdivision. You can use face loop cut again for that and add extra lines in the middle of the gap 
segments.
Image:DieAnotherWayE3.png

Next Page: Die Easy
Previous Page: Penguins from spheres

Die Easy (dice modeling — revised Die Another Way)

Next Page: Model a Silver Goblet
Previous Page: Die Another Way

Die Easy

In the following tutorial, you will use:

polygon mesh
face loop cutting
subdivision surfaces
subdivision creases
bevel
set smooth
multiple materials
extrusion
merge vertices
constraints

1. Erase the default cube: XKEY>Erase selected Object(s)? — press ENTER or click LMB.

2. Create a new cube: to get the cube aligned with the axes, select either Top view (NUM7), Side view (NUM3) or Front view 
(NUM1) then SPACE→Add→Mesh→Cube.

The following all assumes you pressed NUM3 and then created the cube.

3. Create two materials for colouring: the new cube has no material associated with it and this can cause strange things to 
happen later on.

[is this correct?]
[ Couldn't change out of Object Mode after reloading a file with partially finished die] .
[(User:- I always find that when I cannot change out of Object mode it is because I have nothing selected which 
can be edited. I think an editable object (not a camera or a lamp) needs to be selected to go into Edit mode.)]

Go into Edit Mode (if in Object Mode, press TAB).

In the Link and Materials panel click twice on “New” under the selector showing “0 Mat 0”:
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this should change “0 Mat 0” to “2 Mat 2” and the blank space above “2 Mat 2” will now say “Material.001”

In Edit Mode, select Shading context (F5) and, on the Material panel, “Material.001” will be selected. To better keep track of
things, change the material's name from "Material.001" to "DieCol": click on the text "Material.001" which will show the name
as white on red, now enter the new name and press ENTER. (In my Blender 2.42a, the renaming part of the materials tab, is 
contained in a separate tab called ´Links and Pipelines´

To select a different colour from the default grey, click on the (default) grey bar to the left of "Col" and you will get a colour 
selector window.

Select the colour you want in the rainbow bar at the bottom of the window and, since this will be used as the die colour, move 
the tiny circle in the colour window above it to the bottom righthand corner, selecting a whitish colour.

Now create [?set the colour for the already created material?] a new material: click on the up/down arrow to the left of
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“MA:DieCol” at the top of the Material panel and select “ADD NEW”. The new material is called (by default), “DieCol.001”,
change this to “SpotCol”.

To change this colour click on the grey bar to the left of “Col” and select a dark colour for the spots.

Returning to Editing context(F9), DieCol will have been assigned to the cube, the coloured square to the left of “2 Mat 2” will
be SpotCol (the name is above “2 Mat 2”), the dark colour you've chosen. Leave it set like this so as each set of spots is
selected, this colour can be assigned to them.

(user note: Here you could hit 'subdivide' twice then do step four before skipping to step 6.)

4. Bevel the edges: if not already in EditMode press TAB; to select all the vertices press ZKEY to go into wireframe mode. To 
make sure of the selection (the newly created cube may already have all its vertices selected), press AKEY — if the cube goes
dark, press AKEY again.

Hit WKEY→Bevel→Recursion: 1, and, at the bottom left of the 3D Window, you will see

Press SPACE and in “Width: 0.nnnn OK”, click on the number, when it shifts to the left and appears in white on a pink
background, enter 0.15 (you can also enter the number as .15, 0.150, .150 &c. — they are all acceptable ways of entering 0.15),
press ENTER (it will revert to the black on grey), click on the OK button.

5. Dividing the faces: in the Editing context (F9) panel, “Mesh Tools 1”, click on “Edge Length” — the length of the top edge,
for instance, should show 1.700.

A typical die has a grid of 9 possible positions for the spots and the gap between the spots is the spot radius (or half the 
diameter). So, there are conveniently 10 units on each edge of the square faces, where the gaps use 4 of the units and the 3 spots
use two each. This means the gaps are of size 1.7/10 = 0.17 and the spots (1.7×2)/10 = 0.34.
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Image:Medidas.jpg

It is assumed in the following that you are in Front view (NUM1), have selected the top edge and that you are adding cuts 
starting at the left.

To make these segments, use the face loop cut tool. Press KKEY→Loop Cut (or CTRL-R) and select one of the edges.

As soon as the mouse cursor approaches an edge a blue line will appear, it will be horizontal if the cursor is near a vertical 
edge, vertical if the cursor is near a horizontal edge.

Click and the line will go yellow and the free part of the edge between the nearest line to the left and the nearest line to the right
will go green and the distance will be shown as a number. Move the line (just moving the mouse) until the distance from the
nearest line to the left is approximately 0.17 — then press SHIFT and you will be able to move it in smaller increments to get 
it exactly into position and click LMB. It seems that, to avoid it jumping out of position as the mouse has moved because of 
clicking, that SHIFT should be kept pressed while clicking LMB.

[When you have got it nearly into position and press SHIFT and move the mouse, the line jumps away from where it was so 
the rough position you had before pressing SHIFT is lost. However, it works very nicely otherwise.]

After making the first cut you should have something like this:

Now continue to make cuts, the next one 0.34 away from the first one, the next after that 0.17 away again and so on. You 
should then have:

[You can certainly make all of the cut process faster, by making 9 cuts at once. After KKEY -> Loop Cut, wheel your mouse 
(or NUM+) to make 9 even cuts. Now get rid of the three unwanted cuts (edge loops). Make sure to deselect (AKEY). Go to 
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edges mode CTRL+TAB -> Edges. Select one of the edges of the unwanted edge loop. Select the whole loop CTRL+EKEY -> 
Edge Loop Select. Erase it with XKEY -> Edge Loop. Then repeat that for the other two. This way you don't have to calculate 
enything yourself. You don't need to deal wiht the "0.17" and "0.34" at all. Everything is even and proportional.]

Now if you turn the cube around (MMB) you will see that the cuts extend over the top face, the back face and the bottom face 
as well.

Now repeat all the above but with horizontal lines coming down from the top edge.

Rotating the cube around (MMB) you can see that the back face is now divided like the front face but the top, bottom, left and 
right faces have only horizontal divisions.

Now select Side view (NUM3) and add the vertical cuts as you did before with the front face.

You can check the size of the edges by selecting Face select Mode

and selecting a face. The lengths of the edges will be displayed.

6. Adding the spots: select Front view (NUM1); go into Face select Mode (if you are not there already) and select the five spot 
faces. (User comment: be sure to have enabled "Limit selection to visible")

Go to Editing context (F9), if you are not already there, and click on “Assign” in the “2 Mat 2” column to assign the “active
index” — the material SpotCol — to all the spot faces: press ZKEY to go into solid mode to see the result.
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Now press AKEY to unselect all the (newly coloured) faces and then select just one of them. Extrude the face by hitting 
EKEY and then ESC. Do not click after hitting EKEY. Collapse this face by using ALT-M to merge the 4 corners of the 
extruded face into the centre where it will tell you it has removed 3 vertices.

The sequence of keystrokes is: EKEY, ESC, ALT-M, ENTER, ENTER.

(Note from Natume : another way to create the inner vertex on the selected faces is to convert the quads to triangles -
CTRL-TKEY or SPACE -> Edit -> Faces -> Convert to Triangles - then to subsequently use the Knife (Midpoints) feature - 
KKEY - to cut them into two more pieces each, along their midpoints. This takes longer, but is perhaps more viable in other 
operations.)

[Actually the fastest and most viable way is probably to first convert each face into triangles, then simply select all of the edges
and subdivide them. (Space -> Edit -> Edges -> Subdivide) or simply WKEY, 1KEY)

You should get the following:

IMPORTANT NOTE: Some of the images belong to the previous tutorial. Their colors are wrong.

This face is to have 5 dots so do the same for the other four spot positions, you should then have:

Now go into Vertex select Mode and select the vertices in the centre of each spot instead.

Remember the spot radius was 0.17. We need to use this value to move the centre point of the spots inwards. Move all the 5 
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centre points inwards together by 0.17: press GKEY, YKEY, -0.17 and hitting ENTER. You should then see this:

TAB out of Edit Mode. If you haven't done so already, hit “Set Smooth” in the Editing panel and turn on subdivision surfaces:
in the Modifier panel, click on “Add Modifier” and select “Subsurf” from the dropdown menu. You will then see

the default setting for “Levels” is 1 and for “Render Levels” is 2.

On a die, the edges of the spots are usually sharp so we'll use subsurface creasing to do that.

Go back into Edit mode and with Edge select Mode on, select all the perimeters of the spots like so (it may help to turn off 
subsurf for the moment):

Press SHIFT-EKEY to enable creasing and type in "1" (1KEY — Note: not the numpad key) and hit ENTER giving

Press AKEY to unselect the vertices.
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Now repeat the steps from the beginning of “6: Adding the spots” but changing “five spots” to whatever number is appropriate
— a die is numbered so that opposite sides add up to 7.

If you started with Front view (NUM1) it will now have 5 spots, the back (use MMB, or, more conveniently, NUM4 or 
NUM6, to turn the cube around) will have 2 and the extrusion will be -0.17.

If you then go to Side view (NUM3) — the righthand side — and put 6 spots there (extrusion -0.17 along the X axis, XKEY), 
the lefthand side will have 1 (extrusion 0.17).

If you put 4 on the top (Top view NUM7, extrusion -0.17 along the Z axis, ZKEY) then the bottom (you can use either NUM8
or NUM2 to rotate the cube) will have 3 (extrusion 0.17).

Once you finish, if you change “Levels” in the Subsurf modifier panel to 2, you will get something like this:

7. Preparing a test render: You can make a test render now to see that the spots look the right size and the bevel is right. So, 
turn the subdivision level for the rendering up to 3. To help position the camera so that you centre the die, you can make the 
camera look at the die by adding a track-to constraint to it. I prefer to track an empty though, because it is more flexible.

Make an empty by going into Top view (NUM7), moving the cursor away from the cube and selecting “Add” from the main
menu at the top of the 3D window and then select “Empty” [it's not in the SPACE→Add menu in 2.41 [yes it is, just not in the
Edit Mode, switch to Object Mode]].

It's always best to go into one of the set orthographic views so as to align new objects to the axes. If you add something
misaligned, just go to the object menu then clear/apply → clear rotation (or ALT-RKEY).

The empty was created outside the cube, leave it there until we get the constraint set up.

To add a track-to constraint: in Object mode, select the camera first then SHIFT-RMB the empty and press CTRL-TKEY and
choose “TrackTo Constraint” from the list. Move the empty back inside the die. You can edit constraints in the object tab (F7).
Add a couple of lamps (both intensity 1) to get the scene like this or feel free to experiment with a more advanced lighting
setup:

8. A test render: to render, set the size of the image you want. 800×600 is a decent size, so put these settings in the format panel
in the Scene tab (F10). In the render panel, make sure 100% is selected. If it's 50%, the render will come out as 400×300. For
preview renders, don't turn on OSA, which is anti-aliasing, because it slows your renders down significantly. Try to only use it 
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for a final render.

Another way to position the camera is by selecting it and then looking through it as you move it. Look through the camera by 
pressing NUM0. Use the GKEY to pan across and rotate around the local axes of the camera by pressing say RKEY, XKEY, 
XKEY to rotate in x axis. To zoom in and out press GKEY, ZKEY, ZKEY and then move your mouse forwards or 
backwards. The mouse wheel zoom moves your view towards and away from the camera, without actually moving the position 
of the camera.

Another important point is to set the image format. This is done in the format panel. The listbox has a number of image types. I 
find that PNG is generally the best because it is lossless and offers the highest compression among the lossless formats. It also 
supports an alpha channel for transparency. When rendering an animation, it is better to render as an image sequence than as a 
movie because it is easier to edit these and repair broken Frames. Quicktime supports loading of image sequences and you can 
save as a movie using a wide range of compression formats.

To save the render, go to the File Menu→Save Image and type in the full name of the image including the extension e.g.
die.png [extension seems optional in 2.41].

The output should now be looking something like this:

Image:DieAnotherWay16.png

Next Page: Model a Silver Goblet
Previous Page: Die Another Way

Model a Silver Goblet

Next Page: Simple Vehicle Part I
Previous Page: Die Easy

Basic Shape

On first pass, the goblet looks like it is composed of a cylinder(s). While it is possible to model the goblet with a cylinder mesh,
we can just use a cube. What is the benefit of using a cube? It is faster to make and there are less vertices to track.

Starting with the default cube in NUM 7 view and Edit Mode, extrude the top face three times. Scale each extrusion vertices to 
create the first knob. This example scaled E1 and E3 to 0.300 and E2 to 0.700.

 

Continue extruding up. This design will take 12 total extrusions - 3 to make the first knob + 1 for the stem + 4 to make two 
upper knobs + 4 for the cup.

After moving and scaling the first 10 extrusions, select the top 8 vertices (shown below). Scale these in along X and Y to 0.900.
This will make them only slightly smaller than what will be the outside of the cup. Pull E11 down so that it is level with E10. 
This makes the rim. Finally, pull E12 down inside of the cube to form a container.
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Smoothing and Defining

Time to take the mesh and turn it into a proper goblet. Add a subsurf level 2 to the mesh. Change to Object Mode (TAB) and 
select the Set Smooth button under Links and Materials. The cube-looking mesh will now look like an object that was created 
from a cylinder.

We want some of the edges back so return to Edit Mode. Select edges to make more defined and crease them (SHIFT EKEY) 
to +1.000. I've turned on Draw Creases under Mesh Tools 1 to illustrate which edges have been creased (highlighted yellow) in 
this example.

 

That concludes the creation of the goblet. Save the scene for use in the lighting tutorial. To jump to the relevant lighting 
section, go to Blender 3D: Noob to Pro/Light a Silver Goblet

Next Page: Simple Vehicle Part I
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Previous Page: Die Easy

Simple Vehicle

Next Page: Simple Vehicle: Wheel
Previous Page: Model a Silver Goblet

Overview

The idea of this tutorial is to learn to face a complex project. A vehicle is a nice object to use to test yourself and find new 
problems.

First, we must understand that a project does not reproduce the real world; a project shows an idea or thought and will result in 
a final image or video. Whatever does not appear in the final result is unnecessary to include in the model.

What vehicle should we make? Let's go with the classic jeep. This will allow for a lot of doodads.

Let's decide what objects of the jeep model will need to be made - body, wheels, seats, and a rocket launcher for good measure. 
Objects we can ignore include the engine, which remains hidden under the hood. There are many additional objects you can 
make such as seats and steering wheel to customize your jeep.

Next Page: Simple Vehicle: Wheel
Previous Page: Model a Silver Goblet

Simple Vehicle: Wheel

Next Page: Simple Vehicle: Seat
Previous Page: Simple Vehicle

Techniques

You should already know how to:

Make a mesh
Navigate the viewport
Extrusion
Create, edit materials

This section will recap and introduce:

Forming faces
Subsurfing
Merging vertices
Object naming

Pre-constructed

For our premise, envision jeep tires. They're not too sleek but rather rugged for all kinds of terrain. We need a tire that can 
handle any obstacle in its way.
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If you want to skip making a tire from scratch, take an existing model you can find the tires
at :"http://www.e2-productions.com/bmr" released under the Blender Artistic License.

Choose one, reduce the hole and enlarge the bump.

Model from Scratch

Start with the viewport in XZ coordinates (NUM1). Add a tube (Space > Add > Mesh > Tube) specify the number of vertices 
to use. This example we'll use 32. Now scale the tube to a size of 4. With all the vertices selected, extrude the individual faces 
into the circle (Make sure to select INDIVIDUAL FACES not Region). Hold SHIFT CTRL while extruding the faces until the
sides come in -1.300 units, or just type in -1.3 and hit enter (in older versions of blender hit NKEY first) (A Noob:- In v2.43, 
we have to set ratio, so it should be -0.13)

Rotate around the model and you'll notice the outside of the tire doesn't yet exist. Let's remedy this. Go back to NUM1 view.

 

Now its time to make the tire look like a rugged tire. Apply a subsurf of level 1 or 2 to the mesh. The tire will now look like a 
bead necklace. A little creative use of creases will restore our tire.

Turn on the Limit Selection to Visible. Enter select edges mode and bring up the circle selection tool (AKEY to unselect all, 
then BKEY twice). Use the scroll wheel to change the circle selection size to be in the center of the tire, between the inside and 
outside edges. This will select all of the inside edges, as well as the triangles on the side of the tire, as in the picture below. 

 Invert selection (Space > Select > Inverse)
 Press FKEY to create the missing faces
 Select auto
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Crease these edges to 1.000 (SHIFT EKEY).

 

The tire is almost done. Let's add a simple hubcap to it. In NUM1 view, add a tube mesh (32 vertices) and scale it up a bit to 
make it easier to work with.

Set the view to NUM3 and pull the tube out of the tire along the Y-axis. Reduce the length of the hubcap to about 0.5 unit. 
Select the left half of the hubcap vertices and return to the NUM1 view.
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Scale these vertices and pull them inward. Keep the vertices selected.

Use extrusion (Only Edges) and then press ESC. This will duplicate the vertices and place them at zero, which in this case 
happen not to be on top of each other.

We'll merge these vertices together to create a flat surface. ALT MKEY will bring up the merge window. Merge the vertices at
center. Blender will reduce the 32 vertices to 1. Keep the 1 remaining vertice selected, enter NUM3 view, and pull it along Y 
into the hubcap.

 

The final mesh editing is to select all of the hubcap vertices (easiest in the side view), scale up to slightly larger than the hole of 
the tire, and move back into the tire along Y.

The last thing to do is to rename the wheel so we can find it easier later. Enter Object mode and select the wheel only. In the 
Link and Materials subwindow in Editing (F9) you'll see the Active Object name box. It should read OB:Tube in the grey box. 
This name was created because we started with a tube mesh. Click on the button and rename the object to something like 
'wheel'. Save your file where you'll find it later and continue to the next step.

Resulting jeep tire:

Optional

Change the materials to make it look like a tire. One object can have multiple colors/textures. Refer to the materials section for 
an explanation on how to do that.
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Next Page: Simple Vehicle: Seat
Previous Page: Simple Vehicle

Simple Vehicle: Seat

Next Page: Simple Vehicle: Rocket Launcher
Previous Page: Simple Vehicle: Wheel

Techniques

You should already know how to:

Make a mesh
Navigate the viewport
Extrusion
Subsurf
Crease edges

This section will recap and introduce:

Loop subdivide
Small, consistant vertex movement

Basic Structure

The design will be a utilitarian bucket-type seat. Start in NUM 1 view of the default cube and rename it. Extrude the cube 
multiple times to make your basic shape. In this example, a 3x3x1 block composes the body with one cube coming out the top 
for the headrest. The seat is the bottom cube's front faces extruded out.

To add a little texture to the mesh, we'll add some cushion seams. Use Loop Subdivide (CTRL R) and you'll see the pink 
selection loop. You can use the NUM+ key to increase the number of loops made at the same time. Press NUM+ 3 times to 
form 4 loops and LMB the center column of blocks. You may also find it easier to add them one at a time in the correct place, 
than inserting them and then moving them.

 

Move two of the resulting loop group vertices to each side, a small distance from the end blocks. The goal will be to have one 
vertex go into the cushion and then one come back out to create an indent.
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Since this is a 3D object, the back seams will move along the Y axis (green) and the seat seam will move along the Z axis 
(blue). In overhead view (NUM 7), select the back seam vertices and the front seat seam vertices with a group select command, 
making sure the Select Only Visible button is off. To move these back just a little, grab them (GKEY), move only along the Y 
axis (YKEY), and type in a small number using the NUMPAD. For example, type in .05 ENTER.

The next step is to add the horizontal seams. Switch to NUM 3 view and move the seam vertices down using the same method. 
In this case, you'll notice that a positive movement will be the wrong direction. To move them down, make the value negative. 
The correct key sequence is .05 NUM- ENTER. Remember that the minus sign is pressed after the number is entered.

 

Add a subsurf modifier to the object. Select the edges between the back and seat and crease them. Crease any edges you feel 
like to create your perfect jeep seat.

Next, resize the seat height and widths.
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As a final touch, the seat can be made slightly more concave to look like it would hold a person better.

This final seat renders to:
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Next Page: Simple Vehicle: Rocket Launcher
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Simple Vehicle: Rocket Launcher

Next Page: Simple Vehicle: Body
Previous Page: Simple Vehicle: Seat

Techniques

You should already know how to:

Previous Simple Vehicle techniques

This section will recap and introduce:

UVspheres
Changing object's center

Overview

Two assumptions are going to be made here. One is that the rocket will not be launched in the future (use separate objects if 
you want to do that). The other is this is going to be a simple, simple design.

If you want to add options to your gun (think sight, trigger), go for it!
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One Tube, a Rocket & a Launcher

Start a new file and delete the default cube. In NUM 1 view, add a cylinder mesh with 24 vertices. We'll use 24 because the 
default 36 is overkill and will only increase rendering time. Rename and elongate the cylinder along the Y axis. This will be the
length of the launcher. We need to add the rocket and the back opening to this.

Extrude the ends (region) - 7 times on one end and 2 on the other. The 7 extrusions will get folded to make the tube and the 
rocket.

We'll start with the easy part. On the end with only 2 extrusions, scale the two end vertices circles to about 0.7 by using the 
CTRL key. Next, move the first extruded vertices back flush with the original ones. Then pull the second extruded vertices 
inside of the cylinder. What will happen is a tube with thickness will be created on this end.

 

Now that we know what the tube looks like on one end, let's start the other. Scale the first and second extrusions to 0.7 and 
make the tube as you did before. Time to fold out a rocket head.

Take extrusions three and four and scale them to a value less than 0.7 (0.5 for example). We are making a cylinder that will fit 
inside our tube and be coming out.
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Extrusions five and six will be the flat head of the rocket. Extrusion seven will bring the tip back to a point so just scale it down 
to 0.2. Move the vertices along Y to create the shape of rocket you desire.

The Mount

Having a launcher is nice, but we'll need to affix it to the jeep somehow. Let's add a mount to the tube. Think easy. Add a 
cylinder, scale, and move it to the bottom of the tube.

The easiest way to have a wide range of motion for the launcher is to use a ball joint. We can simulate one by just adding a 
UVsphere. The default 32 segments and 12 rings will be fine. This creates a smooth sphere. You can think of the number of 
segments as being the wedges visible when the sphere is viewed as you added it. The number of rings then could be described 
as the depth of the sphere from that same view.

Resize and place the sphere at the new cylinder arm.

 

This next step will be important for continuing the tutorial. Get the 3D cursor to as close to the center of the sphere as possible. 
While the sphere is still selected after creation, you can press SHIFT + SKEY and snap cursor to selection, putting it in the 
exact center of the UV Sphere. Switch to Object Mode. Under either the Object menu or SPACE go to Transform > Center 
Cursor. This should move the large pink dot where the cursor is located. This will give it a new center of gravity around the ball
joint, making it easy to manipulate later.

Apply materials or additional items to the object and save for later use.

Do not forget to name the rocket for later use.

Next Page: Simple Vehicle: Body
Previous Page: Simple Vehicle: Seat

Simple Vehicle: Body
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Next Page: Simple Vehicle: Some Assembly Required
Previous Page: Simple Vehicle: Rocket Launcher

Techniques

You should already know how to:

Make a mesh
Navigate the viewport
Extrusion
Form faces
Name objects

This section will recap and introduce:

Deleting and creating edges
Subdividing
Merging vertices
Loop subdivide
Adding unconnected vertices in one object

Planning

Think about what you want your jeep body to entail. As always, consider where the major sections will need to be made so that 
you don't have to backtrack later to accommodate your idea. Feel free to make your own body design; here is one I made up.

The Basics

Start a new file. Take the default block and extrude it into your sections along the X axis (NUM 1 view). In this design, the 
sections are being designed to include the back, flatbed, doors, dashboard, window, and hood, left to right. The window is 
extruded straight up (older jeeps' windshields aren't slanted), and I decided to add a lower back to later hold the bumper/lights if
you wanted to add them.

Widen the jeep body. Use the proper views to make each step easy. The picture examples are not necessarily meant to provide 
the correct view you should have when editing your mesh. They are meant to show how the mesh should be turning out.

 

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P


Blender 3D: Noob to Pro - Beginner Tutorials/Print version - Wikib... http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P...

111 of 263 5.5.2007 21:39

Delete the proper edge along the top of the mesh where you want the cab and flatbed to be (XKEY). This will also remove the 
faces on the top. In vertex select mode, select two vertices (SHIFT RMB is the easiest here) and create an edge (FKEY) to 
make edges on the inside of the flatbed. The next step is to create faces using the new edges. In this example, 5 faces were 
made.

Adding the door: our jeep design will have somewhat of a cheat - no actual door. Before crying foul, many jeeps didn't have 
doors to facilitate quick entry and exit. To cut out one door, select the four vertical edges where the door will go. Use the 
subdivide command (WKEY) to cut the edges in half. You'll notice that the subdividing will also affect the adjoining faces. Do 
the same thing you did when the flatbed was cut out - removing/adding edges and creating new faces.

 

  

This is not a necessary step, but if you want to clean up the look of the model, we'll get started. In face select mode, select the 
faces that are going to be combined. Press FKEY and a little window will appear titled 'FGon'. Go ahead and make it to 
effectively merge the faces. As you may have guessed, if an FGon face is created and you want to later undo it, select the clear 
option in the FGon popup.

Go ahead and resize the widths of the bed and windshield. Always move as many vertices or edges at the same time to not only 
work faster but to make sure they are moved equally. The use of SHIFT while moving vertices is very helpful in fine 
movements.

If you want an object to come to a point such as a wedge from a cube, merge vertices. In this example, the lower back area will 
be modified. Select two vertices to join together and press ALT MKEY. Select the option for your merging. 'At First' or 'At 
Last' will probably be the option that will work here. Play around to see what each merge option does. After the merging, 
Blender will tell you how many vertices were removed.
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Extrude the bed surface upward. This is only useful in hiding the tires that we'll add later in the tutorial. Alternatively, you 
could make two boxes to hide them.

A Touch of Detail

Let's add some detail to the model - how about the hood? First thing to do is add some edges to the front of the jeep. Press 
CTRL RKEY to enter Loop Subdivide. A pink loop will appear around the mesh. Put the cursor over the area to get the 
example picture to appear. When the loop is in the right place, LMB click. The place to put the actual cut can now be selected. 
Do this twice - once for each side. Move and align the resulting edges to form an angle to the front and bring the window 
vertices in.
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Extrude the hood surface up a small amount. We don't want it too high, just high enough to catch the light.

Zoom in and select the top-front hood edge created from the extrusion. Drag it out along the X axis. Select the now diagonal 
face of the hood extrusion. Extrude from it. The result will come out of the surface at a diagonal angle. Take the resulting 
vertices and move them close to the front of the jeep. Readers note: I have no idea what the heck this paragraph is talking 
about, and the pictures don't help, someone really needs to rewrite this that actually understands what is going on. I advise 
skipping the hood part because it is hard to understand and doesn't look like it changes much.

 

The above paragraph briefly explains extruding the Hood of the jeep including a lip that comes over the front. Below are step 
by step pictures on how I accomplished this;

Step 1: In face select mode (CTRL+TAB-faces), select the top of the hood and press EKEY to extrude it. Only extrude it a 
small amount.

Step 2: Staying in Face select mode, here is the tricky part. Select the small face on the fron of the hood you just extruded. 
Then, hit EKEY then ESC. This creates a duplicated face on top of the one you selected. Do not click or move the mouse 
between these two keystrokes.
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Step 3: Now deselect the selected face by hitting AKEY. Then enter Edge select mode (CTRL+TAB-edges) and select the top 
edge of the face you just deselected.

Step 4: Hit NUM 1 to go to the side view. Now using the red X arrow pull the edge out a little further than you pulled up the 
hood itself then hit LMB.

Step 5: Now rotate just enoug so you can see under the wedge you just made. Go back into Face select mode 
(CTRL+TAB-faces) and select the face on the underside of it.

Step 6: Go back into side view with NUM 1. Now hit EKEY to extrude the face a little with the mouse. When it's a good size 
hit LMB.
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Step 7: Now make sure the "Select only visible" button is turned off and go into Vertex select mode (CTRL+TAB-verticies). 
Play around with the verticies pulling them a little closer to the front of the jeep. It's best to selct using the box select (BKEY) 
or the Lasso (CTRL+LMB).

The end result should be an extruded hood with a lip.

Alexwill84 08:23, 27 April 2007 (UTC)

In the topdown view (NUM 7), add a plane. Extrude an edge twice to result in three connected planes.

Pull the sides down to form a trapezoid shape and reduce the width. Once it is in the desired shape, select the three faces and 
duplicate it. Press SHIFT DKEY and all selected vertices, edges, and/or faces will be duplicated. The copy will automatically 
be grabbed for moving.
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Move the duplicate to the jeep body and repeat the duplication two more times for a total of four fenders.

We'll move on to making a tripod support for the rocket launcher. Add a cylinder mesh with 12 vertices then scale and size it so
that it looks like a tube. Once you have it to a size you like, duplicate it twice for a total of 3 cylinders. Rotate two of the 
cylinders in the NUM 1 view by LMB clicking on the white circle that appears when the cylinder is selected in rotate mode. 
The picture on the left is an example of the end result.

Change to overhead view (NUM 7) and put together the three cylinders so the tops come close together. Now all three can be 
selected and moved or rotated accordingly.

 

Move the tripod onto the jeep flat bed. The final steps are to select your materials and rename the object (described in the wheel
section). This will complete our simple jeep model.
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Optional Activities

Feel free to add anything you see fit such as bumpers, guard rails, doors, steering wheel, lights, etc. You can either have them 
on the same object or separate objects (useful if you want to move them around). Note: If you subsurf the result from this 
tutorial, you will get a bad looking result, please try not to subsurf the jeep.

Next Page: Simple Vehicle: Some Assembly Required
Previous Page: Simple Vehicle: Rocket Launcher

Simple Vehicle: Some Assembly Required

Next Page: Model a Low Poly Head
Previous Page: Simple Vehicle: Body

Techniques

You should know how to:

Do everything discussed in previous tutorials

This section will recap and introduce:

Append a file
Duplicate an object

Overview

The objects for the simple vehicle have been made if you have followed all the previous Simple Vehicle tutorials. Putting it all 
together will come very easy now.

Appending the File
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If you have the jeep body file open, keep it open. Otherwise, open the file for the jeep body. In Object Mode, go up to File > 
Append (about 3/4 of the way down the menu). The find file window will appear. Go to the location where the jeep seat was 
saved. When the .blend file is clicked, you'll go into it as if it is a directory.

Here we have the categories of Camera, Lamp, Material, Mesh, Object, Scene, Text, and World. We are interested in the seat 
object, so click on Object. Now there are three items: Camera, Lamp, and Seat. That is, it will say Seat if you named your 
object Seat. This is why it is useful to rename your objects, materials, etc. If you forgot to rename the object, it will be called 
Cube (default for our starting mesh).

 

What should happen after selecting Seat and the button 'Load Library' is the seat will pop into our file where the 3D cursor was.
It will definately need to be scaled, rotated, and/or moved to the right position. In my example, I rotated the seat about the Z 
axis -90 degrees by pressing RKEY ZKEY NUM9 NUM0 NUM-.

After placing the seat in the jeep body, let's make another so we have a seat for the driver and passenger. Still in Object Mode 
with the seat selected, duplicate it (SHIFT DKEY) and slide it over. After duplicating it, it will automatically go into grab 
mode. If you RMB or ESC, it will still be duplicated - just sitting on top of the original.

 

Rinse and Repeat

Append the file again to place the wheel object and rocket launcher in the file. Scale, rotate, move, and duplicate each object 
accordingly. Depending on the position of your camera, you may or may not have to make all four tires. Remember that the 
only important parts to draw are those that will be seen!

Set the ball over the tripod. The fun part is rotating the rocket launcher since the center of it has been moved to the ball joint.
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The last thing is to apply materials to your objects if you haven't already. I'll point you to the materials section for information 
on that. I would suggest that the window be assigned a transparent material by making the Render Pipeline wire for example. 
User request:explain in more depth how to make the windshield transparent

The final result of a simple jeep:
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Model a Low Poly Head

Next Page: Edit Mode HotKeys Review
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How to Model A Low-Poly head in Blender

This tutorial is designed to teach users to make a low-poly animesque head in Blender.

All of the pictures were made by me as Blender3D screen shots. They are all free for any form of use. NOTE: Pictures go from 
left to right

Overview
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What you need to know:

Basic Blender controls

Making the Model

Go into the front view (keypad 1) and add a plane.

Select the bottom two vertices (Shift + Right-Click) and 
press W to bring up the vertex menu. "Select Merge", then 
"At Center".

Now you have a pointed chin.

Select the top two vertices (use the BKEY) and re-arrange 
them so they make more of a chin shape by pressing the 
GKEY to move and ZKEY to constrain the movement to 
the Z-Axis.

Add a plane

Merge the verticies

A pointed chin!

A pointed chin!Select the top 2 verticies
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Now extrude (EKEY) along the Z-Axis (ZKEY) so that you have another area.

Scale it (SKEY)so that it's not so cubic.

Now extrude along the Z-Axis again (EKEY then ZKEY) and scale (SKEY) it down a bit.

Extrude along the Z-Axis

Scale it

Extrude along the Z-Axis again
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One last time... (E) (Z) (S)

Select the middle vertices (BKEY) and press (WKEY) to bring up the edit menu again. 
Subdivide it once.

Now select the vertices above and below, and subdivide them.

Now subdivide these vertices twice. This will help to make 
the nose.

There!

Extrude along the Z-Axis again

Select the middle verticies

Select the verticies

Subdivide!

There!
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Select and subdivide here, so you can make the eyes.

And rearange the vertices so they make eye shapes.

Now select the middle vertice here (right mouse button).

Extrude it along the Y-Axis (EKEY) (YKEY) and move 
your mouse around to change how far it moves.

Now we make the nose. Select these three vertices (Shift + 
Right mouse button) and press (F) to make a face.

Subdivide some more

Make some eyes

Select these

Extrude

Let's make a nose!
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Now do the same to the other side, and you will have the nose's base.

Select these vertices (Shift + Rightclick) and make a face 
(F). Do this to the other side.

Now you have a nose.

Rotate the camera so you are seeing the back. Press 
CTL+NUM1. Also, change to face select mode.

Select the faces behind the nose. (Shift + Rightclick) and 
press (X). This will bring up the delete menu. Selected 
"Faces" to get rid of these.

Now select these vertices (above and below), and subdivide
them.

Do the same to the other side

Make a face

You have a nose!

Rotate the camera

Get rid of these

Select these
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And select all the edges on the outside.

Move the vertices back a bit to give the face more 
smoothness (G) (Y)and rearrange the chin.

Now select the vertices at the back of the head, using (B).

Extrude these along the y axis (E) (Y)

Ta da!

Now select the back vertices and press (F) to make a face.

Select edges on the outside

Give the face more smoothness

Select the verticies at the back 
of the head

Extrude along Y-Aixis

Ta da!

Make a face
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and so on....

and so on....

now select and subdivide these once (W)

and these points too.

Now select the middle and move it back (G) (Y).

Finishing it up

And here it is with sub-surfacing. You have finished. Hit (F12) to see the final render.

Next Page: Edit Mode HotKeys Review
Previous Page: Die Easy

Edit Mode HotKeys Review

Next Page: Object Mode HotKeys Review
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and so on...

and so on...

Subdivide these

Subdivide these as well

Move the middle back

With subsurfing
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3D View by Mode: All HotKeys | Object Mode | Edit Mode | Pose Mode
Vertex Paint Mode | Texture Paint Mode | UV Face Select Mode

Other Windows: Scripts Window | File Browser | Image Browser | Buttons Window
Outliner | User Preferences | Text Editor | Audio Window

Timeline | Video Sequence Editor | UV Image Editor | NLA Editor
Action Editor | IPO Curve Editor

by Key: . , A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
Relevant to Blender 2.37a

Here's a review of some of the hotkeys you've learned and some you haven't yet. This list is for use in the 3D Viewport in Edit 
Mode.

Edit Mode HotKeys
The Period Key

.KEY (on the number pad) - centers the view around the current selection or active object.

.KEY (on the alphanumeric pad) - changes the pivot point to the 3D cursor. The pivot point is the point where all 
things meet when scaled to 0, and the point of 0 translation during a rotation transformation. See the menu on the 3D 
view header, located immediately to the right of the Viewport Shading menu.

The Comma Key

,KEY - changes the pivot point to the bounding box center.

A

AKEY - Toggles between selecting all or selecting none.
ALT+AKEY - changes the current Blender window to Animation Playback mode. The cursor changes to a counter.
ALT+SHIFT+AKEY - the current window, plus all 3DWindows go into Animation Playback mode.
SHIFT+AKEY - brings up the toolbox.

B

BKEY - Activates box-select tool.
BKEY+BKEY - Circle Select. If you press BKEY a second time after starting Border Select, Circle Select is invoked. 
Use NUM+ or NUM- or MW to adjust the circle size. Leave Circle Select with RMB or ESC.
ALT+BKEY - Select portion of viewing area to only be visible.

C

CKEY - Centers the 3D View where the 3D cursor currently is.

D

DKEY - Brings up a Draw Type menu.

E

EKEY - Extrude selection

F

FKEY - creates segment/edge/face. If two vertices are selected, create an edge connecting the two vertices. If three or 
four vertices are selected, or two edges are selected, create a face connecting the vertices or edges. If two co-planar faces 
are selected, join the faces to create an FGon, or dismantle a previously created FGon.
ALT+FKEY - Beauty Fill. The edges of all the selected triangular faces are switched in such a way that equally sized 
faces are formed. This operation is 2D; various layers of polygons must be filled in succession. The Beauty Fill can be 
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performed immediately after a Fill.
CTRL+FKEY - Flip faces, selected triangular faces are paired and common edge of each pair swapped.
SHIFT+FKEY - Fill selected. All selected vertices that are bound by edges and form a closed polygon are filled with 
triangular faces. Holes are automatically taken into account. This operation is 2D; various layers of polygons must be 
filled in succession.

G

GKEY - "Grabs" the current selection and allows you to move it around with the mouse. Use LMB, ENTER, or 
SPACE to drop it in place. Use RMB or ESC to cancel the move.
GKEY XKEY - Grabs the selection and locks it's Z and Y position. In this mode it will only move along the global X 
axis.
GKEY XKEY XKEY - Grabs the selection and locks it's Z and Y position on the local axis. In this mode the selection 
will only move along the local X axis.
GKEY YKEY - Grabs the selection and locks it's Z and X position. In this mode it will only move along the global Y 
axis.
GKEY YKEY YKEY - Grabs the selection and locks it's Z and X position on the local axis. In this mode the selection 
will only move along the local Y axis.
GKEY ZKEY - Grabs the selection and locks it's X and Y position. In this mode it will only move along the global Z 
axis.
GKEY ZKEY ZKEY - Grabs the selection and locks it's X and Y position on the local axis. In this mode the selection 
will only move along the local Z axis.

H

HKEY - Hides the currently selected vertices, edges and faces. They will be hidden only while in Edit Mode.
ALT-HKEY - Unhides vertices, edges, and faces that were previously hidden. Vertices, edges, and faces that are 
unhidden will be added to the current selection.

I

IKEY - inserts a "key". Keys are used for animation.

J

ALT+JKEY - converts triangular faces to quads.

K

SHIFT+KKEY - knife tool. this doesn't seem to work with nurbs.

L

M

MKEY - Brings up Mirror Axis menu.
ALT+MKEY - Merge selected points.

N

NKEY - brings up a Transform Properties mini window.

O

OKEY - toggles proportional edit mode

P

Enter the Blender Game Engine

Q
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QKEY - prompts if you would like to quit the Blender.

R

RKEY - allows rotation of the selection. Move the mouse after pressing RKEY to rotate it. Press LMB, SPACE, or 
ENTER to confirm the rotation. Press ESC or RMB to cancel the rotation.

S

SKEY - begins scaling (resizing) of the selection. Move the mouse to scale larger or smaller. Press LMB, ENTER, or 
SPACE to confirm the scaling. Press RMB or ESC to cancel the scaling.

T

U

UKEY - undo last edit
SHIFT+UKEY - redo previously undone edit

V

VKEY - Rip - for example, select one edge of a cube, and press VKEY to separate and drag it away from the edges it's 
attached to.

W

WKEY - Boolean Tools menu [in 2.41: Specials menu]

X

XKEY - delete the selection.

Y

CTRL+YKEY - redo previously undone edit

Z

ZKEY - Toggles between drawing the scene in wireframe and solid mode.
CTRL+ZKEY - undo last edit
SHIFT+CTRL+ZKEY - redo previously undone edit

TAB

TAB - toggles in and out of Edit Mode of the selected, active object.

F1-F10

Nothing Really

F11

F11 - Shows/hides the window with the last render.

F12

F12 - begins a single frame render based on the Scene settings in the Buttons Window.

LMB

LMB - places 3D cursor where you click
CTRL+LMB - places a new vertex at the place clicked. The new vertex will be joined to any previously selected vertices
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by an edge.

RMB

RMB - selects vertex, edge or face, depending on select mode.
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Object Mode HotKeys Review
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3D View by Mode: All HotKeys | Object Mode | Edit Mode | Pose Mode
Vertex Paint Mode | Texture Paint Mode | UV Face Select Mode

Other Windows: Scripts Window | File Browser | Image Browser | Buttons Window
Outliner | User Preferences | Text Editor | Audio Window

Timeline | Video Sequence Editor | UV Image Editor | NLA Editor
Action Editor | IPO Curve Editor

by Key: . , A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
Relevant to Blender 2.37a

Here's some more hotkeys to review. These are for use in Object Mode. Notice that many of the hotkeys are the same for both 
Object and Edit Mode.

Object Mode HotKeys
The Period Key

.KEY (on the number pad) - centers the view around the current selection or active object.

.KEY (on the alphanumeric pad) - changes the pivot point to the 3D cursor. The pivot point is the point where all 
things meet when scaled to 0, and the point of 0 translation during a rotation transformation. See the menu on the 3D 
view header, located immediately to the right of the Viewport Shading menu.

The Comma Key

,KEY - changes the pivot point to the bounding box center.

A

AKEY - Toggles between selecting all or selecting none.
ALT+AKEY - changes the current Blender window to Animation Playback mode. The cursor changes to a counter.
ALT+SHIFT+AKEY - the current window, plus all 3DWindows go into Animation Playback mode.
SHIFT+AKEY - brings up the toolbox.
CTRL+AKEY - prompts to "Apply Changes." Size and rotation changes to the model object become permanent.
CTRL+SHIFT+AKEY - prompts to convert dupliverted objects to real objects.

B

BKEY - Activates box-select tool.

C
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CKEY - Centers the 3D View where the 3D cursor currently is.

D

DKEY - Brings up a Draw Type menu.

E

ALT+EKEY - Start/stop EditMode. Alternative hotkey: TAB.

F

FKEY - In the 3D View, switches to UV Face Select Mode if selected object is a mesh. Pressing FKEY again will bring 
you back to Object Mode.
CTRL+FKEY - Sort Faces. The faces of the active Mesh Object are sorted, based on the current view in the 3DWindow.
The leftmost face first, the rightmost last. The sequence of faces is important for the Build Effect (AnimButtons).

G

GKEY - "Grabs" the current selection and allows you to move it around with the mouse. Use LMB, ENTER, or 
SPACE to drop it in place. Use RMB or ESC to cancel the move.
GKEY XKEY - Grabs the selection and locks it's Z and Y position. In this mode it will only move along the global X 
axis.
GKEY XKEY XKEY - Grabs the selection and locks it's Z and Y position on the local axis. In this mode the selection 
will only move along the local X axis.
GKEY YKEY - Grabs the selection and locks it's Z and X position. In this mode it will only move along the global Y 
axis.
GKEY YKEY YKEY - Grabs the selection and locks it's Z and X position on the local axis. In this mode the selection 
will only move along the local Y axis.
GKEY ZKEY - Grabs the selection and locks it's X and Y position. In this mode it will only move along the global Z 
axis.
GKEY ZKEY ZKEY - Grabs the selection and locks it's X and Y position on the local axis. In this mode the selection 
will only move along the local Z axis.

H I

IKEY - inserts a "key". Keys are used for animation.

J K L M

MKEY - move selection to a different layer.

N

NKEY - brings up a Transform Properties mini window.

O P

PKEY - starts the game engine.

Q

QKEY - prompts if you would like to quit the Blender.

R

RKEY - allows rotation of the selection. Move the mouse after pressing RKEY to rotate it. Press LMB, SPACE, or 
ENTER to confirm the rotation. Press ESC or RMB to cancel the rotation.

S
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SKEY - begins scaling (resizing) of the selection. Move the mouse to scale larger or smaller. Press LMB, ENTER, or 
SPACE to confirm the scaling. Press RMB or ESC to cancel the scaling.

T

TKEY - brings up a Texture Space menu. Allows translation and scaling the Texture.

U

UKEY - brings up Make Single User menu.
ALT+UKEY - opens undo history menu.

V

VKEY - enters Vertex Paint Mode. Pressing VKEY again will switch back to Object Mode.

W

WKEY - Brings up Boolean menu. Choose Intersect, Union or Difference.

X

XKEY - delete the selection.

Y Z

ZKEY - Toggles between drawing the scene in wireframe and solid mode.
CTRL+ZKEY - the single best function of blender: UNDO!!! You can undo almost anything, and the program notifies 
you when doing a no-undo operation. Note: If Blender claims there are no more steps to undo, hit tab to switch to object 
mode and try again.

TAB

TAB - toggles in and out of Edit Mode of the selected, active object.

F1-F11 F12

F12 - begins a single frame render based on the Scene settings in the Buttons Window.

Next Page: Curve and Path Modeling
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Curve and Path Modeling

Next Page: 2D Image (logo) to a 3D Model
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Frighteningly enough, we know what you're thinking. You're thinking that mesh modeling is cool and all, but it would be nice if
Blender had a better way to create complex smooth 3D objects, right? Ok, so you weren't thinking that, but now you're curious 
about this better way. Good. Move on to the next page to learn more.

Next Page: 2D Image (logo) to a 3D Model
Previous Page: Object Mode HotKeys Review

2D Image (logo) to a 3D Model
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Using Bezier Curve to Model a 3D logo from a 2D logo

{Construction on hold, feel free to complete}

The image to the left is used in this tutorial. However, the tutorial is easier to follow using 
letter/numbers, or simple shapes/curves. Basically we will be using the graphic as a template 
for a 3d logo, tracing it, then discarding the 2d image.

Set up

You need a 2D logo similar to mine (preferably in JPEG format as Blender understands jpegs
fairly well). If you haven't already done so, open blender and select one of the orthogonal 
view angles by pressing NUM7, NUM3, or NUM1.. At the bottom of the 3D viewport on 
the left, there are some menus, click View-->Background Image

A small window will appear containing just one button marked use background image; click this button. A few more buttons 
will appear. One of them says image: and has a small button with a picture of a folder on it; click this button. You are now 
presented with a file selection screen. Using the navigation techniques from the previous tutorials, find your 2D jpeg image on 
your computer, click the file in the list once then click the Select Image button at the top right of the screen.

Blender now displays this image in the background of the 3D view for you to trace its outline. The image is only displayed in 
orthogonal view. If perspective view is enabled, toggle to orthogonal view by pressing NUM5. The image will not be rendered 
as it is not part of your scene.

Once a background is selected you'll have a 
dialog like this one. (Note: This tutorial was 
originally generated from Blender v2.37. v2.43
has been added - older versions may differ.) 
The background dialog buttons are described 
below:

The  is a toggle button 
that turns display of the image on or off. 
Turning the button off will not clear the 
settings; it just hides the image. When you turn

the button on again, your previous settings are back. Try it - click the button a few times. In v2.43 the equivalent button is the 
 button.

Image selection is controlled on the row labeled . There are 2 buttons, a text box, and a final 
button. The first button  is used for browsing for an image. The 2nd button is for selecting an image from a history list. 
(This will be empty for the first time. Selecting it now will display the image you currently have selected.) The text box 

 allows typing in the file directly. The  button removes the current background image. Version 2.43 is the 
same with the addition of the  button that refreshes the image or movie, and the  button which shows the number of 
users of the image block.

The third row is called Texture and will not be used for this tutorial.

The fourth line, labeled blend controls the transparency of the background image with a slider. A setting of 0 is completely 

original 2d logo
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solid and 1 is completely transparent. You can adjust it by clicking left or right of the knob for gradual changes, clicking and 
dragging on the slider for rough settings or clicking directly on the blend text for numeric entry.

The use of the blend function will become obvious once we start tracing our logo. For now, play around with it, see how it 
changes the image, and put it back to the 0.500 default.

The fifth line, size, controls the size of the image. This size setting is independent of the zoom for the 3D view window. To see 
how the size works move the default cube off to the side so that you can see both the cube, the background dialog and the 
background image. Now watch both the cube and image as you change the size. Notice how the image changes size but the 
cube doesn't? Now press NUM+ and NUM- to change the view's zoom. Now both the cube and image change size.

The final row controls the X and Y offset for the image. These controls move the image up and down (Y) or left and right (X). 
These settings can be useful if you need to reposition the image from the default position. Like the size, these offset values are 
independent of the view. As you change the offset values the cube you added earlier won't move. Now scroll the view using by 
clicking and dragging the SHIFT MMB and notice how the cube and image move together?

Once you start tracing the image you won't be using the size or offset setting. Delete the cube (select it, press XKEY and select 
All from the Erase menu), and set the size so that the entire image is viewable. Then set both the X and Y offsets to 0. Finally 
minimize the Background Image dialog. You'll only need it to adjust the blend setting until you finish tracing.

Introducing the Bezier Curve

The Bezier Curve (http://en.wikipedia.org/wiki/Bezier_curve) allows drawing graceful, complex curves and only requires a few
control points. Specifically, it only requires 4 points for a curve. Two end points and two control points.

For the moment set the blend to 1 on the Background Image dialog. With the center of the 3D view still selected, press SPACE
-> Add -> Curve -> Bezier Curve. Alternatively you can use the Add menu at the top of the screen or press SHIFT -> AKEY
to jump directly to the add menu. You should now have something like this:

Unlike the traditional Bezier Curve each Bezier vertex has 3 points. I've labeled the 3 
points for the left vector: A, B and C.

Point A is an end point. The curve will always go through this point. Points B and C are 
control points. These points influence the path of the curve as it leaves Point A. Because 
the path stops at A, Point B has no real effect on the path. Instead B is currently locked 
with C. (If you move either B or C, the other will move.) We will fix Point B to move 
independently a little later.

The control points have 2 effects on the path exiting the 
end point: direction and distance (these are termed slope 
and magnitude in math circles) from Point A. The direction will provide the direction that 
the path will follow when it leaves A and the distance will determine how long the path 
follows that direction before it starts making its way to the next of the curve.

The Curve you added.

How the controls affect the 
path

Image:Beziersharpturn0001.gif
N.B. To easily make 
sharp turns; take B
point and move it 
really close to A.

Image:Beziersharpturn0002.gif
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The example to the left shows how the control points influence the path of the curve. In the top picture, 
we see three curves. The top curve is the default curve. In the next curve down, C has been moved to 
give a drastically different direction. Notice how the path leaving A moves away from the other end 
point. The third curve, the distance was changed dramatically. Watch the path move much higher than 
the other two curves.

In the bottom example, I've built a heart shape using just the points shown. Dragging the bottom end 
point down will make the shape closer to a leaf. You'll be able to do the same at the end of this tutorial. 
Go ahead move around the points for the curve and see how they all interact. Get a good feel working 
with the curve and when you're ready we'll move on to tracing.

Now that you know how to work with a bezier curve set blend back to 0.5 on the Background Image 
dialog so we can start tracing.

Rough Tracing

The first step in tracing is to click the Polygon convert button on the curve tools panel. You'll find this in 
button on the Buttons Window. You may need to select the Edit Panel. Press F9 if this panel isn't visible. If 
you don't already have a curve add one now. It will help to move the curve to the center of the yellow 
lightening bolt if you must add a new one.

Next, move the vertices of the curve to the points shown in the image to the 
left. This is called Rough Tracing because you don't need to exactly trace 
the image. You only need to approximate the image. Moving the vertices 
should be done using the instructions from the Creating a Simple Hat
tutorial.

Note: Selecting the best place to put a vertex is a bit of an art that you'll acquire as you work 
with curves. For now follow the arrows along the cutouts and place each of the vertices as 
shown.

This tracing uses all the vertices of the polygon. Other cases, you'll need add or remove extra
vertices. Adding and removing vertices as shown in Turning a Cube into a Puppy tutorial 
(Note: To add a vertex select the end point of your curve press CTRL and click LMB. At 
the place you clicked a new vertex will appear connected to your curve.).

After moving the last vertex, we finish the rough tracing by pressing the CKEY to close the polygon. You should see an image 
similar to the one on the right. (If you only have an outline switch your view port shading to solid by pressing the ZKEY for 
now.) Notice how the polygon doesn't cover all of the yellow of the bolt and how in some places the polygon fails to conform 
to the shape of the bolt. This is expected and should not be a cause for concern. We correct this in the next section.

Once you've finished several logos you should begin to get a feel for the required placement 
of vertices. Until then, here are some general guidelines to keep in mind:

A gradual curve may only require a single vertex.
Tight curves will likely require two closely placed vertices.
Curves may not require a vertex at all - you can define some curves using the control 
points of the adjacent vertices. We did this for both of the inside curves of the bolt 
above.
Corners require a single vertex placed where the curve bends. A square, for instance, 
requires four vertices - one at each corner - to be modeled properly.
The end point of a curve will always be on the curve. So should all of the vertices you 
place.

We are now ready to move onto the next step modeling the logo. Press ZKEY to return to 
wire frame mode and prepare for the next step.

Image:Beziersharpturn0003.gif
(with C selected) 
Press EKEY to 

extend the Bezier, 
and drag it out; you 

will find it goes 
where you pointed 
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for Blender 
3D version 
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Move Vertices Here

Final Rough Traced Polygon
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Polishing the Tracing

First, press the Bezier convert button to convert the polygon back to a curve. This will convert your polygon back into a curve. 
Nothing obvious will happen. If you look close, you should notice the number of points on the curve tripled. When you 
converted the curve back to a Bezier curve, Blender changed all of the polygon vertices to Bezier vertices. While the polygon 
vertex is a single point the Bezier vertex is made of an end point and 2 control points. So the extra points are the control points 
of the Bezier vertices. These control points are placed along the curve to produce the same shape as the converted polygon.

Our job is to move the control and end points so that the curve follows the edge of the bolt. The trick 
is to move the 2 control points between adjacent end points to bend the curve to the edge of bolt. First,
move the right control point of the top-left vertex. This should pull the curve from its end point to 
more closely match the line of our bolt. After placing this point, we move to the next control point 
following a clockwise direction around the bolt. Use the RMB to select the point you want to change 

and move it with GKEY to place it.

As you move the second point notice how the curve exiting the first end point is drawn away from the edge of the bolt being 
traced. We now have to adjust the first control point again to get that line back on track. This quickly turns into a balancing act 
adjusting each set of control points. The trick is to make smaller movements for each iteration of adjustments. Make a game of 
it and move the control points all along the bolt. Always move along the clockwise direction. This practice is not just for 
consistency, it keeps your place and ensures that moving a control point doesn't change a portion of the curve that you've 
already completed. In time you learn to move the first point only part of the way. Then moving the second brings the curve for 
the first into correct alignment.

If you have some trouble aligning the curve to the edge of the bolt, consider adding a new point. There are two (at least) ways 
to accomplish this:

Select 2 points that surround the problem spot where you want a new vertex and click the Subdivide button on the Curve 
Tools 1 tool panel.
If near an end point, Select it, press the CKEY to open the curve, then Control+LMB click to add a new point beyond 
the end of the selected final vertex. Press the CKEY to reclose the curve.

The new end point should be positioned and then you have to adjust the curve on both sides of the end 
point you move. Any time you move an end point be sure that the curve going into both adjacent 
(clockwise and counter-clockwise) end points still aligns with the edge of the bolt.

Once you've made the complete circuit around the bolt, you're ready for the 
final polishing of the edge of the curve. Press the TAB to switch to the object mode. This makes the 
polishing easier as Blender hides the points and lines for editing the curve. Now zoom in on the bolt's 
edge using the NUM+ or Control+LMB drag. Use Shift+MMB drag the screen so that you closely 
observe the entire edge of the bolt while zoomed in closely. Look for places where the curve pulls 

away from the edge. Also look for sharp bends at each of the end points that should be smooth. You can see several defects that
I found in my project after tracing the bolt. Switch back into edit mode to fix the curve and then go back into object mode to 
look for more defects.

Sharp end points are adjusted by decreasing the angle between end point and the control points. For 
Blender specific case that I know of, sharp points have a tendency to show to the side of the end point. 
This typically requires adding a new vertex between the two end points to smooth out the curve. Places 
where the curve pulls away from the edge can be resolved by moving the control point closer to the 
edge. In the above image the curve was found to have been pulled away from the edge. This was fixed 
by moving the control point a little to the left.

Here's the final polished curve for my project. It is shown in both edit mode and object mode so you 
can clearly see both the control and end points on the left and the curve to the right.

Note: If you have never worked with Bezier curves before, try it with a 2D paint program such as 
Inkscape or Paint Shop Pro. It might be quicker and easier to learn proper placement of control 

points in a program where drawing the curves is quick and simple.
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Helpful Tip: In blender 2.37 and later (not sure of earlier versions) pressing the HKEY toggles the control points between free 
and aligned (Edit Mode). Free Control Points are good for sharp angles, and aligned are good for smooth curves. This 
shortcut is in the Space>Edit>Control Points menu.

This concludes the tracing of the bolt. All that remains is making the curve 3 dimensional, applying a material and positioning 
the final object. Before doing that, we will trace the circle in the next part of the tutorial. Save this project if you want to take a 
break before continuing. You'll need it on the next turorial.

Adding a Third Dimension

First, give the object some depth. Leave editmode, go to the editbuttons screen, and under the "Curve and Surface" tab, set the 
following values:

Extrude: 0.2 (the height of the extrusion on either side)

Bevel Depth: 0.02 (the radius of the round bevel applied to the exruded edge)

BevResol: 4 (the number of subdivisions on the bevel curve)

(Note: In previous versions, Extrude and Bevel Depth were Ext1 and Ext2.)

Also, if you have a simple logo go ahead and increase the DefResolU value to 25. If you have an extremely complicated image 
this is totally overboard but looks nice when you are just tracing text or numbers.

Now you can use your knowledge from earlier in this book to change the material and/or add texture to your logo. Feel free to 
rotate, add lighting, or whatever floats your boat. Don't forget to press ZKEY to toggle wireframe mode.

-=< Tutorial under Construction, ready soon, thanks for input spiderworm >=- A similar tutorial is available here
(http://www.vrotvrot.com/xoom/tutorials/logoTut/logoTut.html) 

Continue tutorial using bezier curves

- This continues the tutorial, finishing up the sample logo from the image in the tutorial using bezier curves. These instructions 
make the assumption that you completed the first part in front view with NUM1. An alternative method for doing this using 
mesh circles has been presented below.

First, to make the lightning bolt distinct from the second part of the logo, it may help to apply a yellow material to it before 
getting started.

Adding the circle
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Switch to object mode by hitting TAB if you aren't already there. Press space -> Add -> 
Curve -> Bezier Circle to add a closed bezier curve with four points forming a circle. If you
are in solid draw type, switch to wireframe with ZKEY so you can see the underlying image 
better. Hit SKEY to scale the bezier circle to fit over the circle in the image. You will 
probably find that the bezier circle is not dead center on the sample logo so you will need to 
move it with GKEY to center it. You may need to scale it and move it several times to get it 
right. You will also find that the circle in the sample image is actually a slight oval, so scale 
and position the bezier circle so that it touches the circle in the image on the left and right 
sides. Normally, you could then scale the circle and constrain it on the z axis by hitting 
SKEY then ZKEY, but it turns out that the oval isn't regular anyway, so just select the point 
on the top and hit GKEY then ZKEY to move it down until it touches the top of the oval in 
the image. Then do the same for the bottom point and you should have a pretty good fit.

Bezier Circle

Match up left and right sides

Move top and bottom points
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Just to understand what's happening in the next steps, switch to solid view with ZKEY. As 
you can see, you now have a circle, but it's filled in the middle where you want to be able to 
see through it. To cut a hole out of the circle, hit space -> Add -> Bezier Circle while you 
still have it selected in edit mode. A new circle will appear inside the larger circle. As you 
should be able to see in solid mode, the new circle actually cuts its shape out of the larger 
circle surrounding it. Switch to wireframe mode with ZKEY so that you can see the 
underlying image again. Scale up the smaller circle so that it approximately fits the inner part
of the circle in the image. Don't worry about getting it exact since you'll be manually moving 
all four points anyway. Move the bottom point of the bezier circle to the top left corner of the
bar that crosses the circle.

Move the right point of the circle to the other corner. When 
you create a Bezier Circle, Blender by default sets the 
alignment of all the control points to aligned. To make the 
diagonal bottom edge you need to break the alignment on 
the two lower sets of control points. Hitting the HKEY will 
toggle between free control points and aligned. Once you've
selected the two lower bezier points and hit the HKEY to 
make them free you can move each of the inner control 
points to create a nice straight edge.

Then move the other two points and adjust their control points until you have a pretty good approximation of the rest of the 
inside curve. Next step is to press space -> Add -> Bezier Circle again and repeat the same steps, but for the lower opening in 
the logo. Once you've completed both openings, switch back to solid view with ZKEY and examine your work. Make any 
adjustments you need to swithing the draw type back and forth as needed.

The next step is to make this part three dimensional like you did with the lightning bolt. Go 
to object mode with TAB, then select the editing buttons. Under curve and surface, set 
Extrude/Ext1 to 0.2, Bevel Depth/Ext2 to 0.02 and BevResol to 4. You can also set 
DefResolU to 25 as suggested for the lightning bolt. Looking at the results, the bevel effect 
may not be enough, so try increasing Bevel Depth/Ext2 to something like 0.15. That should 
look better, but there will be a problem. Switch back to wireframe mode with ZKEY and 
you'll see that the bevel has widened everything so that the circle no longer matches the 
original image. This can be fixed fairly easily by reducing the width parameter under curve 
and surface until it fits again.

Circle in circle

Place two points at either end 
of the bar

Place two points at either end 
of the bar

Wider bevel has a nice look
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For final steps, select the lightning bolt again and switch into 
sideview with NUM3 and hit GKEY and then YKEY to 
move the bolt backwards. Move the bolt back so it no longer 
intersects with the circle and bar. Apply a red material to the 
circle and bar portion. Finally, you can go to view, then to 
background image and hit the background image button to 
hid the image now that it is no longer needed. At this point, 
you can add any finishing touches for lighting and camera 
angles and render the logo.

Johnos Addition (the tutorial on the 
next page does this too)

- This tutorial assumes that you were creating a logo from the one above, and that you are willing to listen to an idiot. :-)

I am new to Blender3D but I will try to finish this tutorial, and leave you with this:

Adding The Circle

Ok, what you have so far is a lightning bolt, which is great. Its also nice and rounded which is even better. However, what we 
are missing at the moment is the outside circle. This is probably not the best way of doing it, but it is one way. Instead of using 
the Bezier Curve, I am using Circles.

Go to the top view (NUM7), and press SPACE -> Mesh -> Circle. Accept the 32 vertices, you can make it less but it wont look 
as good.

Move it into the center of the circle, if you don't then I advise you have wireframe on for the moment (press Z). Then press S, 

Bevel has increased logo size

Width adjustment restores to 
normal size

Final render

The finished article
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for scale, and make it the correct size for the inside of the circle. Once you have that in the correct place, like so:

You may notice that I needed to stretch it sideways a little, you will too. Ok, deselect that, (press A, once or twice). Now make 
another circle, move it into the middle, and change the scale (S Key, remember) so that is reaches to the outside of the big red 
circle, bigger than the circle that you added before. Now here is where I am sure theres an easier way of doing it, but I don't 
know how so what I did to fill in the circle with faces was this.

If you dont read this carefully, then you may not get the wanted end result. Deselect the second circle, then select four vertices, 
that are in a square and will make up a face.

Adding the first circle
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Once you have that, press F and a face will appear, I.E the box will be filled (turn off Wireframe, press z). Now do this right 
around the circle. To do this, hold down Shift and Ctrl, then draw a circle around the two vertices you wish to deselect with the 
Left Mouse Button. Then draw a circle around the next two vertices while holding down Ctrl and LMB, NOT SHIFT. Shift 
changes the control from selecting, to deselecting. This might take a while, sorry. Once you have got right around the circle its 
time to make the line through the middle... this is easy!

NOTE: A quicker way of making the circle object in this scene is to only create the small circle, select it, press 'E' to extrude 
(choose Only Edges), press 'S' to scale and another sized circle will appear, size this appropriately then click LMB. Then to 
create the cross, select 2 vertices at either side of the circle near where the cross overlaps, then press 'F' to create a face.

This way is a lot faster, thanks for your help :-) To make the crossing line however, you need to move 4 of the vertices slightly..
example below:

Selecting the four vertices
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Once you do this, highlight the 4 you moved, then press F.

Making the circle 3D

Highlight the full circle by pressing A either once or twice. Go to Side View, and press E for extrude and drag it down so that it
is the same thickness as the lightning bolt (you'll see why). Now this bit is purely for arts sake, you won't probably learn 
anything here but its good practise.

Now look at what you have made... it looks nice enough but where the lightening bolt goes through the circle it looks a bit odd 
so we will make it look like the circle is lying on top of the bolt. Where the bolt goes through the circle, note the edges and the 
vertices. Move them so that the lines are just either side of where the bolt goes through. Then make new edges using CTRL+R 
on the outsides of these edges. Like so:

Moving the four vertices
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Now you have squares where the lightning bolt hits the circle. Change to Wireframe (z) if you are not already in it then 
highlight the 16 vertices of these boxes and raise them. Now do the same for where the center line crosses the bolt but create 4 
lines instead of two. To explain why, I've done a diagram.

Now we can make the finishing touches, add subsurf and set it to 2 or 3 and add colour! Then you are done :-) I won't go over
subsurf and adding color because people have covered that better than I could in previous 'Noob to Pro' pages. I think thats 
everything, I did this and ended up with the first screenshot so I'm sure you will aswell. Sorry about any spelling mistakes, and 
I'm sure I didn't use the easiest methods but I've only been doing this kind of stuff for 3 days :-) Good luck

Next Page: 2D Image (logo) to a 3D Model Part 2
Previous Page: Curve and Path Modeling

Creating the overlap

Why we use 4 points instead of 2

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P


Blender 3D: Noob to Pro - Beginner Tutorials/Print version - Wikib... http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P...

145 of 263 5.5.2007 21:39

2D Image (logo) to a 3D Model Part 2

Next Page: Modeling a picture
Previous Page: 2D Image (logo) to a 3D Model

Tracing an Image With an Interior Cutout

Tracing the No symbol is somewhat more complex than the lightning bolt. The reason is this symbol is hollow and requires 
additional planning to trace than just following an outline of an object.

I'll be back to explain the difficulties in the near future, so stay tuned.

One way to do this is outlined below:

The first thing to do is add a mesh circle. Hit SPACE and select 'Add -> Mesh -> Circle'. (This circle is mostly for 
measuring purposes, and will ultimately be removed.)
Scale (SKEY) and move (GKEY) the circle so that it's sides are even with the sides of the logo circle, and the top and 
bottom are an even distance from the top and bottom of the logo circle. (The logo circle is not perfectly round.)

Make sure you're in object mode (TAB), add a cube (SPACE, 'Add -> Mesh -> Cube') and place it (GKEY) on the right 
edge of the circle so that it is centered on the right edge.
Scale (SKEY) the cube so that it is the same width as the wall of the circle and touching each side of the wall.
Now, we want the 3Dcursor at the center of the logo circle. To do this, go back to object mode (TAB), and select the 
circle that we added earlier (RMB), then press SHIFT+SKEY and choose 'Cursor -> Selection'. (This is the main reason 
why we have this circle here.)
Reselect the cube (RMB) and TAB to edit mode.
Choose NUM7 for the top view, and use RMB to select only the front face of the cube. (Before this you have to make 
sure that you are in 'Face select mode'.) In the image below, I've used MMB to rotate the scene slightly so that you can 
see that only one face is selected (Note: In this picture there are two faces selected. The one you should select is front one
in front view NUM1 or the bottom one in top view NUM7 - it's the same face).
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Press XKEY and choose Erase Vertices. This will reduce the cube to a square

(User note: Erase Vertices will erase all the vertices connected to the two faces selected. In this case this is all the vertices in the 
cube and will completely remove the cube. I think "Erase Faces" would be correct.)

twofingers: @1st - READ carefuly, @2nd - before editing Wikibooks DISCUSS it first in the DISCUSSION tab! and @3rd - 
SIGN YOURSELF!

Press NUM7 to go to the top view then select the Editing panel (F9).
Press AKEY to select all, and then make sure that the rotate settings are set to degr:360 , Steps:50 , Turns: 1. (Actually, 
Steps can be whatever number suits your fancy. You may want to play with various values.) This is just like we did for 
creating the man's hat.
Click on 'Spin' to extrude the square into a ring.

(Another way to do it is to create a ring with 2 Tubes (SPACE -> Add -> Mesh -> tube). Scale one to the size of the outer 
border of the ring and one to the size of the inner one. Then in edit mode select 2 Vertices next to each other on the inner and 
outer tube and made a face (FKEY) which covered one segment of the ring. Then you have to spin it like described above (the 
number depends on the number of vertices you choose for your tube tube = 32 Verticles -> 632 rotationsteps). Same on the 
other side. If your faces are not in the right place go to object mode select the tubes an press SHIFT+SKEY and choose 'Cursor
-> Selection' to center the 3D cursor.)

Next we will create the bar.

Staying in Edit mode, hit SPACE and select 'Add -> Cube'. If you haven't moved the cursor since the ring extrusion, it 
should appear in the middle of the ring.
Expand (SKEY) the cube so that it just encompasses the inside circle of the ring

Scale (SKEY) the square in the Y axis (YKEY) so that it is approximately the thickness of the logo bar.
Return to object mode (TAB), and rotate (RKEY) the ring together with the just designed bar so that it is parallel to the 
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logo bar.
In Edit Mode (TAB), squash the ring in the Y direction (SKEY, YKEY) so that it fits the logo ring.

In edit mode, reselect just the bar. To do this, choose 'Face select mode', and do an area select of the face selectors near 
the center of the bar (use the BKEY, or SHIFT+RMB methods).
Re-rotate (RKEY) the bar (in Edit Mode) so that it is parallel to, and in the middle of, the logo bar.

The next thing we need to do is scale the bar so that it is precisely the same width as the logo bar.
To do this, choose scale (SKEY), and press YKEY twice. This will go to local scale mode (local to the object). This is 
why we were rotating the entire ring, since the ring and bar are part of the same object.
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We no longer need the original circle now, (it should be sticking out from the top and bottom of the ring), so select it 
(RMB), and delete it (XKEY).
If you hit NUM3 You'll see that the bar and the ring are at completely different heights than the lightning bolt. Select and
scale them so that they are all roughly the same height (the bar should be slightly higher than the bolt, and the bolt 
slightly higher than the ring so that all the proper parts are covered.).
You can use the trick above to select (RMB) only the bar, scale it in the Z axis (SKEY, ZKEY) and then hit SPACE
and choose 'Select -> Inverse' to select the ring (all but the bar).
When done rescaling, press NUM7 to look at your handiwork.

There is one last bit, which is to slightly rotate the whole ring around the X axis so that it is below the top of the bolt and 
above the bottom.
Once that's done, all that's left to do, is color in the ring.

Next Page: Modeling a picture
Previous Page: 2D Image (logo) to a 3D Model

Modeling a picture
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Previous Page: 2D Image (logo) to a 3D Model Part 2

Modeling a picture

Ever seen an awesome looking picture you wanted to turn into a 3D model? Like a logo or a symbol? Well, it's actually pretty 
easy... it just takes some time to do.

First off, you're going to need a picture to trace, I'm currently doing a project for a friend to do with devils and demons, 
so I chose a demonic looking face for this tutorial: Demonic Face
(http://www.masterpiecepumpkins.com/Graphics/Devil2%20(1.5)_______________PM.JPG) 

Now we open Blender and start a new project. Delete the default cube. Before you start tracing the face, you need to set 
the face as the background image. To do this, click 'view', then 'Background Image'. A box should pop up with only one 
button in it (Use Background Image), click it. Now some settings appear, we're only interested in one of them for this 
tutorial. Click the small button with a picture of a miniature folder on it (it looks kind of like a feather pen.) It's the first 
one under the 'use background image' button. From there, select the picture you want to trace. Like this: Background 
Selection (http://k.domaindlx.com/genis/images/bg_select.jpg) 

Ok, now for the long part. Zoom in to the new background image just a little bit. Now, add a bezier curve, and size it 
down a little. Hit F9 and find and click the button that says 'Poly'. Now there should be a few more vertices to work with 
and the curve should be just a bunch of joined lines. Select one point at a time and using the GKEY move it to a point 
along the background image(or face in this case). Do the same for all of the rest of the vertices, making sure you only 
have one vertex selected at a time or you'll move more than just the vertex you want to. once this is done, select one of 
the end vertices of the curve (it doesn't matter which end) and use SHIFT+DKEY to copy that vertex. Move the newly 
copied vertex to a point along the edge of the face a small ways away from the vertex you copied it from. Continue doing 
this until you have a complete outline (of the whole face or just one part, like the ear). Here's what it should look like (I 
did the left ear):Tracing (http://k.domaindlx.com/genis/images/points.jpg) . You can't see it in the picture, but six of the 
points on the right side of the ear are connected, while the rest aren't. In order to get the effect we're looking for here, we 
need to connect all of the points around the edge to make an outline (make sure not to connect the points across the 
picture or you'll have a messed up outline).

(user note: hitting CTRL-LMB instead of SHIFT-DKEY will add a vertex that is already connected.)

To get the outline for the whole face, just do the exact same thing around all of the edges. We still have a problem 
though, most of the points aren't joined by a line, so all we have is a bunch of dots. This is easily solvable. Using the 
BKEY or the right click of the mouse, we select a bunch of vertices at a time (somewhere between 5 and 10), and hit the 
FKEY a few times. Every time you hit the FKEY it should connect two of the points. Do this until all of the selected 
points are connected, then deselect them and select another group and use FKEY to join them. Keep doing this until all 
of your points are connected. To connect the last two points, select all the points and press the CKEY, to close the 
polygon.

[edit: A better option would be to select a vertex on one of the ends of the whole line, hold down the CTRL and left-click on a 
certain point on the image. This will create a new vertex, immediately connected to the vertex you selected.]

Now that we've got the entire face traced (or outlined if you want to call it that), we can make it 3D. Hit F9 again and 
find the Ext1 and Ext2 properties, shown here: Ext1 & Ext2 (http://k.domaindlx.com/genis/images/make3D.jpg) . 
Change the values and see what happens. They correspond to the depth of the outline. Try changing them around until 
you find what looks good. Now, you'll notice that the lines just stick out straight. I'm still investigating how to actually 
model a head from the outlined face ... so if anyone has any ideas, feel free to add them to this page.

in order to make it have depth you should make the outline out of mesh points instead of a curve. add a primitive mesh 
and delete all the vertices in edit mode, then ctrl click to all point outline. add depth to the surface in a side view(split 
views so you can see what your moving). it helps to have 2 or more reference images, but you can wing it. Usually the 
final result has to be subsurfed.

(USER EDIT: I accidentally started it with mesh instead of curve. You can do the same thing with extrude, but I have no idea 
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how to go on after that) (USER EDIT LATER: If you subsurf it, it creates a relatively 3D looking image. Its really cool)

(Another user, even later: If you want to turn your curve into a mesh, hit Alt-C while in Object Mode. Note that this is NOT 
reversible.)

Next Page: Bones
Previous Page: 2D Image (logo) to a 3D Model Part 2

Printing a Rendered Image

Render your image. Exit or minimize the "Blender:Render" window. In blender, go to File -> Save Image... Then save your 
image. Then you can print it as you would print any other picture, using The Gimp, Paint, Microsoft's Photo Editor, or many 
others.

Using Bones

Next Page: Materials and Textures
Previous Page: Modeling a picture

Bones
Bones are a modeling tool that is especially important if you're trying to model characters that move. Bones allow you to move 
characters' limbs in a way that is much simpler than trying to re-arrange the vertices every time.

Basically how it works is that a bone will be associated with certain vertices, which will move along with the bone when the 
position is changed in pose mode. Using bones is fairly simple once you get the hang of it, but, like many things in Blender, can
be a little daunting at first sight. Never fear - that's what tutorials are for!

A model

Bones don't do much on their own - in fact, they turn invisible on render time! So, we'll need a model to use them with. If you 
haven't already, use an earlier tutorial to create a simple model, and we'll be on our way!

For this tutorial, we're going to use a model with human proportions, but bones can be used with just about any body type. The
same idea can be applied to cats, spiders or whatever!,

Laying down bones

Note: This just shows the basics of boning an object. Go to the advanced animation page for a more comprehensive guide on 
this.

Alright, let's get started! First of all, we'll need a model to put some bones on! For this tutorial, we're going to use a humanoid 
model. I'm using a quick model that I made based off of the Blender 3D: Noob to Pro/Modeling a Simple Person first tutorial. 
It's rather blocky, but this isn't a detailed tutorial. ;)

Okay, first of all, here's our setup, with Block Dude standing on the plane. 
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Now, let's put some bones on Block Dude! In Object Mode go to Space -> Add -> Armature.
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What we are looking at is an armature. This is a single bone. Now, we need to put the bone in Block Dude! Move and rotate the
bone so that it's in the middle of Block Dude's chest.

Now, extrude and scale the bone as needed to put the bones in his body! Make sure that you are in Edit mode, and click the 
pink dots at the end of the bone to do things like extrusion. These operate much the same way as verticies, you can extrude, 
rotate, move, and even subdivide. Your finished result should look something like this:
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Now, just to make things easier, we're going to name the bones. For example, my bones are named RT_Forearm, Left_Forearm,
RT_Upper_Arm, etc. Select the bone and click here to rename it. (This makes it much easier when you have lots of bones.)
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Now, we need to parent the bones to the mesh. Go back into Object Mode and select Box Dude. Now, select the Armature as 
well, and press CTL+PKEY. A menu will pop up, select "Armature", then "Create from closest bone." Select the armature, 
and enter Pose Mode(CTL+TAB)(you need to select the armature for this option to appear!). Try moving a bone around. If 
you've done everything correctly, your mesh should move when you move the bones! If this doesn't happen, scale the bones up 
so that they fit better in the mesh, and scale up the bones until they do what you want. With the bones now, you put Box Dude 
into a lot of different positions without moving individual verticies.

Note: "Create From Closest Bones" creates vertex groups within the parented object that are associated with armature bones. 
This is done automatically, according to the bones' position and size. Alternatively, choose "Name Groups" instead of "Create 
From Closest Bones" if you don't want Blender to assign groups automatically, and do it manually. To manually change vertex
groups go to Edit Mode (Edit Mode, F9, Links and Materials tab) and use the Assign and Remove buttons. 'Assign' adds 
vertices to the group (without removing any members that are not curently selected) and 'Remove' obviously removes them. 
Vertices can be assigned to multiple groups.

In response to the previous comment, if the vertices are properly assigned to the bones they will move regardless of whether 
the bones are inside the cylinder or not (HOW they deform WILL be affected however). I'm guessing that your mistake was 
creating and (more importantly) parenting the cylinder to the armature while it was outside the cylinder, which caused Blender
not to assign vertices to any bones at all. You can check this by editing the cylinder, selecting a vertex group in the Links and 
Materials tab, and pressing select. This will highlight the vertices associated with the bone. If none are selected, it means none 
were assigned in the first place - in which case you need to assign them manually as explained above.

If there is no effect, select in Edit or Pose mode that bone (or bones) and choose Envelope display mode (F9 -> Armature -> 
Envelope), then press Alt+S and increase its area of influence to cover all faces that should be influenced by the bone.

Finally, here's an example of how you can move Box Dude with the bones: 
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Materials and Textures

Next Page: Quickie Material
Previous Page: Bones

Materials and textures are the things giving your model colour and structure. Without materials your models would always stay 
the same dull grey blender uses by default. While materials give the model colour, textures give it a structure. They allow you 
to do things such as add a wood pattern to a desk and to make your rendered images look more realistic.

To find out more about materials and textures, go to the next page.

Next Page: Quickie Material
Previous Page: Bones

Quickie Material

Next Page: Quickie Texture
Previous Page: Materials and Textures

Your First Material
Hit CTRL+XKEY to start with a new Blender scene. This switches you automatically to Object mode. Use the RMB to select 

the default Cube and then open the Material buttons by pressing the shading button (  or press F5). The cube should already 
have a default gray material assigned to it, as seen below.

Click the  next to MA:Material in the Links and Pipelines panel to delete the link to the datablock. This removes the 
material from the object, removes several tabs from the Button window, and removes a lot of information from the Material 
panel and replaces it with an "Add New" button. You could click that to create a new material, but what we want to do is 
reapply the old material to it. Click the button that looks like this:  . You'll see a drop-down list and you want to choose 
"Material". This nifty drop-down will list all of the materials you've created thus far and let you apply them to any object in the 
scene.

Naming Names

"Material" isn't a very creative name for a material. There are a couple of different ways to rename the material.
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Press the button that looks like a little car. It's right next to the  that deletes the material. This will "auto" rename the 
material. It will come up with a pretty boring name, "Grey". It's better than "Material", but we can think of something 
better.

1.

Press LMB over the material name, and a cursor will appear for you to put your custom material name. To clear the 
entire name before entering your own, press BACKSPACE. There are many places in the Blender you can enter your 
own value using the same method. Rename the material to "Green Ooze".

2.

Setting the Color

Obviously, just changing the name of the material doesn't make the material green. We have to do some work on it still. You'll 
notice this section of buttons:

Set the R value to 0.149, the G value to 1.000, and the B value to 0.446. R of course stands for red, G for green, and B for blue.
Mixing these values, we can achieve any color you want.

The easiest way to choose your color value is to click the box below and use the window that pops up to select whatever color 
suits your fancy. You'll be using this one in later tutorials.

We've changed the color of the object, but we can also change the color of the specular. Specularity adjusts how the material 
reflects light. Click the button marked Spe. The color dialog can now be used to adjust the specular color. Keep your eyes on 
the Preview of the material and start messing with the R, G, and B sliders.

Set the specular color to R = 0.640, G = 0.990, and B = 0.566. With this value we should be able to get a good ooze down the 
road. The colour preview and settings should now look like this:

 

There are a lot of other material buttons. We'll get to them all eventually. Keep this file open and go to the next tutorial, where 
we will perfect the ooze.

Next Page: Quickie Texture
Previous Page: Materials and Textures

Quickie Texture
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Intro
Textures are laid on top of materials to give them complicated colours and other effects. An object is covered with a material, 
which might contain several textures: An image texture of stone, a texture to make the stone look bumpy, and a texture to make 
the stone deform in different ways. This tutorial uses the file from the previous tutorial. If you didn't do it before, go back and 
do it now.

Adding a texture
Select the object to be textured. Add a Material to it if it hasn't got one already. Select the Textures tab with the spotty square 
icon (or by pressing F6). Click Add New. Select the texture type from the drop-down list. You can also change the texture's 
name (It will be something like Tex.001) by clicking on the name box.

Adding a cloud texture
Add a new Cloud texture (select Clouds from the texture type drop-down list). A preview appears, as well as some parameters 
to experiment with.

Go back to the Materials tab (Click the red sphere or press F5) and a coloured preview of the texture appears. It is purple! All 
new textures default to this colour. On the right hand side there are three tabs: Texture, Map Input, and Map To. Select the Map
To tab. The RGB (Red, Green, Blue) sliders here adjust the colour of the texture. Some areas are transparent and show the 
material underneath. This allows you to layer textures. Make the colour black. Render the object (F12) to see the effect:

Next we will add a stucci texture to make our clouds look bumpy.

Adding a Stucci texture
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Go back to the textures tab (F6) and select the next texture channel (one of the blank buttons under 'Tex'). Add a Stucci texture.
Back to the Material (F5), and click the "Map To" tab. Turn Col off and Nor on. Col means the texture affects the colour. Nor 
means it affects the rendered normal, or the angle the renderer treats the surface as - creating fake shadows on the surface. Play 
with the Nor slider, but leave it on about 4. Now click the Map Input tab - we are going to change the size of the texture. Set 
SizeX to 0.2 (stretching the texture five times on the x-axis) and SizeY to 10 (Squishing the texture 10 times in the Y-axis). 
Render! The object looks like it has grooves.

Adding an image texture
Any JPG will do for this bit, but if you can't decide, find a nice picture of wood you'd like to use as a texture on the web. Using 
the Image Search feature of a search engine is an easy way. Remove the two old textures (on the Textures tab, select the old 
ones and click the little X next to their name) and add a new Image texture. Still in Textures, select image from the texture type 
drop down menu, click Load Image, and choose your image. Hit F12 to render.
Back to the Map Input tab (Materials, F5), try the effects of Flat, Cube, Tube and Sphere, and the XYZ buttons below. Also 
remember you can change the size of your image using the Size parameters (SizeX etc.)

Further Reading
Textures are a very powerful tool, and layering them can create all sorts of interesting effects. You can use Disp to actually 
displace the vertices of your object based on the texture (best used with a high vertex count or Subsurf) and do all sorts of other
tricks. The Nor feature is very good for making objects look more realistic without greatly increasing the render time.
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Procedural Textures
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Procedural Textures

Texturing objects can be broken down into two categories: procedural and image texturing. Procedural texturing makes use of 
mathematical formulas to generate textures. These textures are generated within Blender. Image texturing uses images created 
or captured outside of Blender, either from an image manipulation program such as the GIMP or Photoshop, or captured on a 
camera. We have already learned about image texturing, so move on to the next tutorial to learn about procedural texturing.

Current Procedural Textures

Blender currently supports many procedural textures, which are : Clouds, Marble, Stucci, Wood, Magic, Blend, Noise,
Musgrave, Voronoi and DistortedNoise.

Next Page: Creating Basic Seawater
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Creating Basic Seawater

Next Page: Texturing Basic Seawater
Previous Page: Procedural Textures
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75% of the Earth's surface is covered with water. In homage to this great fact, we will develop your materials skills first by 
creating basic seawater.

First we create a new file in Blender and delete the default cube by pressing XKEY and confirming the popup dialog. Now 
switch to top view with NUM7 and enter SPACE > Add > Mesh > Plane to create a plane. Then scale it up to 30 its original 
size with the SKEY the way you've already learned in one of the earlier tutorials.

Now off to the actual texturing work. Press F5 to bring up the Material Buttons in the Buttons Window. You will probably find
two new small windows appearing here: one called Links and Pipelines and the other one Preview.

Click the 'Add New' button in the Material window to create a new material named `Material.001'. To make life easier we'll 
rename it to something meaningful like 'Seawater' by simply clicking it and typing in the letters, as shown here 
(SHIFT+DELETE in field to clear):

Now, on the same tab, give the seawater material a color of RGB (0.0, 0.139, 0.400). Find the Alpha slider and move it until it 
reads approximately Alpha 0.100.

Next Page: Texturing Basic Seawater
Previous Page: Procedural Textures

Texturing Basic Seawater

Next Page: Mountains Out Of Molehills 2
Previous Page: Creating Basic Seawater

Disclaimer: This tutorial is for those of you who have installed the yafray
(http://www.blender3d.com/cms/Yafray.51.0.html) external renderer! The texture will NOT look like waves (or much of
anything at all) with the internal renderer of Blender.

[Note: Since version 2.42 (or maybe earlier) you can use the internal blender render]

[ed. note: Need a much more basic introduction to what materials, textures, maps, and all the accompanying terms are with 
illustrative examples before diving into a specific sea-water example. Much more effective learning when you know what you're
changing.]

A rendered image with yafray renderer 
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A rendered image with blender renderer 
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Now we'll add a procedural texture to our seawater, which will give it a "wavy" look. Click the Texture button (looks like 
bricks) or press F6 to view the texture buttons subcontext. Click on the knob to the left of the texture name and select the "Add 
New" button. This creates a new texture named "Tex.001". Click on the name and change it to "Waves".

Go to the Texture Type pull-down and select 'Stucci'. On the Stucci tab click 'Wall Out' and 'Soft noise', and change 'Noise 
Basis' to 'Voronoi F1'. [ed. question: Need a little more detail on playing with what these parameters do] Our Waves texture is 
ready; next, we will refine how it is applied to our Seawater material.

Left click on the Materials button (looks like a red sphere) to return to the material buttons subcontext. Look at the Texture 
panel, and you'll see that the "Waves" texture has been automatically associated with the Seawater material.

Select the 'Map To' tab. Click the 'Nor' and 'Spec' buttons so they're selected and have white text (the white text indicates a 
positive mapping). Click the 'Hard' button twice so it's selected and has yellow text (the yellow text indicates a negative 
mapping).

Select the 'Map Input' tab. There, look at the X, Y and Z scaling. The values to use here depend on the size of your water plane 
(you can see and edit the size of the plane by going to Object, Transform Properties or by pressing 'N'. With a plane size of 
X=3, Y=3, Z=1, a reasonable map input scaling is sizeX=5, sizeY=20, sizeZ=25. One important consideration, if you're 
mapping to a flat surface, is that the X and Y scalings shouldn't match (or Y and Z or X and Z for a vertical plane). This is part 
of what gives the Stucci/voronoi a good "wave" look.

[Note: for the subsequent step you may have to change the Texture Blending Mode to subtract or multiply, instead of mix or 
add, to get a fine rendered image. Since version 2.42 (or may earlier) use F5 -> MapTo -> drop down list select Subtract or 
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Multiply and continue with this tutorial. This also works for the yafray renderer, later you can change it back to Mix after you 
applied a second texture with 'Col' enabled.]

Now do a render (F12) and look at the result. If you just get a big blue-green looking plane, you are probably using the internal 
blender renderer. Install YafRay if you haven't already. To render with it, press F10 to view the Scene context. On the Render 
tab, beneath the huge 'Render' button, change the Render Engine from 'Blender internal' to 'YafRay'.

[User note: I have blender 2.41 and I have just clicked the colorband button inside the Color's Tab from Texture, and it looked 
like: 

 ]

(Note: You have to have your light a good distance away from the plane, and have it set very powerful to see more than a black 
square.)

This looks okay, but a bit too jagged. To smooth things out, we'll add a second texture. Go to the Texture subcontext (F6) if 
you're not already there. In the Texture tab, click the first empty rectangle beneath the "Waves" texture. Click 'Add New'. 
Rename the new texture "Clouds", and change its texture type to 'Clouds'. In the Clouds tab, set NoiseSize to .2 and 
NoiseDepth to 2. Switch back to the material buttons subcontext, select the Texture tab, and verify that the new Clouds texture 
is checked and selected. Click on the Map To tab and select 'Nor' ('Col' should already be selected).

Render (F12), admire your water, and maybe drink a tall glass of something refreshing!

Next Page: Mountains Out Of Molehills 2
Previous Page: Creating Basic Seawater

Mountains Out Of Molehills 2
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This tutorial shows you how to use displacement mapping to make a simple environment.

1. Make a grid. (Add/Mesh/Grid) 32x32 will do just fine.
2. Set it smooth. (Editing/Link and Materials/Set Smooth)
3. Make a new material for it. (Shading/Material/Add New)
4. Make a new texture for the material. (Shading/Texture/Add New)
5. Go to Shading/Texture Buttons. You can see your newly created texture there now.
6. Change Texture Type to Clouds.
7. Change the name of the texture to be more descriptive. For example GroundDisp or something similar.
8. Go back to Shading/Material buttons. You can see our cloud texture applied now but it's not applied correctly yet.
9. Go to Shading/Map To. This defines how the selected texture is mapped on our material.
10. Check out Col and check Disp on.
11. Set camera and a few lights to the scene.
12. Render.

You can tweak the environment easily by changing Nor value in the Shading/Map To. This defines how strongly the 
displacement texture affects the material.
You could also add subsurfing to the ground area to get smoother results. Also feel free to tweak the texture and try out 
different alternatives.

By adding some Mist in the World buttons, adding a Cloud Texture to the World and make it blend from white to gray we 
could get something like this: 
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Light a Silver Goblet

Next Page: Basic Carpet Texture
Previous Page: Mountains Out Of Molehills 2

Techniques

You should know how to:

Perform actions discussed previously in the tutorial.

This section will recap or introduce:

Reflective material
Positioning camera and light
Editing the World colors
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Objects in the Scene

Create the goblet discussed in Model a Silver Goblet or load it if previously made. If you haven't already made the goblet, feel 
free to try the tutorial using a sphere or something else instead and you will still get a good outcome. In Object Mode with 
NUM 7 view, add a plane mesh. Scale the plane to very large and make sure the goblet is setting comfortably on top of it.

Select the camera and move it so that the goblet, its shadow, and its reflection in the plane will be seen. You can see the 
numerical location of the camera by bringing up the Transform Properties window by pressing NKEY in the viewport. In my 
example where 0,0,0 is the bottom center of the goblet, the camera is located at 27, -21, 19 XYZ with a rotation of 63.5, 0.62, 
46.7.

Next, move the light so that it will create a shadow on the plane. Again, the location of this example is 9, -15.2, 25.8 for XYZ 
(rotation does not matter for this type of light source).

 

The rendering of this scene yields:

Adding the Atmosphere

In Object Mode, select the goblet and go to the Shading panel (F5). If no material is linked to the goblet, add new material. 
Rename the material 'cup' or something similar. The area of interest is the Mirror Transp window. Highlighted below are the 
mirror options we'll be playing with. Press the Ray Mirror button to make the material act like a mirror and reflect light.

Move the RayMir slide to 0.85 or type it in after LMB on the number. This is how reflective the surface will be. A low number 
of 0.00 means that it reflects little while a high number of 1.00 reflects everything.
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Also change the Fresnel slide to 1.4 from 0.0. This will increase the power of the Fresnel function. What this means is the color
of the material will be strong because the light source is taken into consideration. If the Fresnel wasn't used, the object would 
appear dark because the light source isn't directly calculated in the mirror. Also, change the color of the goblet to white. Using a
light color will give your goblet an interesting petina if you so choose.

Next, select the plane and modify the material. We want the plane to be dark and shiney. Set Col and Spe to near black for the 
color. For reflectivity, turn on Ray Mirror to about 0.15 RayMir and ignore Fresnel this time.

The scene will still be quite dark so let's turn up the light. Sometimes you want to add additional light sources and other times 
you just want what you have to be brighter. Here we'll stick to the one lamp.

Select the lamp object and increase the Energy to 3.000 making it 3 times brighter than before. As always, try changing it to 
several levels to see how bright or dark you can make the rendering.

There is only one more thing to do before rendering the scene: change the world. Under the Shading panel there is a globe icon 
that will get you to the world buttons. Here you have Real, Blend, and Paper buttons under the Preview window. And under the
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World window are options for changing the color of the horizon (Ho RGB), zenith (Ze RGB), and ambient (Am RGB). We're 
interested in these two windows at the moment.

Using Real and Blend will affect the way the horizon and zenith interact. Experiment with them to see what they do in the 
preview. In this example, Real and Blend are turned on.

The Paper button works a little differently in that what you see in the preview will essentially be the background of your 
render. This effect is most noticable when your camera is rotated. Despite the camera rotation, the preview would still be 
'wallpapered' on the render.

For our world, set the RBG close to 0.00 for the horizon, zenith, and ambient.

That was the last step! Make sure the camera is in the right spot and render the scene. Here is the output of this example: 

Next Page: Basic Carpet Texture
Previous Page: Mountains Out Of Molehills 2

Basic Carpet Texture

Next Page: Image Textures
Previous Page: Light a Silver Goblet

Goal
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I am using a basic scene that I quickly set up before I started to create the carpet material. It shows a monkey (suzanne), a 
plane, camera, 3 area lamps and 1 spot lamps.

The purpose of this tutorial, is to highlight the power of blenders built in shaders and procedural textures to create a carpet 
material to use in your scenes.

[User request: Can you please specify how you arranged the three area lights and the main light, or possibly make the scene you
started with available for download?]

The Basic Material and Shader Settings

For the basic material for the carpet set the colour settings of your material as follows -
Col (R 0.714) (G 0.134) (B .134) Dark Red
Spe (R 0.590) (G 0.210) (B 0.084) Redish Brown
Mir (R 1.000) (G 1.000) (B 1.000) White

Change the specular shader to ('phong') and leave the default lamert diffuse shader as it is. Change the ('spec') to [0.13] and the 
('hard') to [12]. Lastly click the ('Full Osa') button to enable it. If you render now you will notice that the plane looks like a ugly 
pastel colour (if not, you have a different lighting setup to mine and the shader will not look the same as the images in this 
tutorial.) Dont worry about this ugly looking plane it will soon be a beautiful carpet.

Cloud Texture 1

Press 'F6' on the keyboard to bring up the texture panel. Click the bottom most of the long boxes to create a texture in the 
bottom channel. Create a new texture and rename it something like 'Red Clouds 1'. From the ('Texture Type') pull down select 
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clouds. In the 'Clouds' settings panel change ('NoiseSize') to [0.210] and ('NoiseDepth') to [4].

Now select the Colors tab which will bring up the ColorBand for the texture. Press the orange ('Add') button to add a cursor on 
the colourband. Next make sure the 'Cur : 0' is showing next to the add button and change the colours as follows - (R 0.770, G
0.168, 0.168). Now click on right side of the 'Cur : 0' so it shows 'Cur : 1'. Change 'Pos' to 0.6. Set Alpha to 1 and change the
colour to (R 0.732 G 0.243 B 0.243).

Now go back into the material settings and change the settings in the Map To tab as follows. Click ('Spec') twice so the text 
becomes yellow do the same for ('Hard'). Now select 'Subtract' for the texture blending mode. Change ('Col') to [0.188].

At this stage if you render you might find it hard to notice the difference, it is apparent only where there is low light levels on 
the plane, don't worry about this at the moment. It means if you render with Ambiant Occlusion you get a nice carpet effect of 
slightly varrying colour.

Cloud Texture 2

Go back to the texture panel and create another texture, call it 'Clouds' and put it in the channel above 'Red Clouds'. Change 
('NoiseSize') to [0.054] and ('NoiseDepth') to 4. Select 'Improved Perlin' from the Noise Basis pull down. Finally change 
('Nabla') to [0.031]. Do not change any more settings here.

Now in the material panel, under the Map To tab change the following - Click ('Nor'). Click ('Spec') and ('Hard') twice so as 
they are yellow.
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As you can see the material is starting to look a bit better, only 2 more textures to go.

The Final Cloud Texture

Switch to the texture panel once again and create a new Clouds texture in the next channel up. Change ('NoiseSize') to [0.010] 
and ('NoiseDepth') to [6]. Now click on the 'Colors' tab and change the colour of the left cursor ('Cur : 0') to (R 0.713 G 0.262 B
0.223) and Alpha to 0. Switch to Cursor 1 ('Cur : 1') and its colour settings (R 1.000 G 0.363 B 0.000) and Alpha to 1.

Now in the materials panel under the 'Map To' tab Click ('Nor'). Click ('Spec') and ('Hard') twice so as they are yellow. Leave 
the blending mode as 'Mix'. Change ('Col') to [0.464] and ('Nor') to [1.00].

The Last Texture

For the last time (in the sense of this tutorial) go to the textures panel. Create a new Stucci texture in the next channel up. 
Change ('NoiseSize') to [0.006] and ('Turbulance') to [10.94]. Click on the 'Colors' tab. The first cursor 'Cur : 0' sould be black
with alpha 0. 'Cur : 1' should be red (R 1.000 G 0.000 B 0.000) with alpha 1.
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Now go to the materials panel. Under the 'Map To' tab Click ('Nor'). Click ('Spec') and ('Hard') twice. Change the Blending type
to 'Subtract'. Change ('Col') to [0.056] and ('Nor') to [0.50]. And thats it. When you render now you should have a nice looking 
carpet material. By tweaking with the colours you can create an colour of carpet.

Next Page: Image Textures
Previous Page: Light a Silver Goblet

Procedural Eyeball

Next Page: Image Textures
Previous Page: Basic Carpet Texture

Level: intermediate
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Version: 2.43

Building a better (procedural) eyeball!
Originally created by Jon McKay (Ammusionist) and posted on blenderartists.org/forum
The end result of this tutorial is an eyeball that fulfills the following requirements:

Single mesh
I wanted to be able to append a single object into any project.

1.

Procedural Textures
I didn't want to have to rely on image maps that could get lost.

2.

Versatile
One single model to be used for any type of character, be it human, alien or whatever.

3.

Easy
Any effects needed to be quickly accessible. I don't want to be wasting time faffing around with colour-band 
settings at the texture level

4.

Impressive
This sucker needs to look good any way it goes.

5.

One other thing I really wanted was the iris musculature to follow the pupil dilation!6.

Creating the Mesh

The objective here is to make a great looking eyeball. That means it may not be anatomically perfect, but there are some things 
we need to take into account: The eye should consist of a white (white bit with veins); an iris (coloured bit); a pupil (black but 
in the centre of the iris) and a cornea (clear bit surrounding the whole eye). These may not be absolutely correct, but these are 
how I'm referring to the pieces of the eye.

Start with a ball: Go to a front view (Keypad-1) and create a UV sphere. 24 Rings and segments should be sufficient. It'll 
give us plenty of smoothness and enough verts to work with when we create shapes.
This sphere will become the coloured parts of the eye, but we also need a second sphere for the cornea. Use the Z key to 
switch to a wireframe view (if you're not already there). Hit the A key a couple of times to ensure all points are selected 
then Shift-D to duplicate the sphere.
Press S-Key to scale and scale the second sphere to slightly larger than the first. (Hint: Hold shift while scaling for fine 
adjustment) or you could also enter a value, 1.01.
Now that we have a nice confusing mesh, we're going to make our life easier. We're going to hide the outer bit for the 
moment. Hit the "H" key.
Don't panic like I did the first time I accidentally hit H, you can bring it all back with Alt-H. (Note: In blender Alt + some
key often reverses the effect of pressing the key in the first place!)
OK Now to create the basic mesh for the inner part. Basically, we need to make a concave iris/pupil section.
Switch to a side view and use the Border Select (B-Key) to select the first four rings and the tip. Now we're going to 
flatten these. Press "S" for scale "Y" for Y axis only and "number 0" for scale-to zero.
Now grab the flattened verts with the "G" key and press Y so that it goes the right way, and drag it a little into the 
eyeball.
Now for the cornea. It's not perfectly spherical; it bulges slightly at the front. We're going to use the Proportional Editing 
tool.
First, we need to un-hide the cornea. Hit Alt-H
Usually you would use the O-Key, but this little menu item allows you to to activate proportional editing for Connected 
vertices.
Once activated, you can select the type of falloff from the 3D header bar. Select “Root Falloff”
Press A-Key a couple of times again to make sure no points are selected, switch to a side view (Keypad-3) and right click
just to the left of the front-most point. We just want to select that one vertex.
Now comes some fun. We want to drag that point into the eye in the y axis, so press “G” for grab and “Y” for Y axis. As
you move the vertex, you'll see a circle that defines the influence of the proportional editing. Adjust it so it is about ¼ the
height of the whole eye and drag it out until it looks right.
To clean the model up, we're going to apply a subsurface and apply some smoothing. Go to the editing buttons and find 
the modifier panel.
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Add a subsurface modifier and set both level and render level to 2.
Now hit Tab to switch to Object mode and hit the "Set Smooth" button in the Link and Materials panel.
Now would be a good time to save your work before we go on to textures.

Adding the Textures

Cornea Material

White Material

Pupil Material

Iris UV Map

Iris Material

Pupil Dialation

Next Page: Image Textures
Previous Page: Basic Carpet Texture

Image Textures

Next Page: The Rusty Ball
Previous Page: Basic Carpet Texture

Procedural texturing is very powerful; however, sometimes it is difficult or impossible to generate the desired realism with 
them. Image texturing is there for you when you need it. To review, the basic idea is to take an outside image and wrap it 
around your model. Now move on to the next tutorial to learn how to do this.

Free Image Texture Editors

Wood Workshop (http://www.spiralgraphics.biz/ww_overview.htm) A free utility (Requires Operating System: 
Windows 2000/XP) that generates surprisingly high quality tiling wood texture images. These textures can be exported as
standard image files for use within Blender.
The GIMP (http://www.gimp.org) GIMP, a free image editor that has many of the same functions as Photoshop.

Next Page: The Rusty Ball
Previous Page: Basic Carpet Texture

The Rusty Ball

Next Page: Creating Pixar-looking eyes in Blender
Previous Page: Image Textures
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Making objects with image textures is not really hard for simple objects like balls, cubes, and tubes. I'll show you how to do 
this:

Make a new Scene in Blender and delete the default cube (XKEY).
Make an object you want to have the image on (I recommend a Mesh plane, sphere or tube).

if you are making a Mesh Plane, change your view to above, by pressing NUM7
Go to the materials (F5) and select the default material (of course you can also make a new material).
Now go to the textures (F6) and choose "Image" as "Texture type" for the selected texture. There will appear many 
options, the one we need is "Load image". Click it and select an image. (Note: JPGs, PNGs or TGAs are recommended 
for Blender. Bitmaps tend to get all screwy.)
After this, you'll have to specify how your image should be applied to your object. To do this, go to the materials again, 
where you'll have to find the "Map input" tab (near the textures tab). If you have selected it, you'll see four buttons: Flat, 
Cube, Tube and Sphere. Select the option which meets your object best.
Render your object. If you can't see your picture well, you can try to rotate your object or select another option in the 
"Map input" tab.

You can also render videos onto objects using this method. Just select a movie in the "Load image" dialog and enable the 
option "Movie" at the textures buttons. NOTE: Blender ONLY works with Full Resolution video, not video which has been 
compressed using a codec. Most video software will allow you to export video as "full frames" or "no compression". 
Experiment a bit!

Next Page: Creating Pixar-looking eyes in Blender
Previous Page: Image Textures

Creating Pixar-looking eyes

Next Page: UV Mapping
Previous Page: The Rusty Ball

Goal

Note: This tutorial uses the same modelling and texturing technique described in the well-known MAX tutorial by Adam 
Baroody (http://www.3dluvr.com/rogueldr/tutorials/eye/eyes.html). The sole purpose of my tutorial is to make this technique 
more popular among the Blender users by explaining how to achieve the same result with Blender.

The goal of this tutorial is to make a Pixar-looking eye. One of the main reasons that Pixar's characters really convey life is in 
their eyes. They have depth, you can see how the eye not only shines but it "collects" light. You may think that you can't 
achieve this effect without raytracing but you're wrong. The secret of this depth is in the modelling of the eye. Lets see how it 
works!

Parts of the Eye

In this picture you can see the "ingredients" of the eye model. The blue mesh at the left is the cornea. Its shape allows for a 
small spot of specular light to appear on it even if the light is in a far side position. The mesh next to it is the iris. Now notice 
how it's a bit concave. That's the tricky part - the shape of the iris allows for a wide soft specular light to appear at the opposite 
side of the lamp direction. This fakes refracted light from the cornea and makes the illusion of "collecting" light and creates 
depth. The next mesh is the eye pupil - a simple circle.The pupil size is the same size as the iris hole. You can position it close 
to the inner side of the iris. And finally - the eyeball. It's a simple sphere with a hole in it.
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I won't go deep into modelling of each element - it uses Blender's subdivision surfaces and it's quite simple as you can see.

Below is a link to the diagram of the eye [4]
(http://www.basiclenses.com/images/uploads/Eye%20Diagram%20National%20Eye%20Institute%20Refno%20NEA08.jpg) 

Materials

Now let's look at the materials.

Cornea

To make the cornea, press NUM3 to go into side view and add a UVsphere with 8 segments and 8 rings. To create the hole at 
the front of the cornea, delete the 8 triangular faces that make up one end of the cornea. The resulting hole will be ringed by 8 
vertices (which you could subsequently extrude and use to help you model the sections below - just a suggestion for those who 
feel capable)

The cornea uses a transparent material (alpha = 0.1) with Spec = 6, Hard = 255 and SpecTra = 1. "Ztransp" should also be 
turned on.

(User: Spec has a max of 2, is .6 me thinks)

(User: Make sure shadow buttons are off or it will black out the iris.)

See here for a premade .blend file of this step (http://nusoy.com/blender) .

Iris

~~ Note ~~ I did this tutorial, first the way they said here, and then my way. I inserted a circle, extruded (edges only), but I 
DIDN'T move anything. I then scaled what I had extruded towards the origin of the circle (middle). It had the same effect, and 
was much faster, but you had to get it roughly 1/4 of the way for the same proportion. ~~ End of Note ~~

The iris is built from a circle of 8 vertices.

Select opposite vertices of the circle and join them using FKEY. While creating these lines, subdivide each new edge 
using subdivide multi with 2 cuts (WKEY then subdivide multi. Check number of cuts = 2. Press OK).

Select the new vertices two at a time (adjacent ones) and join them using FKEY. This will form a ring which will become
the pupil hole.

Change to edge select (CTRL + TAB) and select the inner edges where the pupil will be. Delete these edges (XKEY then
press Edges).

Change back to vertex selection and select the inner vertices around the pupil hole. Change to a front view and pull the 
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vertices back a little to form the concave shape. (Select vertices, then press G to "grab", and drag LMB away from cornea
opening.)

Scale the iris to the same size as the hole in the eyeball and position it behind the cornea. (Press S, then drag)

Create a new material and add the iris texture (F6 or click the spotted wall tiny button, choose Image as the texture type 
and then press Load Image button). To create a material see the material tutorial at 
http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Quickie_Material.

The texture should be flat texturing (top button to right of preview) and flat in the Map Input tab. Occo coordinates work. All 
that is required now is a bit of tweeking of the texture size using the Xsize and Ysize values in the Map Input tab, and scaling 
the pupil hole size in Edit mode.

(User: Hm, image seems to be missing. Use GIMP or something and extract the iris from this pic used later on in the tutorial: 

/User)

Here is the eye texture taken from the picture above 

You can tweak the RGB values and brightness/contrast of the image to achieve the appearance you want. Use a smaller value 
for Hard (about 50) otherwise you'll have a too shiny look instead of soft specular that fakes refracted light. The Spec value 
depends on the energy and distance of the light that illuminates it. Generally you'll need to take care that the refracted ligth on 
the iris should be no more than half as bright as the small specular spot on the cornea - otherwise you'll achieve the bad effect 
of two specular spots. Oh, another important thing - join the four meshes before tweaking the texture coordinates. Otherwise 
you'll have to do the job twice after you join them, because the texture space is changed. And activate shadeless button.

Click here to download the .blend file for this step. (http://nusoy.com/blender) 

Pupil

The material for the pupil is a simple black color with the "shadeless" button on.

Sclera

The sclera (http://en.wikipedia.org/wiki/Sclera) has white color and high values for Spec and Hard (depends on the lighting). 
Optionally you can use a reflection map to make it look more wet but I usually don't do this.

Lighting
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The lighting is simple - move the eye to a new layer, create a new lamp and make the lamp affect only this layer. Position the 
lamp at a good angle so you have a small shiny spot of specular light on one side of the iris and a soft spot of "refracted" light 
on the other side. You can use a backlight to prevent the eyeball from being too dark at the non-illuminated part.

That's it! Now you're (almost) ready to start with character animation. You have a nice eye, now you only need a character for 
it!

Changing the Eye Color

You can change the color of the eye by either changing the cornea color, or by changing the iris color itself. Changing the 
cornea color might be like putting on colored contacts.

Changing the Cornea Color

To change the cornea color, do the following:

In the mesh which is used to create Cornea set the value of the alpha slider to 0.2 (or more if you desire)1.
Change the color of the mesh to whatever color you like2.
Turn off traceble3.

Render!4.

(and remenber to smooth out everything by selecting the perticular mesh going to edit buttons and clicking on set smooth)

Changing the Iris Color

To change the iris color you can either edit the iris image external from blender or you can modify the RGB values of the image
when imported into Blender.
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Next Page: UV Mapping
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UV Mapping

Next Page: Quickie UV Map
Previous Page: Creating Pixar-looking eyes in Blender

Learning the basics of using UV mapping to map a texture accurately onto an object.

In case you're interested, UV mapping stands for the technique used to "wrap" a 2D image texture onto a 3D mesh. "U" and 
"V" are the name of the axes of a plane, since "X", "Y" and "Z" are used for the coordinates in the 3D space. For example: 
increasing your "U" on a sphere might move you along a longitude line (north or south), while increasing your "V" might move
you along a line of latitude (east or west).

Next Page: Quickie UV Map
Previous Page: Creating Pixar-looking eyes in Blender

Quickie UV Map

Next Page: UV Map Basics
Previous Page: UV Mapping

See the next page for a relevant video tutorial.

Next Page: UV Map Basics
Previous Page: UV Mapping

UV Map Basics
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Next Page: Every Material Known to Man
Previous Page: Quickie UV Map

Intro

Until someone types in the text for this chapter, you can watch a good video tutorial from the main Blender
(http://www.blender3d.org) site. It is called LSCM UV Mapping and it is located on this page: 
http://blender3d.org/cms/Model_Material_Light.397.0.html

Someone now proceeds to write some beginning text to this page... (pretty much a summary of the excellent above video by 
GreyBeard.) Should use a better object (that requires pinning etc).

The Basics of UV Mapping

Add an icosphere

We'll use an icosphere (2 iterations) for this demonstration. So, create an icosphere with 2 iterations. (SPACE → Add → Mesh
→ Icosphere)

Make sure you are in top view like in the picture before you create it. Otherwise the equator of the sphere is probably not 
parallel to the x/y-plane and unwrapping will give strange results.

Mark a seam

In side view, select a ring of vertices on the icosphere. (Like an equator).

Press CTRL+EKEY and select "Mark Seam". This tells the UV unwrapper to cut the mesh along these edges.
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Note: since Blender 2.42 you can alternatively go into UV Face Select-mode and mark single edges as seams with 
CTRL+RMB and you could also select the faces of the upper or lower half of the sphere and then press CTRL+EKEY and 
select "Mark Border Seam". This is quite nice because you don't have to switch between Edit-mode and UV-mode any more to 
mark seams.

Unwrap the mesh

Set the window mode to "UV Face Select" (this mode is another mode like "Edit Mode" or "Object Mode", and can be set 
using a drop-down box at the bottom of the 3D viewport).

To make a second 3D viewport click the RMB near the border in the 3D viewport and select "Split Area". Set its window type 
to "UV/Image Editor" with the drop down box on the far left (looks like a grid for the 3D viewport) or with SHIFT + F10.

In the first window, select all your vertices, and hit UKEY and then LSCM. For Blender 2.42 select all the faces, and hit 
UKEY and then unwrap to use LSCM.
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LSCM is one of the algorithms for unwrapping a mesh onto the 2-dimensional UV space, acronym for Least Squares 
Conforming Map. It is a very useful unwrapping method because it attempts to preserve the shape of each face, much like 
unwrapping the cloth of a garment.

Make a template image

When you have tweaked a nice layout and intend to make the texture image yourself, you may ease the texture drawing by 
saving an image of the UV layout. This image can then be opened in your image editing program of choice to make a basis for 
the UV texture by showing where each surface goes. First run UVs->Save UV face layout: With Wrap selected, the layout will 
maintain its proportions which is best for general Tip: if your image painting program supports layers, try putting the UV layout
in a locked, transparent layer above the actual painting. If you do not alter the dimensions of the exported UV image in any way
it will fit perfectly with your UV layout when the image is loaded back into Blender.

Apply an image

Save the following image:

Load it in the UV/Image window by clicking Image->Load image (or Image->Open in version 2.4). Then with the very basic 
operations, grab, rotate and scale, adjust the unwrapped mesh so that it fits nicely on top of the image.
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Admire your new creation

Back in the 3D viewport, put it in Object mode and set the Draw Type to Textured (it's normally Wire or Solid, another drop 
down box at the bottom of the window. Greybeard calls it potato mode). Hit TAB a couple of times to refresh your object, and 
admire your new picture mapped onto your object! To make the texture visible in renderings too, you also need to add a new 
material to the icosphere and then toggle on TexFace from the Material buttons:

To finish your work, switch to Edit Mode, select all vertices and from the Editing buttons (F9) click Set Smooth. Then next to 
the same panel reads Modifiers. Click Add Modifier -> Subsurf. Set Render Levels to three. Switch to Shading buttons (F5) 
and enable Stars. The scene is ready!
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Some notes

All this relates to the UV/Image window.
If you are going to edit the layout of your unwrapping (so you can make a better picture), make sure Select->Stick Local UVs to
Mesh Vertex is on. You can "pin" vertices when they have been unwrapped with PKEY. If you do, make sure you put at least 
one pin on every island. You can remove all pins with alt-p. LSCM works by trying to maintain the angles between each vertex.
If an unwrapping should be symmetrical and it's not, try putting one pin in the middle of the outside edge of the big side and 
one on the small side, and unwrapping again with EKEY.

IMPORTANT:

Remember to set your map input with the UV and Flat buttons enabled.
As said before, to make the texture visible in renderings, too, you also need to toggle on TexFace from the Material 
buttons.

Source

Greybeard's LSCM Mapping video tutorial: http://blender3d.org/cms/Model_Material_Light.397.0.html
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Every Material Known to Man

Next Page: Hot Keys
Previous Page: UV Map Basics

Want to share your material settings with the world? This is the place!

Metals and Minerals

Glass
Gold
Chrome
Alloy

Other

Ceramic
Crayon
Marble
Mirrors
Mothball
Liquid

Abstract

Light Effects
Misty Globe

Plants

Woods

Human

Caucasian Skin
South asian Skin

Next Page: Hot Keys
Previous Page: UV Map Basics

Modeling Keyboard Shortcuts
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Next Page: Beginning Modeling Final Project
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Blender HotKeys - Relevant to Blender 2.36 - Compiled from Blender Online Guides

Window HotKeys

Certain window managers also use the following hotkeys. So ALT+CTRL can be substituted for CTRL to perform the 
functions described below if a conflict arises.

CTRL+LEFTARROW. Go to the previous Screen.
CTRL+RIGHTARROW. Go to the next Screen.
CTRL+UPARROW or CTRL+DOWNARROW. Maximise the window or return to the previous window display size.
SHIFT+F4. Change the window to a Data View
SHIFT+F5. Change the window to a 3D Window
SHIFT+F6. Change the window to an IPO Window
SHIFT+F7. Change the window to a Buttons Window
SHIFT+F8. Change the window to a Sequence Window
SHIFT+F9. Change the window to an Outliner Window
SHIFT+F10. Change the window to an Image Window
SHIFT+F11. Change the window to a Text Window
SHIFT+F12. Change the window to an Action Window

Universal HotKeys

The following HotKeys work uniformly in all Blender Windows, if the Context allows:

CTRL+LMB. Lasso select: drag the mouse to form a freehand selection area.

ESC.
This key always cancels Blender functions without changes.
or: FileWindow, DataView and ImageSelect: back to the previous window type.
or: the RenderWindow is pushed to the background (or closed, that depends on the operating system).

SPACE. Open the Toolbox.
TAB. Start or quit EditMode.
F1. Loads a Blender file. Changes the window to a FileWindow.
SHIFT+F1. Appends parts from other files, or loads as Library-data. Changes the window to a FileWindow, making 
Blender files accessible as a directory.
F2. Writes a Blender file. Change the window to a FileWindow.
SHIFT+F2. Exports the scene as a DXF file
CTRL+F2. Exports the scene as a VRML1 file
F3. Writes a picture (if a picture has been rendered). The fileformat is as indicated in the DisplayButtons. The window 
becomes a File Select Window.
CTRL+F3 (ALT+CTRL+F3 on MacOSX). Saves a screendump of the active window. The fileformat is as indicated in
the DisplayButtons. The window becomes a FileWindow.
SHIFT+CTRL+F3. Saves a screendump of the whole Blender screen. The fileformat is as indicated in the 
DisplayButtons. The window becomes a FileWindow.
F4. Displays the Logic Context (if a ButtonsWindow is available).
F5. Displays the Shading Context (if a Buttons Window is available), Light, Material or World Sub-contexts depends on 
active object.
F6. Displays the Shading Context and Texture Sub-context (if a ButtonsWindow is available).
F7. Displays the Object Context (if a ButtonsWindow is available).
F8. Displays the Shading Context and World Sub-context (if a ButtonsWindow is available).
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F9. Displays the Editing Context (if a ButtonsWindow is available).
F10. Displays the Scene Context (if a ButtonsWindow is available).
F11. Hides or shows the render window.
F12. Starts the rendering from the active camera.
LEFTARROW. Go to the previous frame.
SHIFT+LEFTARROW. Go to the first frame.
RIGHTARROW. Go to the next frame.
SHIFT+RIGHTARROW. Go to the last frame.
UPARROW. Go forward 10 frames.
DOWNARROW. Go back 10 frames.
ALT+A. Change the current Blender window to Animation Playback mode. The cursor changes to a counter.
ALT+SHIFT+A. The current window, plus all 3DWindows go into Animation Playback mode.
IKEY. Insert Key menu. This menu differs from window to window.
JKEY. Toggle the render buffers. Blender allows you to retain two different rendered pictures in memory.
CTRL+O. Opens the last saved file.
QKEY. OK? Quit Blender. This key closes Blender. Blender quit is displayed in the console if Blender is properly 
closed.
ALT+CTRL+T. TimerMenu. This menu offers access to information about drawing speed. The results are displayed in 
a pop-up.
CTRL+U. OK, Save User defaults. The current project (windows, objects, etc.), including UserMenu settings are written
to the default file that will be loaded every time you start Blender or set it to defaults by pressing CTRL+X.
CTRL+W. Write file. This key combination allows you to write the Blender file without opening a FileWindow.
ALT+W. Write Videoscape file. Changes the window to a FileWindow.
CTRL+X. Erase All. Everything (except the render buffer) is erased and released. The default scene is reloaded.
CTRL+Y. Redo. Mac users may use CMD+Y.
CTRL+Z. Undo. Mac users may use CMD+Z.
SHIFT+CTRL+Z. Redo. Mac users may use SHIFT+CMD+Z

Object Mode HotKeys

These hotkeys are mainly bound to the 3D Viewport Window, but many work on Objects in most other windows, like IPOs and
so on, hence they are summarized here.

HOME. All Objects in the visible layer are displayed completely, centered in the window.
PAGEUP. Select the next Object Key. If more than one Object Key is selected, the selection is shifted up cyclically. 
Only works if the AnimButtons->DrawKey is ON for the Object.
SHIFT+PAGEUP. Adds to selection the next Object Key.
PAGEDOWN. Select the previous Object Key. If more than one Object Key is selected, the selection is shifted up 
cyclically. Only works if the AnimButtons->DrawKey is ON for the Object.
SHIFT+PAGEDOWN. Adds to selection the previous Object Key.
ACCENT. (To the left of the 1KEY in US keyboard) Select all layers.
SHIFT+ACCENT. Revert to the previous layer setting.
TAB. Start/stop EditMode. Alternative hotkey: ALT+E.
AKEY. Selects/deselects all.
CTRL+A. Apply size and rotation. The rotation and dimensions of the Object are assigned to the ObData (Mesh, Curve, 
etc.). At first glance, it appears as if nothing has changed, but this can have considerable consequences for animations or 
texture mapping. This is best illustrated by also having the axis of a Mesh Object be drawn (EditButtons->Axis). Rotate 
the Object and activate Apply. The rotation and dimensions of the Object are 'erased'.
SHIFT+CTRL+A. If the active Object is automatically duplicated (see AnimButtons->DupliFrames or AnimButtons- 
>Dupliverts), a menu asks Make duplis real?. This option actually creates the Objects. If the active Mesh Object is 
deformed by a Lattice, a menu asks Apply Lattice deform?. Now the deformation of the Lattice is assigned to the vertices
of the Mesh.
SHIFT+A. This is the AddMenu. In fact, it is the ToolBox that starts with the `ADD' option. When Objects are added, 
Blender starts EditMode immediately if possible.
BKEY. Border Select. Draw a rectangle with the LeftMouse; all Objects within this area are selected, but not made 
active. Draw a rectangle with the RightMouse to deselect Objects. In orthonormal ViewMode, the dimensions of the 
rectangle are displayed, expressed as global coordinates, as an extra feature in the lower left corner. In Camera 
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ViewMode, the dimensions that are to be rendered according to the DisplayButtons are displayed in pixel units.
SHIFT+B. Render Border. This only works in Camera ViewMode. Draw a rectangle to render a smaller cut-out of the 
standard window frame. If the option DisplayButtons->Border is ON, a box is drawn with red and black lines.
CKEY. Centre View. The position of the 3DCursor becomes the new centre of the 3DWindow.

ALT+C. Convert Menu. Depending on the active Object, a PopupMenu is displayed. This enables you to convert 
certain types of ObData. It only converts in one direction, everything ultimately degrades to a Mesh! The options
are:

Font -> Curve
MetaBall -> Mesh The original MetaBall remains unchanged.
Curve -> Mesh
Surface -> Mesh

CTRL+C. Copy Menu. This menu copies information from the active Object to (other) selected Objects.
Fixed components are:

Copy Loc: the X,Y,Z location of the Object. If a Child is involved, this location is the relative position
in relation to the Parent.
Copy Rot: the X,Y,Z rotation of the Object.
Copy Size: the X,Y,Z dimension of the Object.
DrawType: copies Object Drawtype.
TimeOffs: copies Object time offset.
Dupli: all Duplicator data (Dupliframes, Dupliverts and so on)
Mass: Real time stuff.
Damping: Real time stuff.
Properties: Real time stuff.
Logic Bricks: Real time stuff.
Constraints: copies Object constraints.

If applicable:
Copy TexSpace: The texture space.
Copy Particle Settings: the complete particle system from the AnimButtons.

For Curve Objects:
Copy Bevel Settings: all bevelling data from the EditButtons.

Font Objects:
Copy Font Settings: font type, dimensions, spacing.
Copy Bevel Settings: all bevelling data from the EditButtons.

Camera Objects:
Copy Lens: the lens value.

SHIFT+C. CentreZero View. The 3DCursor is set to zero (0,0,0) and the view is changed so that all Objects, including 
the 3Dcursor, can be displayed. This is an alternative for HOME.
DKEY. Draw mode menu. Allows to select draw modes exactly as the corresponding menu in the 3D viewport header 
does.
SHIFT+D. Add Duplicate. The selected Objects are duplicated. Grab mode starts immediately thereafter.
ALT+D. Add Linked Duplicate. Of the selected Objects linked duplicates are created. Grab mode starts immediately 
thereafter.
CTRL+D. Draw the (texture) Image as wire. This option has a limited function. It can only be used for 2D compositing.
ALT+E. Start/stop EditMode. Alternative hotkey: TAB.
FKEY. If selected Object is a mesh Toggles Face selectMode on and off.
CTRL+F. Sort Faces. The faces of the active Mesh Object are sorted, based on the current view in the 3DWindow. The 
leftmost face first, the rightmost last. The sequence of faces is important for the Build Effect (AnimButtons).

GKEY. Grab Mode. Or: the translation mode. This works on selected Objects and vertices. Blender calculates the 
quantity and direction of the translation, so that they correspond exactly with the mouse movements, regardless of 
the ViewMode or view direction of the 3DWindow. Alternatives for starting this mode:

LMB to draw a straight line.
The following options are available in translation mode:

Limiters:
CTRL: in increments of 1 grid unit.
SHIFT: fine movements.
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SHIFT+CTRL: in increments of 0.1 grid unit.
MMB toggles: A short click restricts the current translation to the X,Y or Z axis. Blender calculates which 
axis to use, depending on the already initiated mouse movement. Click MiddleMouse again to return to 
unlimited translation.
XKEY, YKEY, ZKEY constrains movement to X, Y or Z axis of the global reference.
a second XKEY, YKEY, ZKEY constrains movement to X, Y or Z axis of the local reference.
a third XKEY, YKEY, ZKEY removes constraints.
NKEY enters numerical input, as well as any numeric
key directly. TAB will switch between values, ENTER finalizes, ESC exits.
ARROWS: These keys can be used to move the mouse cursor exactly 1 pixel.
Grabber can be terminated with:

LMB SPACE or ENTER: move to a new position.
RMB or ESC: everything goes back to the old position.

Switching mode:
GKEY: starts Grab mode again.
SKEY: switches to Size (Scale) mode.
RKEY: switches to Rotate mode.

ALT+G. Clears translations, given in Grab mode. The X,Y,Z locations of selected Objects are set to zero.

SHIFT+G. Group Selection
Children: Selects all selected Object's Children.
Immediate Children: Selects all selected Object's first level Children.
Parent: Selects selected Object's Parent.
Shared Layers: Selects all Object on the same Layer of active Object

IKEY. Insert Object Key. A keyposition is inserted in the current frame of all selected Objects. A PopupMenu 
asks what key position(s) must be added to the IpoCurves.

Loc: The XYZ location of the Object.
Rot: The XYZ rotation of the Object.
Size: The XYZ dimensions of the Object
LocRot: The XYZ location and XYZ rotation of the Object.
LocRotSize: The XYZ location, XYZ rotation and XYZ dimensions of the Object.
Layer: The layer of the Object.
Avail: A position is only added to all the current IpoCurves, that is curves which already exists.
Mesh, Lattice, Curve or Surface: depending on the type of Object, a VertexKey can be added

CTRL+J. Join Objects. All selected Objects of the same type are added to the active Object. What actually happens here
is that the ObData blocks are combined and all the selected Objects (except for the active one) are deleted. This is a 
rather complex operation, which can lead to confusing results, particularly when working with a lot of linked data, 
animation curves and hierarchies.
KKEY. Show Keys. The DrawKey option is turned ON for all selected Objects. If all of them were already ON, they are 
all turned OFF.
SHIFT+K. A PopupMenu asks: OK? Show and select all keys. The DrawKey option is turned ON for all selected 
Objects, and all Object-keys are selected. This function is used to enable transformation of the entire animation system.
LKEY. Makes selected Object local. Makes library linked objects local for the current scene.

CTRL+L. Link selected. Links some of the Active Object data to all selected Objects, the following menu entry 
appears only if applicable.

To Scene: Creates a link of the Object to a scene.
Object IPOs: Links Active Object IPOs to selected ones.
Mesh data: Links Active Object Mesh data selected ones.
Lamp Data: Links Active Object Lamp data to selected ones.
Surf Data: Links Active Object Surf data selected ones.
Material: Links Active Object Material to selected ones.

SHIFT+L. Select Linked. Selects all Objects somehow linked to active Object.
Object IPO: Selects all Object(s) sharing active Object's IPOs.
Object Data: Selects all Object(s) sharing active Object's ObData.
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Current Material: Selects all Object(s) sharing active Object's current Material.
Current Texture: Selects all Object(s) sharing active Object's current Texture.

MKEY. Moves selected Object(s) to another layer, a pop-up appears. Use LMB to move, use SHIFT+LMB to make the
object belong to multiple layers. If the selected Objects have different layers, this is ORed in the menu display. Use ESC 
to exit the menu. Press the "OK" button or ENTER to change the layer setting. The hotkeys (ALT-)(1KEY, 2KEY, ... - 
0KEY) work here as well (see 3DHeader).
CTRL+M. Mirror Menu. It is possible to mirror an Object along the X, Y or Z axis.
NKEY. Number Panel. The location, rotation and scaling of the active Object are displayed and can be modified.
ALT+O. Clear Origin. The `Origin' is erased for all Child Objects, which causes the Child Objects to move to the exact 
location of the Parent Objects.
SHIFT+O. If the selected Object is a Mesh toggles SubSurf onn/ off. CTRL+1 to CTRL+4 switches to the relative 
SubSurf level for display purpouses. Rendering SUbSurf level has no HotKey.

CTRL+P. Make selected Object(s) the child(ren) of the active Object. If the Parent is a Curve then a popup offers 
two choices:

Normal Parent: Make a normal parent, the curve can be made a path later on.
Follow Path: Automatically creates a Follow Path constraint with the curve as target. If the Parent is an 
Armature, a popup offers three options:
Use Bone: One of the Bones becomes the parent. The Object will not be deformed. A popup permits to 
select the bone. This is the option if you are modelling a robot or machinery
Use Armature: The whole armature is used as parent for deformations. This is the choice for organic beings.
Use Object: Standard parenting. In the second case further options asks if Vertex groups

should not be created, should be created empty or created and populated.

ALT+P. Clears Parent relation, user is asked if he wishes to keep or clear parent-induced transforms.
Clear Parent: the selected Child Objects are unlinked from the Parent. since the transformation of the Parent
disappears, this can appear as if the former Children themselves are transformed.
... and keep transform: the Child Objects are unlinked from the Parent, and an attempt is made to assign the 
current transformation, which was determined in part by the Parent, to the (former Child) Objects.
Clear Parent inverse: The inverse matrix of the Parent of the selected Objects is erased. The Child Objects 
remain linked to the Objects. This gives the user complete control over the hierarchy.

RKEY. Rotate mode. Works on selected Object(s). In Blender, a rotation is by default a rotation perpendicular to 
the screen, regardless of the view direction or ViewMode. The degree of

rotation is exactly linked to the mouse movement. Try moving around the rotation midpoint with the mouse. The rotation pivot 
point is determined by the state of the 3DWiewport Header buttons. Alternatives for starting this mode:

LMB to draw a C-shaped curve.
The following options are available in rotation mode:

Limiters:
CTRL: in increments of 5 degrees.
SHIFT: fine movements.
SHIFT+CTRL: in increments of 1 degree.

MMB toggles: A short click restricts the current rotation to the horizontal or vertical view axis.
XKEY, YKEY, ZKEY constrains rotation to X, Y or Z axis of the global reference.
a second XKEY, YKEY, ZKEY constrains rotation to X, Y or Z axis of the local reference.
a third XKEY, YKEY, ZKEY removes constraints.
NKEY enters numerical input, as well as any numeric key directly. ENTER finalizes, ESC exits.
ARROWS: These keys can be used to move the mouse cursor exactly 1 pixel.
Rotation can be terminated with:

LMB SPACE or ENTER: move to a new position.
RMB or ESC: everything goes back to the old position.

Switching mode:
GKEY: switches to Grab.
SKEY: switches to Size (Scale) mode.
RKEY: starts Rotate mode again.
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ALT+R. Clears Rotation. The X,Y,Z rotations of selected Objects are set to zero.

SKEY. Size mode or scaling mode. Works on selected Object(s). The degree of scaling is exactly linked to the 
mouse movement. Try to move from the (rotation) midpoint with the mouse. The pivot point is determined by the 
settings of the 3D Viewport header pivot Menu. Alternatives for starting scaling mode:

LMB to draw a V-shaped line.
The following options are available in scaling mode:

Limiters:
CTRL: in increments of 0.1.
SHIFT+CTRL: in increments of 0.01.

MMB toggles: A short click restricts the scaling to X, Y or Z axis. Blender calculates the appropriate axis 
based on the already initiated mouse movement. Click MMB again to return to free scaling.
XKEY, YKEY, ZKEY constrains scaling to X, Y or Z axis of the local reference.
a second XKEY, YKEY, ZKEY removes constraints.
NKEY enters numerical input, as well as any numeric key directly. ENTER finalizes, ESC exits.
ARROWS:These keys can be used to move the mouse cursor exactly 1 pixel.
Scaling can be terminated with:

LMB SPACE or ENTER: move to a new position.
RMB or ESC: everything goes back to the old dimension.

Switching mode:
GKEY: switches to Grab.
SKEY: starts Size mode again.
RKEY: switches to Rotation.

ALT+S. Clears Size. The X,Y,Z dimensions of selected Objects are set to 1.0.

SHIFT+S. SnapMenu:
Sel->Grid: Moves Object to nearest grid point.
Sel->Curs: Moves Object to cursor.
Curs->Grid: Moves cursor to nearest grid point.
Curs->Sel: Moves cursor to selected Object(s).
Sel->Center: Moves Objects to their barycentrum.

TKEY. Texture space mode. The position and dimensions of the texture space for the selected Objects can be changed in
the same manner as described above for Grab and Size mode. To make this visible, the drawingflag 
EditButtons->TexSpace is set ON. A PopupMenu asks you to select: "Grabber" or "Size".
CTRL+T. Makes selected Object(s) track the Active Object. Old track method was Blender default tracking before 
version 2.30. The new method is the Constrain Track, this creates a fully editable constraint on the selected object 
targeting the active Object.
ALT+T. Clears old style Track. Constraint track is removed as all constrains are.
UKEY. Makes Object Single User, the inverse operation of Link

(CTRL+L) a pop-up appears with choices.
Object: if other Scenes also have a link to this Object, the link is deleted and the Object is copied. The 
Object now only exists in the current Scene. The links from the Object remain unchanged.
Object & ObData: Similar to the previous command, but now the ObData blocks with multiple links are 
copied as well. All selected Objects are now present in the current Scene only, and each has a unique 
ObData (Mesh, Curve, etc.).
Object & ObData & Materials+Tex: Similar to the previous command, but now Materials and Textures with
multiple links are also copied. All selected Objects are now unique. They have unique ObData and each has 
a unique Material and Texture block.
Materials+Tex: Only the Materials and Textures with multiple links are copied.

VKEY. Switches in/out of Vertex Paint Mode.
ALT+V. Object-Image Aspect. This hotkey sets the X and Y dimensions of the selected Objects in relation to the 
dimensions of the Image Texture they have. Use this hotkey when making 2D Image compositions and multi-plane 
designs to quickly place the Objects in the appropriate relationship with one another.
WKEY. Opens Object Booleans Menu.
XKEY. Erase Selected? Deletes selected objects.
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ZKEY. Toggles Solid Mode on/off.
SHIFT+Z. Toggles Shaded Mode on/off.
ALT+Z. Toggles Textured Mode on/off.

Edit Mode - General

Again, Most of these hotkeys are useful in the 3D Viewport when in Edit Mode, but many works on other Blender Object, so 
they are summarized here. Many Object Mode keys works in Edit mode too, but on the selected vertices or control points; 
among these Grab, Rotate, Scale and so on. These hotkeys are not repeated here.

TAB or ALT+E. This button starts and stops Edit Mode.
CTRL+TAB. Switches between Vertex Select, Edge Select, and Face Select modes. Holding SHIFT while clicking on a 
mode will allow you to combine modes.
AKEY. Select/Unselect all.
BKEY+BKEY. Circle Select. If you press BKEY a second time after starting Border Select, Circle Select is invoked. It 
works as described above. Use NUM+ or NUM- or MW to adjust the circle size. Leave Circle Select with RMB or ESC.
CTRL+H. With vertices selected, this creates a "Hook" object. Once a hook is selected, CTRL+H brings up an options 
menu for it.
NKEY. Number Panel. Simpler than the Object Mode one, in Edit Mode works for Mesh, Curve, Surface: The location 
of the active vertex is displayed.
OKEY. Switch in/out of Proportional Editing.
SHIFT+O. Toggles between Smooth and Sharp Proportional Editing.
PKEY. SeParate. You can choose to make a new object with all selected vertices, edges, faces and curves or create a new
object from each separate group of interconnected vertices from a popup. Note that for curves you cannot separate 
connected control vertices. This operation is the opposite of Join (CTRL+J).
CTRL+P. Make Vertex Parent. If one object (or more than one) is/are selected and the active Object is in Edit Mode 
with 1 or 3 vertices selected then the Object in Edit Mode becomes the Vertex Parent of the selected Object(s). If only 1 
vertex is selected, only the location of this vertex determines the Parent transformation; the rotation and dimensions of 
the Parent do not play a role here. If three vertices are selected, it is a `normal' Parent relationship in which the 3 vertices 
determine the rotation and location of the Child together. This method produces interesting effects with Vertex Keys. In 
EditMode, other Objects can be selected with CTRL+RMB.
CTRL+S. Shear. In EditMode this operation enables you to make selected forms `slant'. This always works via the 
horizontal screen axis.
UKEY. Undo. When starting Edit Mode, the original ObData block is saved and can be returned to via UKEY. Mesh 
Objects have better Undo, see next section.
WKEY. Specials PopupMenu. A number of tools are included in this PopupMenu as an alternative to the Edit Buttons. 
This makes the buttons accessible as shortcuts, e.g. EditButtons-> Subdivide is also `WKEY, 1KEY'.
SHIFT+W. Warp. Selected vertices can be bent into curves with this option. It can be used to convert a plane into a tube
or even a sphere. The centre of the circle is the 3DCursor. The mid-line of the circle is determined by the horizontal 
dimensions of the selected vertices. When you start, everything is already bent 90 degrees. Moving the mouse up or down
increases or decreases the extent to which warping is done. By zooming in/out of the 3Dwindow, you can specify the 
maximum degree of warping. The CTRL limiter increments warping in steps of 5 degrees.

EditMode - Mesh

This section and the following highlight peculiar EditMode Hotkeys.

CTRL+NUM+. Adds to selection all vertices connected by an edge to an already selected vertex.
CTRL+NUM-. Removes from selection all vertices of the outer ring of selected vertices.
ALT+CTRL+RMB. Faces loop select.
ALT+RMB. Edges loop select.
CKEY. If using curve deformations, this toggles the curve Cyclic mode on/off.
EKEY. Extrude Selected. "Extrude" in EditMode transforms all the selected edges to faces. If possible, the selected faces
are also duplicated. Grab mode is started directly after this command is executed.
SHIFT+EKEY. Crease Subsurf edge. With "Draw Creases" enabled, pressing this key will allow you to set the crease 
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weight. Black edges have no weight, edge-select color have full weight.
CTRL+EKEY. Mark LSCM Seam. Marks a selected edge as a "seam" for unwrapping using the LSCM mode.
FKEY. Make Edge/Face. If 2 vertices are selected, an edge is created. If 3 or 4 vertices are selected, a face is created.
SHIFT+F. Fill selected. All selected vertices that are bound by edges and form a closed polygon are filled with 
triangular faces. Holes are automatically taken into account. This operation is 2D; various layers of polygons must be 
filled in succession.
ALT+F. Beauty Fill. The edges of all the selected triangular faces are switched in such a way that equally sized faces are 
formed. This operation is 2D; various layers of polygons must be filled in succession. The Beauty Fill can be performed 
immediately after a Fill.
CTRL+F. Flip faces, selected triangular faces are paired and common edge of each pair swapped.
HKEY. Hide Selected. All selected vertices and faces are temporarily hidden.
SHIFT+H. Hide Not Selected: All non-selected vertices and faces are temporarily hidden.
ALT+H. Reveal. All temporarily hidden vertices and faces are drawn again.
ALT+J. Join faces, selected triangular faces are joined in pairs and transformed to quads

KKEY. Knife tool Menu.
Face Loop Select: (SHIFT+R) Face loops are highlighted starting from edge under mouse pointer. LMB
finalizes, ESC exits.
Face Loop Cut: (CTRL+R) Face loops are cut starting from edge under mouse pointer. LMB finalizes, 
ESC exits.
Knife (exact): (SHIFT+K) Mouse starts draw mode. Selected Edges are cut at intersections with mouse line.
ENTER or RMB finalizes, ESC exits.
Knife (midpoints): (SHIFT+K) Mouse starts draw mode. Selected Edges intersecting with mouse line are 
cut in middle regardless of true intersection point. ENTER or RMB finalizes, ESC exits.

LKEY. Select Linked. If you start with an unselected vertex near the mouse cursor, this vertex is selected, together with 
all vertices that share an edge with it.
SHIFT+L. Deselect Linked. If you start with a selected vertex, this vertex is deselected, together with all vertices that 
share an edge with it.
CTRL+L. Select Linked Selected. Starting with all selected vertices, all vertices connected to them are selected too.
MKEY. Mirror. Opens a popup asking for the axis to mirror. 3 possible axis group are available, each of which contains 
three axes, for a total of nine choices. Axes can be Global (Blender Global Reference); Local (Current Object Local 
Reference) or View (Current View reference). Remember that mirroring, like scaling, happens with respect to the current 
pivot point.
ALT+M. Merges selected vertices at barycentrum or at cursor depending on selection made on pop-up.
CTRL+N. Calculate Normals Outside. All normals from selected faces are recalculated and consistently set in the same 
direction. An attempt is made to direct all normals `outward'.
SHIFT+CTRL+N. Calculate Normals Inside. All normals from selected faces are recalculated and consistently set in the
same direction. An attempt is made to direct all normals `inward'.
ALT+S. Whereas SHIFT+S scales in Edit Mode as it does in Object Mode, for Edit Mode a further option exists, 
ALT+S moves each vertex in the direction of its local normal, hence effectively shrinking/fattening the mesh.
CTRL+T. Make Triangles. All selected faces are converted to triangles.
UKEY. Undo. When starting Edit Mode, the original ObData block is saved and all subsequent changes are saved on a 
stack. This option enables you to restore the previous situation, one after the other.
SHIFT+U. Redo. This let you re-apply any undone changes up to the moment in which Edit Mode was entered
ALT+U. Undo Menu. This let you choose the exact point to which you want to undo changes.

WKEY. Special Menu. A PopupMenu offers the following options:
Subdivide: all selected edges are split in two.
Subdivide Fractal: all selected edges are split in two and middle vertex displaced randomly.
Subdivide Smooth: all selected edges are split in two and middle vertex displaced along the normal.
Merge: as ALT+M.
Remove Doubles: All selected vertices closer to each other than a given threshold (See EditMode Button 
Window) are merged ALT+M.
Hide: as HKEY.
Reveal: as ALT+H.
Select Swap: Selected vertices become unselected and vice versa.
Flip Normals: Normals of selected faces are flipped.
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Smooth: Vertices are moved closer one to each other, getting a smoother object.
Bevel: Faces are reduced in size and the space between edges is filled with a smoothly curving bevel of the 
desired order.

XKEY. Erase Selected. A PopupMenu offers the following options:
Vertices: all vertices are deleted. This includes the edges and faces they form.
Edges: all edges with both vertices selected are deleted. If this `releases' certain vertices, they are deleted as 
well. Faces that can no longer exist as a result of this action are also deleted.
Faces: all faces with all their vertices selected are deleted. If any vertices are `released' as a result of this 
action, they are deleted.
All: everything is deleted.
Edges and Faces: all selected edges and faces are deleted, but the vertices remain.
Only Faces: all selected faces are deleted, but the edges and vertices remain.

YKEY. Split. This command splits the selected part of a Mesh without deleting faces. The split parts are no longer 
bound by edges. Use this command to control smoothing. Since the split parts have vertices at the same position, 
selection with LKEY is recommended.

EditMode - Curve

CKEY. Set the selected curves to cyclic or turn cyclic off. An individual curve is selected if at least one of the vertices is 
selected.
EKEY. Extrude Curve. A vertex is added to the selected end of the curves. Grab mode is started immediately after this 
command is executed.
FKEY. Add segment. A segment is added between two selected vertices at the end of two curves. These two curves are 
combined into one curve.
HKEY. Toggle Handle align/free. Toggles the selected Bezier handles between free or aligned.
SHIFT+H. Set Handle auto. The selected Bezier handles are converted to auto type.
CTRL+H. Calculate Handles. The selected Bezier curves are calculated and all handles are assigned a type.
LKEY. Select Linked. If you start with an non-selected vertex near the mouse cursor, this vertex is selected together with
all the vertices of the same curve.
SHIFT+L. Deselect Linked. If you start with a selected vertex, it is deselected together with all the vertices of the same 
curve.
MKEY. Mirror. Mirror selected control points exactly as for vertices in a Mesh.
TKEY. Tilt mode. Specify an extra axis rotation, i.e. the tilt, for each vertex in a 3D curve.
ALT+T. Clear Tilt. Set all axis rotations of the selected vertices to zero.
VKEY. Vector Handle. The selected Bezier handles are converted to vector type.

WKEY. The special menu for curves appears:
Subdivide. Subdivide the selected vertices.
Switch direction. The direction of the selected curves is reversed. This is mainly for Curves that are used as 
paths!

XKEY. Erase Selected. A PopupMenu offers the following options:
Selected: all selected vertices are deleted.
Segment: a curve segment is deleted. This only works for single segments. Curves can be split in two using 
this option. Or use this option to specify the cyclic position within a cyclic curve.
All: delete everything.

EditMode - Metaball

MKEY. Mirror. Mirror selected control points exactly as for vertices in a Mesh.

EditMode - Surface
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CKEY. Toggle Cyclic menu. A PopupMenu asks if selected surfaces in the `U' or the `V' direction must be cyclic. If they
were already cyclic, this mode is turned off.
EKEY. Extrude Selected. This makes surfaces of all the selected curves, if possible. Only the edges of surfaces or loose 
curves are candidates for this operation. Grab mode is started immediately after this command is completed.
FKEY. Add segment. A segment is added between two selected vertices at the ends of two curves. These two curves are 
combined into 1 curve.
LKEY. Select Linked. If you start with an non-selected vertex near the mouse cursor, this vertex is selected together with
all the vertices of the same curve or surface.
SHIFT+L. Deselect Linked. If you start with a selected vertex, this vertex is deselected together with all vertices of the 
same curve or surface.
MKEY. Mirror. Mirror selected control points exactly as for vertices in a Mesh.
SHIFT+R. Select Row. Starting with the last selected vertex, a complete row of vertices is selected in the `U' or `V' 
direction. Selecting Select Row a second time with the same vertex switches the `U' or `V' selection.

WKEY. The special menu for surfaces appears:
Subdivide. Subdivide the selected vertices
Switch direction. This will switch the normals of the selected parts.
Mirror. Mirrors the selected vertices

XKEY. Erase Selected. A PopupMenu offers the following choices:
Selected: all selected vertices are deleted.
All: delete everything.

VertexPaint Hotkeys

SHIFT+K. All vertex colours are erased; they are changed to the current drawing colour.
UKEY. Undo. This undo is `real'. Pressing Undo twice redoes the undone.
WKEY. Shared Vertexcol: The colours of all faces that share vertices are blended.

EditMode - Font

In Text Edit Mode most hotkeys are disabled, to allow text entering.

RIGHTARROW. Move text cursor 1 position forward
SHIFT+RIGHTARROW. Move text cursor to the end of the line.
LEFTARROW. Move text cursor 1 position backwards.
SHIFT+LEFTARROW. Move text cursor to the start of the line
DOWNARROW. Move text cursor 1 line forward
SHIFT+DOWNARROW. Move text cursor to the end of the text.
UPARROW. Move text cursor 1 line back.
SHIFT+UPARROW. Move text cursor to the beginning of the text
ALT+U. Reload Original Data (undo). When EditMode is started, the original text is saved. You can restore this original
text with this option.
ALT+V. Paste text. The text file /tmp/.cutbuffer is inserted at the cursor location.

UV Editor Hotkeys

EKEY. LSCM Unwrapping. Launches LSCM unwrapping on the faces visible in the UV editor.
PKEY. Pin selected vertices. Pinned vertices will stay in place on the UV editor when executing an LSCM unwrap.
ALT+PKEY. Un-Pin selected vertices. Pinned vertices will stay in place on the UV editor when executing an LSCM 
unwrap.

EdgeSelect Hotkeys
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ALT+CLICK. Selects an Edge Loop.

FaceSelect Hotkeys

ALT+CLICK. Selects a Face Loop.
TAB. Switches to EditMode, selections made here will show up when switching back to FaceSelectMode with TAB.
FKEY. With multiple, co-planar faces selected, this key will merge them into one "FGon" so long as they remain 
co-planar (flat to each other).
LKEY. Select Linked UVs. To ease selection of face groups, Select Linked in UV Face Select Mode will now select all 
linked faces, if no seam divides them.
RKEY. Calls a menu allowing to rotate the UV coordinates or the VertexCol.

UKEY. Calls the UV Calculation menu. The following modes can the applied to the selected faces:
Cube: Cubical mapping, a number button asks for the cubemap size
Cylinder: Cylindrical mapping, calculated from the center of the selected faces
Sphere: Spherical mapping, calculated from the center of the selected faces
Bounds to x: UV coordinates are calculated from the actual view, then scaled to a boundbox of 64 or 128 
pixels in square
Standard x: Each face gets default square UV coordinates
From Window: The UV coordinates are calculated using the projection as displayed in the 3DWindow

Render Window Hotkeys (to be written)

To be written (if someone could it would be very useful! : there's no place about it on the internet (or I didn't search enough) )

JKEY. Changes the image output. You have two slots in which to render. Very useful when you want to see what a 
specific change did to the image.
AKEY. Toggles display of alpha channel. The alpha channel of a picture determines it's transparency: Black areas are 
fully transparent, white areas are fully opaque and grey means semi-transparent. This can be useful when rendered images
are arranged in layers, or used in applications which support alpha channels in images. To save images with alpha 
channel, make sure that the RGBA button in the render panel (F10) is enabled. Also, not all image formats support alpha 
channels, i.e. TGA and PNG do, but JPG does not. Note: Any background texturing which is done via the world panel 
(F8) will have an alpha value of 0, meaning it will be transparent. However, the world background will still be rendered 
correctly on (opaque) surfaces as reflections (i.e. mirrors) - this must be taken into account when later composing 
rendered images with a different background.
ZKEY. Toggle Zoom (2x). This will zoom the rendered image. The mouse can still be used to scroll around the zoomed 
image.

Next Page: Beginning Modeling Final Project
Previous Page: Every Material Known to Man

Beginning Modeling Final Project

Next Page: Beginning Lighting
Previous Page: Hot Keys

Now that you've gotten the hang of 3D modeling, it's important to get some community feedback on your progress. Don't be an 
ass and skip this part, or you'll regret it later. Basically this will help you track your progress and give you something that you'll 
be working on over a long term and something you'll be proud of.

First, you need to come up with a project idea. You can choose your own modeling project, or choose one from the list 
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below.

Second, you need to create a model of your idea. Spend a couple of hours on it, and give it some details.

Third, once you believe you've come far enough with the model, post it in the Works In Progress
(http://blenderartists.org/forum/forumdisplay.php?s=b6a3696a3b803274bb7c1b49df9a22a2&f=16) forum on 
BlenderArtists.org(formerly elysiun.com) (you will have to create an account if you haven't already). Post several 
screenshots of your model from within the Blender (note: creating screenshots is outside the scope of this wikibook, 
though see note lower down the page). You can post whatever subject and message with your posting that you would 
like, or you can use this suggested subject and message:

Subject: Beginning Modeling Final Project - <project name>

Message:

Hello. I'm new to the Blender and have completed the tutorials on Beginning Modeling found at the online 
wikibook http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro. Before I continue with the wikibook, I need 
some feedback from the community about my skill level so that I need to determine my progress so far. Please 
evaluate my model and these screenshots for the following:

1) I demonstrate an ability to navigate in 3D space.

2) I demonstrate an understanding of the basic parts of a 3D model, such vertices, edges, and faces.

3) I demonstrate an ability to create form in three dimensions.

Please assist me with any feedback on my model, keeping in mind that I am an absolute beginner still. I appreciate 
your help.

Wait for feedback. It usually comes very quickly. If you have any questions about feedback that you are given, don't be 
afraid to ask your questions in the forum.

When you and others that have viewed your work feel that you are ready, save your model in some place you can get 
back to easily. You will continue working on this project once you've learned some new skills.

Move on to the next page.

(BTW. in Windows and/or maybe other OS, to take a screenshot press 'PrtScn' (PrintScreen). It will copy the screen to 
clipboard for you to paste in your fav graphic app. This may not work in other OSs but try anyway. You can also create Blender
screenshot directly from Blender using menu File>Dump 3DView... or File>Dump Screen... )

(In linux under the KDE I use ksnapshot, check under the graphics tab and see if you have it. If not it should be just a google 
search away :) gl and happy blendering)

(On Mac OS X, press Command (Apple) + Shift + 3 to do a full screen capture)

List of ideas:
A Computer and keyboard
A fishing rod
A train engine
A skyscraper
A robot
A Tank (real or made up)
An airplane
A truck or car
Household appliances

Next Page: Beginning Lighting
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Previous Page: Hot Keys

Lighting

Beginning Lighting

Next Page: Adding Lamps
Previous Page: Beginning Modeling Final Project

Lighting, you say? Psshh. Just throw up one light source and let her run, right?

Wrong. Lighting is probably the most underestimated part of a scene by new 3D artists. By the following tutorials, you will 
gain knowledge of the technical use of lights in your scenes.

Next Page: Adding Lamps
Previous Page: Beginning Modeling Final Project

Adding Lamps

Next Page: Shadows
Previous Page: Beginning Lighting

You can quickly add several different types of lights to your blender scene

SPACE > Add > Lamp > Spot

A light will appear in the location of the 3D cursor. You can move a light just like any other object.

If you want to quickly light a scene just for illumination, not for a specific look, add four lamps around your subject. If you are 
interested in experimenting with a lighting arrangement, a nice quick way to experiment is to create a Monkey in the scene to 
test with.

SPACE > Add > Mesh > Monkey

The monkey is just as good of a test subject as a human face, so give it a try. You can throw various materials on the monkey 
and try different textures too. Don't bad mouth the monkey, she is really useful.

Explaining the Different Lights:

Lamp: Single point light source. This simple light source can cast sharp shadows, but is best for filling in dark areas 
without shadows turned on.
Sun: A light with parallel rays that will illuminate the scene with a bright even light. Often a good starting point for 
outdoor scenes.
Spot: Spot lights produce light in a cone shape, and have some special features. They are the only light source that can be
made visible with the 'halo' option, to simulate light in a fog. They are also the only light source that cast fake shadows, 
called buffer shadows. Unlike raytraced shadows , these buffer shadows are smooth, but not as accurate. They are FAST 
though, the only real choice for animation.
Hemi: 180° constant light source. Great for use as a fill light, or as a back light.
Area: These are similar to lamps, except that they are rectangular instead of an infinitesimal point. As a result they can 
cast accurate raytraced soft shadows. These are my lamp of choice for still shots, but they take a lot of time to render.
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Creating a basic scene with basic lighting

This addition is simply a way to apply what you know about lights and to discover a few settings like colors or creating 
simple shadows. The purpose here is to create a basic scene with a sphere over a plane, nicely lighted. You should 
already know the basics of blender (creating a mesh, moving and rotating it, rendering).

Creating the scene

Okay, let's start! Open a new file. Add a UVsphere of 32 rings and 32 segments. Exit EditMode. Leave it in the center 
of the scene.

Trick : Go in the Editing buttons , and push Set Smooth so the sphere will render as 
a nicely smoothed sphere.

You should already have a plane in the basic scene, otherwise add a Plane. Have it in ObjectMode and move it just 
under the sphere. Scale it so it is very big. The ideal would that we can't see borders with the camera.

Then we will move the Camera. Grab it and rotate it so it looks at the sphere from top and a bit from the right. You can 
have an idea of what it sees pressing Num0 to have a CameraView.
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Trick : First click on the Camera, then on the Sphere holding Shift( the order is very important ). Do a Ctrl+T and select 

TrackTo Constraint  . The camera will be looking at the center of the sphere... You can then move 

either the camera or the sphere and the camera will still point at the sphere. 

Adding the lights

Okay, what we have is a pretty beautiful scene, isn't it?... Well, it isn't! But it is enough to add some lights... Here I will 
describe a basic lighting scene I use as a default for fast renderings. I picked it out from another tutorial, you can find the 
link at the end of this page.
So we will add our so awaited lights. Add>Lamp>Spot. Yes, we will first use the Spot light. We can see it as a 
projector. This is the only light casting shadows. Place it so it is upper and on the left of the sphere. Rotate it so it looks 
at the Sphere (you can use a Trick I gave you before to have the light looking at the sphere).

Okay, let's see what we can tune with the spot light. Having the lamp selected, go in the Lamp settings 

. You will see these buttons.
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Yeah, really lots of options. Don't worry, I'll explain the basic ones.
Dist : Sets the maximum distance the light can reach. Increase it so the lighting cone really goes behind the sphere.
I set it to Dist:40.
Energy : This is the force of the light. You can leave it at Energy:1.
RGB : You can change the colour of the light. Click on the colour and a little window will appear to select the
colour you want. Leave it white.

Buf.Shadow : Enables the light to cast shadows, leave it pushed. 
OnlyShadows : This light only creates shadows, without casting light ( yeah quite unrealistic, but it can be useful

). Leave it unpushed. 
SpotSi : This is the angle of your cone, in degrees. Leave to SpotSi:45.
SpotBl : This smoothes the circle cast by the light. We will smooth it so that it looks better. Set it to SpotBl:0.4.
ClipSta and ClipEnd : This is the distance from the light between which shadows will be cast. You can see the
"line of effects" in the 3D windows when you change these. Set them so the line starts before the sphere and ends 
far ( well, a bit ! ) behind the plane. You should obtain something like this.

Now, we have set our Spot light. This light will be our side light and shadowing light. You can make a fast preview 
pressing F12. You can see your so nice shadow. But there isn't enough light... Let's add some more!
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Time to add a second light! Add>Lamp>Lamp. This time, we will create a basic lamp. This is like a point which emits 
light in every direction from that point. You should place it at the opposite of the camera, quite at the same height. This 
light will be used to better see the form of the sphere and to add a sort of general lighting of the scene.

Go in the Lamp buttons, and set it to a higher energy like Energy:1.25. You can make a quick render to see how much 
this light is important to a scene.

Now, we will add a second basic lamp. Add>Lamp>Lamp and we will place it just behind the camera point of view, a 
bit moved at the opposite of the Spot light. This third light will slightly light the dark parts of the sphere.
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Decrease the energy of this light, as it is only supposed to fake the reflections of the environment. I set it to Energy:0.8. 
Another little trick, as this is not supposed to be a direct light, there shouldn't be a little white glow called Specular on 

the sphere coming from this light. Push the No Specular button. 

Okay, it's time for the final rendering. Of course, this is a really basic lighting set you can use for rendering a simple 
mesh; but for more complicated scenes, lights can come from other places, with other colors, etc... Thus we didn't use the
Sun, Hemi and Area lights, which are a bit more complicated.

Note that the following site contains nude figures: For a more in-depth tutorial, here is a tutorial from the Blender 
Documentation (http://download.blender.org/documentation/html/x4029.html) , which has been a great source of help for me.

Outdoor lighting

Here you will use a Sun in conjunction with a Spot light and some little Lamps.

Next Page: Shadows
Previous Page: Beginning Lighting

Shadows

Next Page: Render Settings
Previous Page: Adding Lamps

Creating Soft Shadows

[twofingers: If you didn't read the link from previous page you'll want to do that now: Blender Documentation
(http://download.blender.org/documentation/html/x4029.html) .
It completly covers not only indoor and outdoor lighting but also adding simple and soft shadows to your scene.]
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Next Page: Render Settings
Previous Page: Adding Lamps

Rendering

Render Settings

Next Page: Output Format Options
Previous Page: Shadows

Render Settings

The render settings control various options related to the output of rendered, or full quality images. Rendering an image will 
calculate effects not displayed in the editing environment (due to their complexity), and therefore takes a larger amount of time 
to produce an image.

The Scene Tab

Let's take a look at all of the rendering options that Blender has. Open up a new scene (CTL + X) and press F10. You should 
see something that looks like this: 

These are the default settings for Blender(with one exception, I have the 'Threads' button turned on). Let's take a look at all of 
these tabs and see what they do.

Output / Render Layers

This is the first tab on the right. First of all, we see a file locator icon (  ) to the left of /tmp\. This is Blender's temporary 
directory. (Normally C:\tmp on Windows) Below that, we see another file locator icon, labled //backbuf. This is the Back 
Bpeuffered image, one way to make an image the background on your render. Simply use that file locator to find a file, and 
Blender will use it as the background image(backbuf button must be clicked). Finally, the last one is //ftype. I'm not sure what it
does, so we're going to ignore it.

edit: What? No. What does the //ftype field do?
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The next row down, we see this:  "What do these do?!" you ask. Well, it's actually 
quite simple. First of all, the first button is the backbuf button that I just talked about. If you have selected a background image 
to render using the "backbuf" option, clicking this button will make it show up. Next, on the right, are the 'Edge' and 'Edge 
Settings' buttons. Clicking the 'Edge' button will render your image with edges. Edges are rendered where the camera sees an 
edge. For an experiment, turn it on and render to see what happens. Notice how the default cube now has a black edge around 
it. If you want it bigger, click the 'Edge Settings' button. Here, you can change the size of the edge that is rendered, as well as 
the color. The next button we are going to talk about is the 'Threads' button. Clicking this enables threads, which allows the 
renderer to do threaded processes. Basically, if you have a dual-core processor (Athlon X2, Intel Core2Duo, etc.) it will have 
one processor render part of the image at the same time that the other processor is rendering another part. This (generally) helps
reduce rendering time. Finally, the last button on this row is the 'Free Tex Images' button, which "Frees all images used by 
textures after each render".

The last buttons on this tab I don't know much about, so somebody else needs to write this.

Right next to the 3x3 box of buttons (bottom left in Output tab) there is a drop down box that normally says Render Window. If
you click this, three options come up. The first is the Render Window, where Blender renders the file in a separate window. 
The next is Image Editor, this renders the file in UV/Image Editor window. The last option is Full Screen, which renders the 
image Full Screen in the Image Editor.

Render

Now, let's move on to the render tab! The first thing you should notice is the VERY BIG button that says 'Render' on it. This 
button performs the same action as the F12 button. Below this is a drop-down box, allowing you to change between the Blender
Internal Render engine and YAFRAY. (For more on YAFRAY, see YAFRAY Render Options). Next to the 'Render' button are 
5 buttons: Shadow, Env Map, Pano, Ray, Radio. These are explained in detail below:

Shadow: Lights will cast shadows. If this is turned off, nothing will cast a shadow. To see this, add a plane below your 
default cube and render. Now turn this button off and see how there are no shadows.
EnvMap: Use the environment map.
Pano: This enables panoramic rendering. For more on panoramic rendering, see Panorama Settings
Ray: This enables Ray Tracing. Turn it off, and render the same images as I talked about in the description of the Shadow
button. "What!?" you say. "That did the same thing as turning off the shadows! What's the deal?" Well, ray tracing is 
used to calculate how light goes through objects like glass and stuff. It also has something to do with shadows.
Radio: This stands for Radiosity.

Moving on, the next button we come to is the 'OSA' button. For the use of this button, see OSA

To the right of the OSA button, are some percentages. These will set the renderer to render at the specified percent of the 
resolution that you have set. (We'll come to resolution later) For an experiment, press the '50%' button. As you can see, Blender
renders the image at 50% of the set resolution. This is an easy way to make a quick render.

Next on our tour, we come to two boxes labeled 'Xparts' and 'Yparts'. These buttons change the number of boxes that Blender 
will render in total. Play around with these to see how they change the number of small boxes in the render window when you 
render.
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Anim

The final tab we'll (briefly) cover is the Anim(Animation) tab. If you have made an animation, pressing the 'ANIM' button will 
render your animation. Pressing it right now will render a 250-frame movie with nothing moving. Because this is not an 
animation tutorial, we will not get into what this tab does as much as we do the other tabs. For the final tab, please go on to the 
next page.

Next Page: Output Format Options
Previous Page: Shadows

Output Format Options

Next Page: OSA
Previous Page: Render Settings

Output Format Basics

When you render a scene in Blender, by default there will open a small window showing your image. If you want to publish 
your picture, you may want to render it a bit bigger. To do this, you have to open the Scene context (F10) and locate the Format
tab (usually on the right).

You will see some settings there. Let's go through their meanings:

SizeX: This parameter sets the width of the image in pixels.
SizeY: This parameter sets the height of the image in pixels.
AspX, AspY: These parameters specify the aspect ratio of the pixels. By default, this is 100:100, because a pixel on a 
computer screen has equal width and height. These settings can be used for screens whose pixels don't have equal width 
and height. For example, on a PAL system one pixel's width/height ratio is 54:51, which you can select there easily. 
Notice that these parameters don't change the size of the image.

Don't forget, setting the number of pixels changes the resolution. Resolutions for your computer desktop are normally 
1024x768, but can be larger. This means that it is 1,024 pixels wide and 768 pixels tall. To make an image this size in Blender, 
change the SizeX to 1024 and the SizeY to 768.

If this does not come out correctly, then you should right click your desktop and click Properties, then go to Appearance. The 
highlighted numbers are X by Y.

Output formats

Blender has the ability to save in a wide variety of formats. To change the format, click the drop-down box halfway down the 
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format tab. Currently, Blender can save files in the following formats:

TIFF
OpenEXR
DPX
Cineon
Radiance HDR
Iris:
Iris + Zbuffer:
HamX: extremely compact but only for the "Play" option
Jpeg: default format. Lossy compression.
BMP: uncompressed.
PNG: open, lossles compression, alpha channel.
Targa Raw: uncompressed Targa.
Targa:

Single rendered images are not automatically saved to disk. Once Blender finishes rendering a scene (this can take some time), 
press F3 and the save dialog will be opened where you can specify a filename and location for the output. You can retrieve the 
last picture rendered by pressing F11.

Video:

AVI Codec: saves an AVI with a compression codec. Once selected a pop-up menu will appear giving options as to what 
codec you want.
AVI Jpeg: saves an AVI as Jpeg images. Compressed but lossy.
AVI Raw: saves an AVI with uncompressed frames.
QuickTime: saves a QuickTime MOV file. Once selected, a pop-up menu will appear giving various video codecs to 
choose from. Can also remain uncompressed.

See also

Blender 3D: Noob to Pro/Creating animated GIFs using Blender and Gimp
Blender 3D: Noob to Pro/Creating Ogg-Theora movies using Blender

Pre-set settings

Those buttons that you see on the right? Those are the pre-set image buttons. Each corresponds to a seperate pre-set setting. For
example, the 'HD' button will set the settings to be 1920x1080 pixels, with the output as a Targa image(.tga).

Next Page: OSA
Previous Page: Render Settings

OSA

Next Page: Looking All Around - Panorama Settings
Previous Page: Output Format Options

OSA stands for oversampling, also known as anti-aliasing. It prevents "jaggies" or aliasing as its called. This is when you have
a diagonal change of colour which results in rough edges. Remember drawing a diagonal line in Paint? To overcome this 
hinderance of square pixels a technique called anti-aliasing or oversampling is used. What it does is it blends the colours 
around the rough edge to create a smooth, but defined edge. One way of doing this is to create the image twice as large, then 
scaling it down - oversampling. Blender can do this for you if you select an OSA rate. Remember this will take much longer, 
but results in better renders, so use this for the final product, not while testing. In some cases the scene can seem blurred due to 
oversampled textures, try changing the OSA setting, or oversampling yourself.
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Here's a quick illustration of how OSA changes a render (look at the edges):

The image on the left has no OSA. The one on the right has 16x (the maximum amount allowed by Blender).

Next Page: Looking All Around - Panorama Settings
Previous Page: Output Format Options

Looking All Around - Panorama Settings

Next Page: Other Important Render Options
Previous Page: OSA

Panoramic Renderings

This Article is Out Of Date

This article is out of date, and the panoramic features mentioned do not work this way in recent blender versions. Panoramic 
features were changed somewhere between 2.37a and 2.42. More information, including how to actually use panorama, can be 
found in this thread in the forums: http://blenderartists.org/forum/showthread.php?p=797886

Building the Example Scene
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Ever wondered how that cool looking 360 degree panoramas that you see 
on some websites are made? Well, I don't know either, so someone else 
will have to tell about that. What I found out though is how to make 
Blender output a 360 degree panoramic image - quite probably this at least 
is the first step when making something like on those websites.

Now, let's try to progress like in a tutorial, as in the other pages of this 
Wikibook. So, fire up Blender, and look at the well known initial box 
scene. Or rather, change it somehow. Assuming you have read the book in 
order, it shouldn't be hard to get something like in the picture.

I placed the camera and the light both above the origin, deleted the cube, 
and added 8 cylinders, all around the origin. One way to do this is to place 
one cylinder, then duplicate and rotate it around the origin. For this to 
work, set the rotation center to the 3D-cursor (with the Pivot button), and 
position the 3D cursor at the origin (use SHIFT+S to make the 3D cursor 
snap to the grid).Place the first cylinder using GKEY and then holding 
CTRL while moving the mouse. Change to object mode, then use 
SHIFT+D to duplicate it. Next, press RKEY to rotate it, then hold CTRL
while rotating it by 45 degrees. Repeat the same for the remaining 
cylinders. Use G to move the light. Use NKEY to enter the camera values 
like shown, so it looks parallel to the ground.

Speaking of ground, lets also add a ground. I added another cylinder, below
the other ones, as shown. It's easy to add by switching to front view 
(NUM1), duplicating a cylinder (SHIFT+DKEY), and then moving it 
holding CTRL pressed again, so it snaps to the grid. To scale it, use the 
SKEY , but hit SHIFT+ZKEY to lock the z scaling, and hold CTRL
pressed while scaling in x and y direction so you can snap to the exact size 
you want.

Now, to have a complete scene, we need some colors. I made the ground 
cylinder green, the 8 example cylinders gray, and also added a noise normal
to the ground. This doesn't really matter here though, just needed some 
example scene for the 360° camera.

Something more interesting is the sky texture, because Blender's sky can be made to seamlessly wrap around with 360 degree. 
Belows is a screenshot of the sky settings I used. To get there, click on the Shading button, then select World.

To change the texture, click the textures button or press F6, then add a new texture with the small button with two arrows, and 
select the type (e.g. "Marble" or "Clouds") instead of "None" for the texture. Go back to the World pane, and enable the Real 
and Blend buttons. And don't forget to use nice colors, I used blue and white. Now it looks a bit like white clouds in a blue sky.

The example scene, see from above

The example camera, seen from the side

The complete scene with a ground cylinder
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[Maybe should add here more details? What is important so you don't get a seam at the 0 - 360 degree point? How do you map 
pre-made sky textures?]

And we are already done, this is the example scene. All that is left to do is to render it as a panorama.

Panoramic Rendering

Go to the render settings (F10), and click the Pano button. Change the Xparts value to 4. The value in Xparts will tell how 
many times the camera will 'turn' horizontally when rendering. The Yparts value would do the same vertically. Each part 
(Xparts or Yparts) will render the size of the whole image you set. To make things easier, make the output image size quadratic 
and set both X and Y Aspect to 100. E.g. make your image size 600x600, but not 800x600, otherwise the following will not 
work.

If you want a seemless 360 degree view, it is important to know how many 
degrees one single image spans. For example, if you know one image is 90 
degree, then you can set Xparts to 4, and the result will be a single panoramic 
picture, and with the right panorama viewer, you can spin around in it 
endlessly.

But, how do you make a single picture 90 degree? The angle a picture spans is
called field of view (FOV). And it is a property of the camera. To change it, 
select your camera, then click the edit button (or hit F9). Make sure you 
haven't set your camera to orthographic (the "Ortho" button), since FOV only 
exists with a normal camera.

Unfortunately, you can't directly enter the FOV in Blender's camera settings (as of version 2.37) - instead there is just a 
parameter called Lens. Type in 16 to get a FOV of 90 degree. Now hit F12 to render our test image.

If you want, you can also try it out with any other scene. Place the camera somewhere in the middle with a good view all 
around, set the camera's Lens to 16, and go into the render settings (F10). Set Xparts to 4, enable Pano, and render. You 
should get an image 4 times as wide as a normal image, and the left and right edges should fit together seemlessly. Also note 
that Blender doesn't know if it should apply the FOV as horizontal or vertical viewing angle, but we always want it to be the 
horizontal angle. Therefore just make the single images of the panorama quadratic, as mentioned above - then horizontal and 
vertical FOV is the same and Blender gets it right.

This is the resulting panoramic image:

One problem remains, the image will be quite distorted. This is because a 
FOV of 90 degree is too high. Let's try with 45 degree and 8 XParts 
instead. As you will have noticed when playing around with the Lens 
parameter before, setting Lens to 8 instead of 16 will not achieve this, it 
will make the FOV even bigger. Setting it to 32 looks better, but definitely 
is not 45 degree. The picture to the right explains how FOV and Lens relate
to each other:

Panorama with 4 parts.
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The camera is at the bottom, the red angle is our desired FOV, and the length of the green line is 
what the Lens parameter represents in Blender. Therefore, the formula to calulcate Lens when we 
know FOV:

Lens = 16 / tan(FOV / 2)

For a FOV of 45 degree, we therefore get a Lens of 38.627. Now, write that into the Lens field in 
the camera settings, and render with 8 XParts. This time it will render an output image which is 8 
times as wide as a normal output image, and again it will be a seamless 360 degree all around 
panorama of your scene. And this time with less distortion. With the above formula, you can now 
use any number of XParts you want - just divide 360 by the number of parts, and calulate the Lens 
parameter for the resulting FOV. Note that you also need to take the Aspect settings into account, 
unless you set it to 100 and create a quadratic output, as we did.

Some Lens settings:

4 parts: 16
8 parts: 38.627
16 parts: 80.437

The output with 8 parts can be seen below.

As always, feel free to modify this page in any way you want or add feedback to the Talk page.
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Other Important Render Options
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Rendering by Parts (Bucket Rendering)

Images can be rendered in pieces or layers rather than all at one time. Your computer will only need to compute smaller bits of 
information thus using less memory. By changing the Xpart and Ypart values (up to 8 each since Blender can't support more 
than 64 [8x8] parts) in the Render panel of the Scene context(F10,) you can divide your image into an invisible grid. The pieces
will layer one at a time until they are whole.

Edge Renderings

Blender has an option of adding a border-an edge to objects (like in cartoons). To do that you need to go to the render buttons 
(F10) and then, under "output" change the edge setting: set the "Eint" to a value of about 100 and check the "edge" icon to 
enable edge rendering. This would give you edge line at the edge of each polygon. To prevent it from applying on all polygons 
the same way change to "unified render" under the format tab. Then, in the edge settings change the "antishift" value, it will 
decrease itself from the fint value when the line is between identical materials. By also checking the "all" icon you tell the 
render to apply the edge rendering on transparent materials as well.

Note: User Terrywallwork - The edge bordering feature in Blender 2.43 only seems to work when Blender Internal renderer is 
used, when Yafray is used, no edge is show even if the options is clicked. I'm not sure if there is a way round this or not.

The Lens parameter of 
the Blender camera.

Panorama with 8 parts.
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Multi Thread Rendering

Blender has the option to render with 'Multiple threads' meaning it can render 2 parts at once at the same speed as rendering 
one. This is done by sending 2 Render parts to the cpu to process at the same time,if your CPU can handle it. The Option is 
found in render buttons (F10) as the button "Threads" under the Backbuf filepath and button.
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Yafray Render Options
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YafRay (Yet Another Free Raytracer) is an open-source alternative rendering engine supported by Blender.

The YafRay render settings are normally hidden. To show them, switch from the Blender Internal rendering engine to the 
Yafray rendering engine.

Go to the Scene Panel (Press F10)
Click the Render Buttons button
In the render tab, under the big Render button, click the Blender Internal button and select YafRay.

Now the YafRay and YafRay GI tabs appear.

Getting Started with Yafray

Firstly, I would like to tell that Yafray renders 2-3 times faster and nicer (includes Global Illumination, Caustics and...) than the 
normal internal built in Renderer in Blender . So it would just be worth it to download and install it.

On Windows just download the .zip file and unzip it. You get the .exe file. Run it and follow default instructions. Latest 
version is 0.0.9 as of september 2006. Now change the Environment variable by adding C:\Program Files\YafRay to your 
PATH or whichever folder you installed yafray.exe Windows 95/98/ME will need to restart where as WinXP users dont. 
Remember yafray doesnt have a GUI and is a commmand line tool. Anyway you never need a GUI to run yafray as it runs 
nicely inside Blender as it is integrated into it. Go to the Command line and type yafray and press return. Now you have two 
paths

1) If there was a error regarding MSVCR71.dll, then download this file from the Web and place it in the c:\windows\system32 
directory

2) Switch from the Blender Internal rendering engine to the Yafray rendering engine as explained and press F12 to Render. 
Wow, You should have noticed the lightening speed of Yafray.

YafRay tab

XML button: if pressed blender will export an xml file that describes the scene and will pass it to YafRay. If not pressed 
blender will render with the YafRay plugin. When using the plugin interface, the render in progress will update 
continuously in Blender's render window. This gives much faster feedback. It even shows the distribution of the samples 
taken by the path light when rendering with cached pathlight. YafRay divides the image into blocks and renders them in a
random sequence.

YafRay GI (Global Illumination) tab
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method
Skydome
Full

quality

See also

YafRay Official Homepage (http://www.yafray.org/) 
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Animation

Basic Animation
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Note About Blender 3D: Noob to Pro/Basic Animation

I created this little note section to both warn learning users, and to give information to those who would make this wikibook 
better. The animation section in this book leaves a lot to be desired. It needs to go slower, and be more thorough. It is not 
finished (hence the accurately drawn "status images"). Here are a few things that need to be mentioned:

How to manipulate keys after they are drawn
How to delete keys (both IPO and Lattice)
What a key is

I recommend that new users, those who are going through this tutorial to learn blender, read the animation section in the 
blender documentation first. It is written for an older blender version, but it is more informative than this tutorial, and most of 
the information in there is still accurate. Here is a link: http://www.blender.org/documentation/htmlI/p6390.html

Basic Animation Begin

Animating, in principle, isn't that hard. These steps show you how to make a simple keyframe animation:

It is a good idea to switch into the animation screen using the screen selection drop-down on the main menu (change it to 
SCR:1-Animation).

1.

Go to the starting frame, using the arrow keys on your keyboard (Shift+Left Arrow goes to Start Frame, Shift+Right 
Arrow goes to End Frame, the Up and Down arrows Skip 10 Frames, the Right and Left arrows skip 1 Frame)

2.

Go into the correct mode. To animate solid objects, go into Object Mode. To animate bones, go into Pose Mode.3.
Place the object or bone at the desired starting location and/or rotation.4.
Press the IKEY and you will see a menu of the different properties which you may animate. Choose the most appropriate
one, based on the properties you wish to change in the next keyframe. For example, if you wish to change the location, 
rotation and size of the object, select LocRotSize. You have now made the first keyframe, which is a frame of animation 

5.
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which you have personally set up.
Now go to the frame of the next keyframe you wish to define, and put everything in the place you want for that frame. 
Remember, if you have a frame rate setting of 25 frames per second (fps) then if you want to make the next keyframe one
second later in the animation, you need to go to frame 25 to make the keyframe. Then press the IKEY again, and select 
the correct option again, depending on the changes you've made. (All in-between frames are automatically made to 
interpolate between the two neighboring keyframes).

6.

Repeat the previous step for each keyframe of the animation.7.
If you want more control over the transition between the keyframes, use the IPO-window (if you followed step 1, it 
should already be open on the right of the screen). Select the object you have keyframed and the IPO-window will 
display its animation curves (one curve for each of the properties you selected). You can select and edit the curves using 
the normal Blender controls. Use the curve menu for more options, such as making the curves actually curve instead of 
being straight lines.

8.

For more information, see the Blender userguide (http://download.blender.org/documentation/htmlI/) 

Next Page: Basic Animation/ScreenLayout
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Lattice Deformer

Next Page: Basic_Animation/Bounce
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Introduction to Lattices

for Blender 2.4+

For the purpose of this tutorial, it is assumed readers will already be familiar with the Blender interface, adding objects to a 
scene, object editing and basic animation workflows.

What is a Lattice?

A Lattice is essentially a simple container that can be used to deform and manipulate a more complex mesh in a non-destructive
manner (ie. A lattice can be used to seriously deform a mesh then, if the lattice is later removed, the mesh can automatically 
return to its original shape).

How to add and use a Lattice

A Lattice is added to the scene in the same way other objects are added. Either:

Shift-A over the 3D window and choose Lattice from the pop-up menu, or1.
Press Spacebar over the 3D window and choose Lattice from the pop-up menu, or2.
LMB ADD from the 3D window menu and choose Lattice from the drop-down menu3.
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The default Lattice looks just like a cube when first added except that it is just one Blender Unit (BU) wide whereas a mesh 
cube is 2 BU wide. When the Lattice is added, the window remains in Object Mode and the Lattice can be moved, resized and 
rotated like any other Blender Object.

On its own, a Lattice serves no purpose whatsoever since it can't be seen in a rendered image. Its only use is to manipulate 
another object and so, to be useful, we need to associate another object with it. The current method for doing this is by applying
a "Lattice Modifier" to a Blender object.

The basic workflow is:

Add a mesh (cube, cylinder, cone, sphere, etc)
Add a Lattice
Select the mesh
Press F9 and go to Modifiers Panel. Press Add Modifier > Lattice
In the Ob: Panel, enter the name of the Lattice (The default name is Lattice, Lattice.001, Lattice.002, etc - or you can 
give it a useful name that you'll remember later)

Adding a Lattice Modifier to an object

Now, we can change the Lattice in Edit Mode and any changes we make to it will affect the mesh.

NOTE: Applying the Modifier Correctly

When adding the modifier to your object, you must enter the exact same name as your lattice. The default is Lattice with a 
capital "L" but if you've changed it or have more than one Lattice, then you will need to enter the new name. When you enter a 
valid Lattice name, the name stays visible in the Ob: box. If your entry disappears then you've entered the name incorrectly.

One simple way to get the right name is to select the Lattice, go to F9, Link and Materials panel and where it says Ob:Lattice or
Ob:Lattice.001 etc, move the mouse over this field and press Ctrl-C (don't click on it, just hover over it). This copies the 
Lattice name. Then select your object, go to the Lattice Modifier panel, hover the mouse over the Ob: field and press Ctrl-V to 
paste the name in. Now it should stay there and your Lattice should work in Edit Mode.

Basic Exercise:

Start with a new Blender scene, delete the default cube and add a UVsphere (Spacebar>Add>Mesh>UVsphere). Accept 
the default 32 Segments and Rings. You could use any of the mesh shapes but because the sphere is heavily subdivided 
(made up of lots of edges and faces) you will get a better idea of what the Lattice is doing.

1.

Tab back into Object Mode then add a Lattice (remember how?). It is generally wise to resize the Lattice so that it 
surrounds the mesh it will be deforming. So, press SKEY and enlarge the lattice to 2 BU wide.

2.

Select (RMB) the Sphere and add a Lattice Modifier to it (you remember how to do that too don't you?). Make sure that 
you type the exact Lattice name correctly into the box. Nothing appears to happen but that's fine.

3.
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Now select your Lattice, TAB into Edit Mode, select just one control point (look like a vertices) on the Lattice and move 
it around. You will see the sphere mesh stretching and squashing relative to that control point. Move each Lattice control 
point one at a time and see just how far you can deform the mesh. Zoom in your 3D window if you need a closer look.

4.

The control points of the Lattice can be moved, scaled and rotated in the usual ways. Try selecting a few of all the control
points and scaling them (SKEY) or Rotating them (RKEY) and watch the mesh follow along.

5.

Now, exit Edit Mode (TAB) and select the sphere in Object Mode. Go to the modifiers panel and press the big "X" 
button to remove the modifier. Despite all that deforming, the sphere immediately returns to its original size and shape. 
Nothing was really changed in the sphere's mesh data. Immediately re-apply the modifier as before (don't cheat by using 
"undo") and see the Lattice immediately apply its own deformation to the sphere again.

6.

That was easy wasn't it? But wait, there's more!

Getting more involved with Lattice

The default Lattice is two control points high, two wide and two deep, ie, it is two control points wide in each direction (these 
are referred to as the U, V and W directions). However, we can change the number of control points in one, two or all 
directions. This is done by selecting the Lattice, going to the Lattice Panel (F9) and changing the values in the U, V & W 
buttons. If you decrease one figure to a value of 1, the Lattice will become two-dimensional (planar). Decreasing two values to 
1 will change the Lattice to a line (one dimension). This can be useful, especially if the remaining value is increased, but is not 
the most common usage of Lattice.

UVW settings for Lattice

NOTE: The "Make Regular" button will set the UVW control points of an unscaled Lattice to be exactly one Blender Unit 
apart in each direction. The "Outside" button effectively removes all the internal control points which are added when the 
UVW settings are higher than 2.

In most situations you will want to increase some or all the values as this gives you more control over complex deformations, 
much like a subdivided mesh. How much you increase the UVW directions depends entirely on how much detailed control you 
need over deformations. As you've already seen basic squash, stretch, shear and simple deforms can easily be achieved with the 
default 2,2,2 Lattice but by increasing the UVW values a little, a whole new range of deform possibilities becomes available.

Three Lattices with different UVW settings
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One thing to understand, however, is that a Lattice cannot bend the individual edges of a mesh (the lines connecting any two 
vertices) so the mesh must contain enough edges in order to apply complex lattice deformations to it. These edges must be 
genuine edges and not the virtual edges created by a subsurf modifier. Edges can be added to a mesh using a variety of tools 
including subdivide, knife and loop cuts.

A simple subdivided cube after a complex lattice deformation

Intermediate Exercise

For this exercise, start over with a new scene and repeat Steps 1 - 3 in the Basic Exercise above. Don't go into Edit Mode yet.

In Object Mode, select the Lattice then press F9 and go to the Lattice Panel. Increase all the UVW values to 4. You will 
immediately see the change displayed in the 3D window.

Tab into Edit Mode and play with the control points again. The first thing you might notice is that the corner control 
points have less influence now than before. This is because the effect is proportional to the distance of each point from 
the mesh. Move some points in the middle of a side face and you'll see the effect is significantly greater.

Try selecting groups of control points and pulling them away from the Lattice to stretch lumps and bumps out from the 
mesh. If you are familiar with the proportional edit tool, try that too - it works on Lattices just like it does on meshes.

Try doing the same exercise but increasing values in only the W direction. (U divides in the X direction, V divides the Y 
direction and W divides the Z direction). So, set the UVW to 2,2,4 and play with the control points again in Edit Mode. Select 
the two rows of control points around the centre of the Lattice and scale them up (SKEY) then Scale them down along Z-axis 
only (Skey>ZKey). Try other transforms constrained on different axes for interesting, controlled results.

There are three different options for how the Lattice Modifier affects each UVW direction. These are Linear, Cardinal and 
B-Spline. All I can say is that B-Spline is the default and to find out what the difference is, press the buttons and see.

Examples
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Some examples of a Lattice deforming a standard UV Sphere mesh (not smoothed)

Making it stick

To keep the mesh deformed permanently, you can select it and press the "APPLY" button in the Lattice Modifier panel. This 
"bakes" the mesh in the deformed position and disconnects it from the Lattice. The Lattice can then be deleted without the 
mesh returning to its original shape. This is useful if you are using the Lattice as a modelling tool rather than an animating tool.

Also, instead of deleting the Lattice, you can use it to immediately modify another mesh. Simply move the Lattice over the new
mesh in Object Mode then apply the Lattice Modifier to the new mesh. If the Lattice is already in a deformed state, the mesh 
will immediately be deformed too. Press Apply again to "bake" that mesh and keep re-using the already deformed Lattice on as 
many other meshes as you wish for matching results.

Animating a Lattice Modifier

Lattice animation uses a workflow almost identical to the RVK (Relative Vertex Key) workflow from Blender 2.37 and earlier. 
You don't need to know this but some people might find the information useful.

With your Lattice Modifer already added to your object, select the Lattice and press I-Key to tell Blender you wish to animate 
the Lattice. Choose "Lattice" from the pop-up list. This sets the basis key (undeformed state) for the Lattice.

Adding the basis key
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In the Editing panel (F9), press the "Relative" button.

Set the keys to "Relative"

NOTE: The Slurph setting determines the delay, in frames, by which the deformation will respond to keys.

To set your first deform key, press I-Key again then enter Edit Mode. Deform the Lattice by scaling or moving control points 
then Tab back into Object Mode. If you open an Action Window now, you will see your first key, "Key 1", added to the list. 
If you press the small arrow at the the top of the list, it will display the slider for that key.

Lattice key sliders in the Action Window

To add more Lattice keys, for a variety of deform shapes, repeat the process: I-Key, Tab to Edit Mode, move control points, 
Tab back to Object Mode. Each time you exit edit mode, a new key will be added to the list in the Action Window.

Animating the Lattice uses the same process as animating Shape Keys for meshes.

If you want the object to begin undeformed, then set each key slider to zero on the first frame of the animation. Move through 
the frames, setting the sliders as you go to deform the Lattice as desired. You will often find you'll need to set a key before and 
after each deform key in order to control the rate at which deformations take place in the animation.

Setting keys in an animation
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Let the fun begin!

Now you have your object safely locked away inside your Lattice, you can still animate the object itself, inside the Lattice!

Why would I animate the object too?

Take the case of the classic cartoon eyeball which is taller than it is wide. If you just stretched the sphere object itself, instead 
of using a Lattice to deform it, then you couldn't properly rotate the eyeballs to look up and down because the whole 
"egg-shaped" eyeball would rotate and end up lying on its front or back. The eyes would literally pop-out of the head.

Cartoon eyes: The stretched spheres don't rotate properly.

If, however, you use a Lattice to deform the basic sphere to make it into a tall "egg" shape, you can still select the eyeball itself 
and animate it within the Lattice. Now when you rotate the eyeball, it will look up and down but still maintain its deformed 
shape within the head.

Cartoon eyes: Spheres deformed with Lattice can still be rotated with good results.

Next Page: Basic_Animation/Bounce
Previous Page: Basic_Animation/ScreenLayout

Bouncing Ball with Lattice
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How to make a ball bounce convincingly!

This tutorial assumes basic Blender awareness and some knowledge of using Blender Lattices as well as keyframes basics 
regarding the Blender Panels. Knowledge of IPO curves will prove useful later as we progress to more advanced techniques.

How hard can it be to move a ball?

It would be easy to just put a sphere on the screen and animate it to move up and down but in all honesty, it would not look like
a bouncing ball. It would not be convincing in any way.

To be believable, the ball must use some of the most fundamental principles of good animation. In particular, the ball must 
squash and stretch and change speed as it falls, hits the floor, bounces and rises ready to fall again. With a little effort we can 
make that boring sphere look alive!

Why use a lattice?

It is possible to make a simple bouncing ball animation without using a Lattice object but with the Lattice we can do more than 
just bounce the ball. For example, once we have a ball that bounces how we'd like it, we can later add rotation to the ball so it 
spins through the air and bounces then, as the bounces decrease, the ball can roll to a halt. Doing this without lattice would be a
far more complex exercise as a rotating squashed and stretched sphere would look like it was wobbling in space (like having the 
flat part of a flat tyre spin around the tyre instead of staying on the bottom, even while the wheel is turning) .

Let's begin then

To begin, add a UVSphere in Top View (NUM7). It is important to add the objects in top view to keep their Z-Axis aligned 
upwards. Set Smooth and Sub-surf on the sphere if desired. Tab back into Object Mode then immediately add a Lattice. Resize
(SKEY) it so it closely surrounds the sphere. Make the edges of the lattice align with the circumference of the sphere as this 
will make animation easier.

(By default the Lattice Object Name is "Lattice". It is good to give all your objects unique and sensible names, especially if you
are planning a complex scene. So you might call the Sphere "Red_Ball" and the Lattice "Red_Ball_Latt" or something similar 
for easy reference and recognition later.)
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Top view of UV-Sphere inside selected Lattice

Make the lattice deform the sphere

Prior to Blender 2.4, objects were parented to Lattices with a Lattice Deform option. In version 2.4+ you can select the object 
(the sphere) and apply a Lattice Modifier to it (Ob: Lattice). However, if you use this new method then the ball will not move 
where the Lattice moves and will not squash when the Lattice squashes and we want it to do both of these things.

Luckily you can still use the good old Parent option then use the Modifier palette to make the Lattice Deform "Real" . So 
select the sphere THEN select the Lattice then CTRL-P to make parent and choose the "Lattice Deform" option. If you now 
select just the sphere, press F9 and look in the Modifiers palette, you'll see a listing for "Lattice parent deform" with a button 
for "Make Real". You can either ignore this button or press it. It really won't matter for now. If we wanted to do some weird 
things to our ball, like kicking it or deforming it in other complicated ways, then we would have to use the "real" Lattice 
modifer option.

So, this may not be the purist approach to using a Lattice but it is a convenient way to achieve the results we're after. Basically, 
it works and is reasonably intuitive.

Lattice Modifier screen using parenting option.

If you press "Make Real" you enable the full Lattice Modifier

You can easily check if the Lattice is working the way we want it to by selecting the Lattice and resizing, moving or rotating it. 
The ball should do everything the Lattice does. I don't wish this to be a full lesson in Lattices so if you don't understand any 
of the above, or you're certain your Lattice is not working as it should, then please learn a bit about lattices before proceeding.

Time to animate!

For our basic animation, we'll use just 23 frames starting with the ball high then falling, squashing, bouncing and ending up 
back where it started. When this is played back in the 3D window, it will loop and we'll see the ball bounce forever in one 
place.

This part is easier done in "SCR:1 - Animation" Viewport configuration. It is also useful to have multiple orthographic views 
open in the viewport by right clicking on the resize viewport arrow and choosing "split area" then making a top view, side, etc...

Go to Front View (Num1).

Press F10 and set your start (Sta) frame to Frame 1 and your end frame to Frame 23. Then make sure you're on Frame 1
(Shift+Left Arrow) to start animating. Note that we are animating the Lattice, not the ball. Everything we do to the lattice will 
directly affect the ball too.
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Select the Lattice (NOT the ball) then do the following on the corresponding frames:

FRAME 1: Press IKEY and set a key for LocRotSize - the ball's start position (high).
FRAME 11: Move the Lattice to ground level and key LocRotSize again (keep the fall distance small for now).
FRAME 13: Leave Lattice in same position as frame 11 and key LocRotSize again.
FRAME 23: Move Lattice back to start position (use Num (N) Panel if you need to)and key LocRotSize again.

These four frames give a basic up and down animation with a pause at the bottom. We can add squash on Frame 12 to finish 
off.

FRAME 12: Place the cursor at the base of the Lattice then set the Rotation/Scaling Pivot to "3D Cursor"  Scale the 
Lattice down along the Z-Axis SKEY-ZKEY and see the ball squash. Key LocRotSize again.

When you have set all five keys, you can cycle through the frames and you should see the following result on the Key frames 
we just set. 

Screenshots of the 3D window, front view, on each of our five key frames.

If you press Alt-A now in the 3D window, you should see the ball bounce. Even though the squash happens on just one frame, 
it still reads properly in our minds and is a vast improvement over an animation with no squash at all. (Press RMB or ESC to 
stop the animation playback).

If you have a camera and lighting suitably set up you could render the animation out and use Blender's "PLAY" button to loop 
the rendered animation. See the bottom of the page for an OpenGL render made from the steps above. Add material to the ball 
and a ground plane for a more interesting result.

Looking at the IPO Curves

If you want the ball to bounce three times then you could repeat the above instructions three times over - if you have the 
patience - but Blender has a better, easier way.

Select the Lattice then open up an IPO window and zoom into the group of keys. If you select LocZ and SizeZ from the channel
list on the right, you should see something like this (I've added labels to the screenshot):
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Note the the IPO Type here is "Object". Purists may be disturbed or perplexed by this but if you remember, we're not really 
using our Lattice in the purist, Lattice Modifier form. Don't worry about it though. It works.

IPO curve for Lattice, showing LocZ and SizeZ channels.

This shows the relative position on the Z-Axis and size in the Z-Axis of the Lattice. You can see that the Size remains constant 
until frame 11, then reduces, then goes back and remains constant until frame 23. Similarly, the LocZ curve shows how the ball 
starts high, falls then stops before rising again. The rounded bottom of the LocZ curve occurs because the IPO curve maps the 
centre point of the Lattice and when we squash it, the centre point lowers slightly.

Of special interest is that by default, Blender uses Bezier curves for IPOs and this gives us rounded tops on the curve. This 
means the ball starts moving slowly downward then moves faster until the reaches the bottom. Also, as it nears the top, it slows 
down again. This is good because this is exactly what happens in reality when a ball rises and falls (It could be better - but it's a
good start).

While in the IPO window, select both curves then press KKEY and you'll see each key frame indicated by a vertical line.

IPO window set to show key frames
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Press AKEY to select all key frames then duplicate (Shift-D) them. The curves will seem to deform 
but when you drag the frames to the right, they will sort themselves out. Position them so the "first" 
frame is at Frame 24 and the new end frame is now Frame 46. Reset the End Frame in the Scene 
(F10) window then watch the animation again. It's not bad. You can repeat this process for more 
bounces. (To have it bounce forever throughout a long animation, ignore the above procedure and 
just set the "Extend Mode" to "Cyclic" in the Curve menu. You'll have to adjust the curve a little on 
the first and last frame but you only do it once and Blender repeats the change for all other cycles.)

It's not bad for a start but there's a lot more to do to this ball before applying for that animation job.

So what next?

In real life and in a typical cartoon, balls don't just bounce forever in one spot. They move along and
slowly lose their bounce before rolling to a halt. And they have more character than our bouncing 
ball.

Things to consider next:

Perfecting the squash - maintaining volume
Adding stretch
Look at acceleration and deceleration
Rotate the ball as it bounces
Reduce the bounce height over time
Move the ball around as it bounces

See this ANIMATION LINK (http://members.westnet.com.au/andydolphin/blender/bounce.avi) (580kb, AVI-DivX) for an 
idea of how you can achieve interesting results with just a little more effort.

Links

Principles of bouncing ball animation: http://www.idleworm.com/how/anm/01b/bball.shtml

Next Page: Particle Systems
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Creating Basic Water animation

Water and Other Fluids

Water is without a doubt one of the most important compound to our lives (second to air) and is therefore incredibly important 
in quite a few blender animations. Wouldn't it be great if we could get an accurate physical representation of this liquid in 
blender? We can, using a tool called Fluid Simulation. This tool looks unnervingly complex at first glace, but this tutorial 
should clear it up for you.

The Domain

One can imagine how much time it would take Blender3D to think about everything in the infinite 3d world in terms of fluid 
objects and deflection, so we obviously need to cut down on that size. Create a fairly large cube. This will eventually be set as 
the volume in which all of the fluid simulation occurs. Don't make it too large, but not too small either. With this cube selected,
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press "f7" to get to the physics screen. Find the tab that says "Fluid Simulation", and click "Enable". of the six new buttons that 
appear, click "Domain". All the fluid physics will be calculated inside this cube.

The Fluid

As a basic start up for your experiments with fluid simulation, I am going to take you through a small demo in which we drop 
an object into a pool of water, creating a splash. To do this, we need a fluid object and an obstacle object. For the fluid, create 
another cube, scaled down to cover the bottom of your domain. Enable this object in fluid simulation also and select "fluid". 
When we start to bake the fluids, this will be set up as your liquid.

The Obstacle

Now, create the object you want to drop into the water. Give it an IPO to drop into the water, and enable it as a--you guessed 
it--obstacle.

Baking Fluids

Now we get to see what it all looks like. Before we do anything too fancy, however, go to the render buttons (F10) and specify 
the total number of frames to simulate the fluid in. Most projects don't need the whole 250 frames. Select the domain object, 
and find the big button that says "BAKE" under its fluid simulation panel. Press it, click the "continue" part of what comes up, 
and watch your masterpiece evolve. Be patient, blender has to render this simulation just like it would render the final product. 
The frame count of this rendering replaces the bar at the top of the screen where it says, "www.blender.org" with the blender 
logo. If at any time you feel that you want to abort this process, press "Esc".

Other Fluid Objects

There are two other incredibly useful types of fluid objects--"inflow" and "outflow". The both of these do exactly what they 
sound like. Inflow objects pour more fluid into the scene, and outflow objects drain it away.

Site Under Construction

More to come, so check back in a few days!

Particles

Particle Systems

Next Page: Making Fire
Previous Page: Basic Animation/Bounce

Particle Systems are used to simulate large amounts of small moving objects, creating phenomena of higher order like fire, dust,
clouds, smoke, or - using a trick - fur, grass and other strand based objects. Due to the nature of particle systems, that is, the 
large amount of objects, the user interaction is limited to controlling global parameters, like direction of particle movement, 
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applied forces, obstacle definition, randomness, particle life and so on, but doesn't allow access to single particles. Though it is 
possible in other software packages (and useful in certain situations), Blender doesn't provide methods to control single 
particles. The amount of control is limited to statistic values, and the resulting effect can only be controlled by those.

For the most basic particle system in Blender you need one Mesh Object - the emitter. Emitters must be mesh objects and can 
emit particles from their vertices' position, and also from faces. Any Mesh Object is changed into an emitter via the Object 
panel->soft bodies (accessible with the F7 key), by clicking "NEW" in the Particles Effect Effect Tab. Once activated, the 
object itself becomes invisible to the renderer (unless the "mesh" button is pressed), and only its particles are visible. By 
default, the Material renders as type Halo rather than as a solid object. To see the particles moving, crank up the "Norm" value 
and hit "ALT+A" in a 3D viewport.

The direction of emmitance is controlled by a couple of values:

Norm: a value that takes into consideration the vertex/face normal and sends particles in this direction (if the value is 
greater than zero)
X, Y, Z: Those values can give particles speed and direction along the objects local/global axes. again, values greater 
than zero are required. Can be mixed with Norm.
External Forces: particles can be further affected by simulated forces like wind and gravity. Their values can be positive 
or negative.

Next Page: Making Fire
Previous Page: Basic Animation/Bounce

Making Fire

Next Page: Furry
Previous Page: Particle Systems

Using Blender's Particle System to Create Simple Smoke and Fire

(2.41)

The simplest way to think about the particle system is that any mesh object can be made to emit particles. By default, the 
particles are emitted from the object's vertices in an invisible ray.

You can specify the colour and transparency of the particles, the speed and direction in which they travel, and their size and 
range of travel. These values are particle "attributes". By combining different attributes, you can make particles look like 
bullets, Jedi lightsabers, smoke plumes, or the flames of a fire.

The following tutorial is not the only way you can create such effects, and expert blender users can probably do it much more 
efficiently and economically. It is a simple effect, intended to let you learn some of the features of basic particle animation.

Some screenshots would be helpfull for this tutorial. Add if you can

What You Need to Know before You Start
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In order to complete this tutorial, you must...

Understand how the Blender 3D interface works so that you can select objects and manipulate them in 3d space.
Know how to select options and change numeric values.
Be able to create and illuminate a simple mesh with lights.
Be able to adjust the camera.
Know how to configure the render and animation settings.

Setting Up the Workspace

Start from the default blender configuration and set up your view as a 2-panel display of the main 3D view window, and a 
smaller panel underneath it for the buttons window.

Create a mesh of a 3-division icosphere in the center of the 3d window. This icosphere will be our first "particle emitter".1.
Add a couple of area lamps at very low energy (about 0.075). Arrange the lamps on either side of the icosphere.2.
Press the F10 key to display the render buttons window.3.
Set up the render options to give you a quick, low-resolution render as follows:

set OSA, SHADOW, ENV MAP, and RAY off (not highlighted)1.
set image size to 50%2.

4.

Now, select the icosphere with RMB. Press F5 to bring up the material buttons. Beginning with Version 2.42, the Halo 
selection is on the Links and Pipeline tab. Under Links and Pipeline, Link to Object, click "Add New". Under Links and 
Pipeline, Render Pipeline, click "Halo".

5.

Press the F12 key to make a quick render, proving that you can see your icosphere centered in the view. If not, adjust the 
camera direction so that it points right at the icosphere as follows:

In the view window, press KP1 to toggle to front view.1.
In the view window, click on the camera to highlight and select it.2.
In the view window, press Alt + R to reset camera rotation.3.
In the view window, press N to edit the camera properties.4.
Set LocX and LocY to 0 so the camera is centered above the icosphere.5.
You can also set the distance from our icosphere with LocZ. a value of 15 or above (depending on the size of your 
icosphere) should be a good starting point.

6.

Press KP0 to return to camera view mode and press F12 to repeat the quick render. The icosphere should now be 
dead centre in the image.

7.

6.

(Note - you can also use the rotate widget to point the camera, but I'll leave that for a different tutorial).

(Beginner note: I had YaFray set as my Render Engine and could not see it. Switching back to Blender Internal allowed me to 
see it again.)

You should now have an icosphere with halo effects at each vertex that looks like this:
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Making a Smoke Plume

Smoke is easiest to model, and learning it first will give you some insight into the particle system. Begin by making a simple 
particle emission that you can see in the view window as follows:

Simple Particle Emission

RMB on the icosphere to select it1.
Press F7 to display Object buttons2.
Click the "Physics" Tab and in the second pane labeled "particles" hit "NEW"3.
The Particles and Particle Motion tabs are displayed (** It is possible to split the panels so that you can see both at 
once. LMB on either the Particle or Particle Motion label and drag to the side. The panels will separate. ** This is an 
optional step and not necessary to complete the tutorial)

4.

Before going further, Press the F12 key to make a quick render of the current state of the object. What you should see at this 
point is nothing, or a small white sphere. Your icosphere appears to have vanished, or gotten smaller. This is because you have 
now declared all its vertices to be nothing more than particle emitters. Also, the particles have no visible attributes at this point, 
so there is nothing for the renderer to see. (NOTE: Using Version 2.42, following these instructions produces a small halo 
object at the center of the sphere)

With the icosphere selected, make the following two changes to the particle system:

LMB on the Particles tab1.
Click on the Static button.2.
Click on the "Particle motion" tab.3.
Change the value of Norm from 0.000 to 0.100 (Hint: click ten times on the right arrow symbol in the box).4.

Notice that the view window now shows a stream of particles (You MUST be in OBJECT MODE to see particles) jetting out 
from every vertex in the icosphere, making it look like a star. Use MMB to rotate the view so that you can appreciate the 
symmetry of the particle stream. Press KP 1 to return to front view, or KP 7 to return to top view.

Press F12 to make a quick render of the changed object (see image).
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You should see something that looks like a white explosion.
You may have to reposition the camera to see the entire 
thing. Each particle is rendered as a glowing ball, but the 
particles are fairly large at this point, and you cannot see 
them as individual particles.

Use the following procedure to make the particles smaller. 
At this time, you will also give them a color and some 
transparency to make them look a little more like puffs of 
smoke.

Smoke Particle Material

In the buttons window, press F5 to display the 
shading window.

1.

Click on the material buttons icon (red globe) to 
display the material.

2.

Change the name of the material to MA:smoke3.

The default colour is light grey, which looks a litte bright for smoke. We'll adjust some of the particle attributes next:

Smoke Particle Attributes

Click on the Shaders tab to display the shaders panel.1.
Set the value of Hard to 152.
Set the Halo size to 0.3003.
In the Material tab, set the value of A (Alpha) to 0.80.4.
In the Material tab, set the RGB color to 0.56, 0.55, and 0.50 respectively.5.

The preview sample might now look as if it has vanished. However, press F12 for a quick render and you will see that the 
former white explosion has now become a star of smoke puffs. This pattern is still too organized and regular to look much like 
smoke, but you are getting there (see image to right).

To model the smoke, press F7 to display the Object buttons 
in the buttons window again. When you first set up the 
smoke model, you set the particle emission as "Static". 
However, you want your smoke to build and to move in the 
final model, so the next step is to randomize the particles 
and make them move like drifting smoke.

First, let's look at the default animation of the smoke 
particles:

Click on the Static button. Notice that the star of 
particles vanishes, and the mesh is now drawn only 
as vertices - no polygons.

1.

Ensure that the icosphere object is still selected 
(highlighted pink).

2.

Pres KP0 to go to camera view.3.
Put the cursor In the 3D View window and press 
Alt-A. Notice that each vertex now emits particles in 
the same star pattern.

4.

Before you proceed, take a quick look at a rendering of the animation as follows:

In the buttons window, Press F10 to display the Scene buttons.1.
In the Format panel, click on the PC button.2.
In the Format panel, choose AVI JPEG as the file format.3.
In the Render panel, set the image size to 25% (small, for a fast render).4.
In the Anim panel, set the value of End to 100, to create a 100-frame animation lasting about four seconds.5.
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In the Output panel, set the filename to /tmp/smoketest, or any other save location that you prefer.6.
Press the Anim button to begin rendering.7.
When all 100 frames are rendered, press the Play button to review the animation.8.

What you should see is a cloud of smoke puffs starting from the location of the icosphere (which is invisible) and radiating 
outwards. it looks a little like an explosion of smoke, but is still too organized and regular to appear as smoke.

Now that you have invested some time in creating the animation, it might be worth saving the .blend file. After you have saved 
the file as smoke1, you can experiment with making the particles look more like smoke. Go back to the section titled:

Smoke Particle Attributes and experiment with the values of Halo Size, Hardness, Alpha and the color of the smoke. You do 
not need to create a new material, you only need to change the existing RGB and A values.

For example, a Halo Size of 0.900, an Alpha value of 0.100, and a hardness value of 1.0 will produce a denser, more realistic 
smoke. After you finish experimenting with the values, use these values and save the file again.

Randomizing the Smoke Particles

If you are modelling smoke from a fire, you want the particle system to move randomly, but to drift in a predictable direction as
if moved by a breeze or simply billowing up from a source of fire.

Blender's particle interaction options provide some sophisticated ways to control particles and make them interact with the 
environment. However, for this tutorial you will simply specify some variables that randomize the particles and move them in 
the desired direction. You can learn about particle interaction later.

To set up the model, first revert to a static view of the particles, as follows:

In the buttons window, press F7 to display the object buttons.1.
In the Particles panel, press the Static button. Notice that the 3D view changes to the particle star.2.
Press KP1 to display the front view.3.
In the Particle Motion panel, find the group of variables labeled "Force" and change them as follows:

Change the value of X to 0.500. Notice how the particles are now skewed to the right.1.
Change the value of Z to 0.500. Notice how the particles are now skewed upward.2.

4.

In the Particle Motion panel, change the value of RLife to 0.200. Notice that the pattern of the particles becomes more 
disorganized.

5.

In the Particle Motion panel, change Random to 0.02 to give the starting speed a slight variation. The pattern becomes 
even more disorganized.

6.

Press KP0 to return to camera view.7.

What was formerly an organized star of particles has now become a random mass. You can now preview the animation as 
follows:

In the Particles panel, click on the Static button to revert to animated particles.1.
In the 3D view window, press Alt-A.2.

The cloud of particles now drifts randomly to the right. Preview the animation as follows:

In the buttons window, press F10 to display the Scene buttons.1.
Press the Anim button to start the animation2.

You should now see a much more realistic drifting cloud of smoke. However, one of the problems with it is that you can still 
see a pattern of particle emission from the vertices of the object. One way to make this less visible is to reduce the scale of the 
object, squeezing the vertices together, although that will make the source of the smoke appear very dense. Using the mesh edit 
decimator option to reduce the number of vertices will make it less dense, as will ramping up the Alpha value of the smoke 
halo.

The *BEST* way to truly randomize particle emission is to select the emitter and go into edit mode (TAB key), select ALL 
vertices of the emitter ("A" key), go to the Editing menu (F9), and then to the Mesh Tool Subpanel. There, press the HASH 
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button, then leave edit mode (TAB key). You will now see particles emit in a TRULY random fashion, something that has been
overlooked by nearly every other tutorial available.

There are many other ways to make the smoke look more natural, such as by animating the value of Alpha or color to make the 
smoke seem as if it is getting thicker. You can use several emittors to send out particles of smoke of different color and density,
with different rates of emission. By animating emittors, you can create a very realistic effect - or even a moving cloud system.

However, for this tutorial, we will keep it simple, and move on to the next step of animating simple flames and sparks to mix in
with the smoke.

At this point, you can save the file, and then experiment with changing the values of the particle system to see how it affects the
smoke. The following image is using Halo size 2.0, 2000 particles, Alpha 0.5 and the "Hash" randomizing technique described 
above.

Making Fire

Need to complete this section.

Next Page: Furry
Previous Page: Particle Systems

Furry

Next Page: Rug
Previous Page: Making Fire

Let your hair hang down

To learn how to make fur or hair, click on the link below and scroll to the bottom. It is the last tutorial.

Or...

Example of sphere with fur-like particles
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Creating Fur in Blender 2.40

Matt Liebrich, twentytortures

First off, select the object you want to be furry. Do this in Object Mode. (You don't have to duplicate the mesh anymore!) For 
this tutorial we'll use a UV sphere with 32 rings and 32 segments. Then, go to the "Object" tab (F7), and click on the "Physics" 
tab (to the right, on the button window menu bar). (Or Press F7 repeatedly to "cycle" between the Object and Physics
SubPanels)

Blender Physics Tab

Under the "Particles" palette, click on "NEW". For best results you should be in object mode.

A bunch of things will pop up in place of that "New" button. Several things are important for the creation of hair/fur. The most 
important are:

Static - makes particles static

Emit

Amount - amount of particles to draw
Step - don't draw redundant particles
Life - how far/long particles go
Display - percentage of particles displayed in viewport

Display:

Vect - makes particles look like strands
Mesh - renders the mesh

From:

Verts - draw particles from verticies
Faces - draw particles from faces
Rand - draw particles randomly
Even - draw particles evenly

The "Particles" palette
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And under the "Particle Motion" palette:
Velocity:

Normal - length of hair
Random - randomizes direction/size

Force

And the "Z" (or possibly X or Y, depending on the result you want.)under "Force" - simulates a force

Particle Motion

Anyway, back on the "Particles" palette, push "Static" and then "Animated" if you want it to be in an animation. Then in the 
"Display" section push "Vect" so that the particles look like strands in your viewport. If you push "Mesh", then your mesh will
be visible as well as your hair when you render.

Under the "Emit" section, increase the amount of particles to about 20 thousand or so. We want a really furry sphere. You can 
leave "Step" at its default value of 5. Life is 50 by default. I find I get better results when I decrease this number to 10 or so. It 
is very important that you decrease the "Disp" number. It by default says 100. This means that 100% of the particles are visible 
in your viewport. You could leave it at 100 if you have a really powerful computer, but for those of us who don't, we'll want to 
turn it down. I like mine around 20% or so. It leaves enough particles visible to be able to imagine the final product but it also 
increases my computer's performance.

In the "From" section there are some buttons that have some importance. "Verts" and "Faces" are the areas where your 
particles are drawn from. "Rand" and "Even" are how your particles are drawn. I find that clicking even is important because it
displays all the hair evenly around your object.

Afterwards, in the "Particle Motion" palette, under the "Velocity" section, adjust the "Normal" value until the hair is as long 
as you like, if we left the "Life" at 50 then we would have extremely long hair even though our normal value would be .01. 
Increase the randomness value for added realism. (Not too much, though!) Then, make the value of "Z" under "Force" 
somewhere around -0.02. This will simulate the hair falling down because of gravity.
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Isn't it cool what you can make in so little time?

Strands Material Settings

In the "Materials" tab, there are some options specific to this type of particle. These can be accessed with the "Strands" 
button, under the "Render Pipeline" heading in the "Links and Pipeline" tab.

The "Start" parameter sets the width of the fur at the base of the particle (from the vertex or face where it originally spawned). 
"End" is the width at the other end of the fur, so in general this should be smaller than "Start".

The Shape option controls how the width of the fur changes, between these two points. A lower value will result in the width of
the middle being closer to the width at the end than at the start.

Good hair and fur material will often be partially transparent, lower the value of the A underneath the colours in Material tab, 
and be sure to set the ZTransp option in the Render Pipeline options, it's above the strands button. Using Raytraced 
Transparency limits the number of strands deep you can see in the render.

Blender 2.42 also adds a new preview type usefull for working on strands, the 5th button from the top on the Preview tab will 
draw a collection of Hair strands using your material settings.

Using my sphere from the previous section, I'll show you how to make the fur look real neat with Blender's default textures. I'm
not going to go into too much detail about how to add textures and stuff because that should be covered in other tutorials.

I'm first going to play around with the "Blend" texture type. Using the textures colorband settings, I made it fade from red to 
green to transparent black.

Under the "Map Input" section under the "Materials" tabs, I clicked the "Strand" button. This will make the texture follow 
the strands, neat eh?
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If I select the default "Orco" button then we get different results.
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There are all sorts of things that can be done with the default textures! Just play around a bit, it's the best way to learn how to 
use the particle system.

Curve Guides

Strands can be affected by blenders Fields simulation. The controls can be accessed from the Physics Buttons (First select 
Object or press F7 until the Physics Buttons appear). There is a combo box labeled fields on the Fields and Deflection tab.

Although hair and fur can be affected by any of these fields types (except none of course), you will find the Curve Guide option
most useful. Before using it though, you will need to create a path for your curves to follow.

So, to give your furbull a pony tail, first create a curve that you want the fur to follow. Do this by selecting Add->Curve->Path
from the main menu. Editing the verticies in a curve is just like editing the vertecies in a mesh object. You can extrude a path 
from a vertex on either end. Make sure one end of the path is in the base of the hair you want to be affected by the curve.

When you have your curve the way you want, exit edit mode and set the fields type to Curve Guide. You can then change the 
radius that your curve guide will affect. If it won't pick up the hair that is in this radius, and drag it along the path, your curve 
may be the wrong way round. To fix this, enter edit mode again. You will need to select your curve (use a to select all verticies) 
and hit w to get the specials menu. Then select switch direction. Your curve should now be affecting the hair.

This is the link: http://download.blender.org/documentation/NaN_docs/Manual2.0/Particles.html

Next Page: Rug
Previous Page: Making Fire

Rug

Next Page: Soft Body Animation
Previous Page: Furry
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Rugs

A rug is a big flat piece of cloth, with strands of cloth coming up. In Blender terms, it's a plane with particle effects!

The first step is to create the plane. Look down by pressing NUM7. Add a plane using the spacebar. Now scale it up a bit, 
maybe 5 X 3 Blender units.

Enter object mode and click physics. For particles, click New. Also click, static and vect. Also, since rugs are synthetic I also 
clicked even as the strands are likely to be evenly spread out.

Now, enter the other window that's still part of particles. For velocities, set normal to about .2, and random to about .16. Also, 
increase R.Life until it looks satisfactory.

It'll probably look too thick, so decrease the amount until it looks good. Sadly it's still gray, but I'm sure you can figure out how 
to color it.

Interesting Ideas

Don't forget that particles respond to fields. You could easily add indentations, like foot prints, by creating a sphere and giving 
it a spherical deflection with a max distance.

Also, using a distortion texture, you can add stains to the carpet to give it a more "real" feeling.

Next Page: Soft Body Animation
Previous Page: Furry

Soft Body

Soft Body Animation

Next Page: Simple Cloth Animation
Previous Page: Rug

Due to rapid updates in Blender, some menu items may be different from those mentioned here. If the menus don't agree then 
just do what seems logical.

Softbody makes each individual vertice, it's own object that falls according to gravity and reacts to outside forces like fields. By
adjusting the settings, you change the character of the edges that connect vertices. For example, you can make it so the edge can
stretch really far, allowing the vertices to become distant, or you can make the edge stiff, so the vertices will always stay the 
same difference apart.

To put this in perspective, picture two clothes one elastic and one cotton. The elastic one has edges that can be stretched, so if 
you could see the vertices that made it up they'd become farther apart. The cotton one would only stretch a little bit, so the 
vertices would stay essentially the same distance apart.

Still here? Ok, you’re going to make a big rubber ball, but not a bouncy one, a flat one. Start with a sphere. I would use a cube
sphere or an icosphere, UV spheres don't deform well at low res. a cube sphere is made by subdividing a cube and doing a
toSphere in the edit window.

Move the sphere up and place a plane below it. Make sure to do this in the right views so that it is aligned properly. Gravity 
acts on the z-axis.
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Now for the soft body select the ball and go to the object tab then the physics subtab or whatever your version has. Click 
"enable softbody" and then turn up 'Grav' to 9.8. Click off use goal. Press the > arrow key and you should see the ball fall. The 
center will remain in place but this is not a problem. If you are on a slow machine you will notice lag. This is because blender 
moves it vert by vert, not efficient.

When it reaches the bottom it will go trough the plane. To fix this we must make the plane effect the softbody. To do this make 
the plane deflect in its physics buttons.
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Now the ball collapses into a strange quivering wreck after impact. To fix this, you need to turn on the stiff quad button, but set 
the edge stiffness down a bit, so its more bouncy. You can use the bake function to solidify the settings see below

Explanation of Settings

I invite you to correct and expand these definitions

Softbody

Friction: creates a resistance to movement of the whole object, like being emerges in a viscous fluid
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Grav: a constant -z force
Mass: (Force = Mass X Accelleration) effects everything by making the object heavier.
Speed: tweaks the simulation to run faster or slower.
ErrorLimit: raise it and the simulation will solve faster but strange things might happen. Save frequently, as blender 
might go nuts with this or any physic simulation (but less so after 2.4)

Goal: makes the object try to return to it's original position, useful at times, in the tutorial you could turn gravity off and 
key the ball falling and use this to keep it a ball.

use Edges: uses the edges a means of resistance to movement for the object. Helps to keep it looking possible

Deflection

Next Page: Simple Cloth Animation
Previous Page: Rug

Simple Cloth Animation

Next Page: Game Engine Basics
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In this tutorial, we will be making a simple skirt. This tutorial does not assume that you have any Blender or other 3D program 
experience.

Making the Skirt Mesh

Open Blender and delete the default cube, if you aren't looking down on the scene, press NUM7.1.
SPACE → Add → Mesh → Circle2.
You should get a prompt for the number of vertices. Use about 20 and hit OK.3.
Once the circle is added, you should be in 'Edit Mode' (You can tell that you're in edit mode if you can see the individual 
points of the circle and they are all highlighted in yellow). If you're not in 'Edit Mode', press TAB.

4.

Press SKEY and resize (in 3D terms, scale) the circle to however big you want your skirt to be.5.
Tap the AKEY key twice to select all vertices.6.
Press NUM1 to look at the skirt from the front. If you can't see it, that's because all the vertices are in the same plane, this 
is fine.

7.

Press the EKEY then select Only Edges, wherever you move your mouse, you'll see a circle follow it. Pull the mouse 
downward and left click.

8.

In the bottom pane under 'Mesh Tools', click 'subdivide'. Then click fractal, set to '10' and press ok. Finally, click 
'Subdivide' again. The subdivide function adds vertices. The fractal function adds vertices with a little bit of randomness. 
All we really did was add some interest to the skirt.

1.

Creating Vertex Group

The vertex group will tell us which vertices will be affected by softbody and which ones won't. The non-affected vertices are 
given a weight of 1.0. To understand the concept of vertex groups, Click Here , however, it's not neccesary for this tutorial.

  You should now have a hollow cylinder
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Deselect all vertices by pressing AKEY.1.
You're still looking from the front right? Press z to enter wireframe mode. This allows you to select vertices that you 
couldn't see before.

2.

Tap the b key and the cursor turns into a plus. Now, if you click and drag, you can select all vertices within the box, it's 
much faster. Anyways, select all the vertices on the top layer.

3.

Look in the bottom pane under 'Link and Materials'. You will see that there are two columns of buttons directly 
underneath the 'Vertex Groups' label. Click the 'New' button. Two boxes appear directly underneath the 'Vertex Groups' 
label. Change the new vertex group name to something meaningfull, like 'softbody'. Change the 'Weight:' to 1, by 
clicking on the left side and sliding to the right. Now press the 'Assign' button. This assigns the vertices that you have 
selected (the inner-most circle) to this vertex group.

4.

Making the Skirt a Soft Body

Enter object mode and select the skirt (right-click it)1.
In the buttons window, typically at the bottom of your screen, click the objects button. It looks like three arrows.2.
A new set of buttons appear, click the one that says physics when you hover over it. From memory, i think it is yellow.3.
At this point there should be three little windows on the bottom. One deals with deflection, one with particles and one 
with softbody. Click enable softbody.

4.

Set the gravity to 9.81. This is like real earth gravity.
leave mass and friction, but increase speed to about 3. This allows you to see the movement in fewer frames.1.
for goal, click enable vertex groups and assign the one that you made earlier. What this does, is it tells the 
vertices that were assigned a 1, to stay where they are, and the ones with a zero that they don't have to stay. Of 
course, you can assign a value of .5, then the vertex will go somewhere between where it began and where gravity 
wants it to go.

2.

5.

Test it out, by placing your curser over the biggest 3d window and pressing ALT A
To exit this animation, press ESC1.
If it runs too slow, exit the animation, press Z To enter wireframe mode, then try again.2.

6.
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Blender Game Engine(BGE)

Game Engine Basics

Next Page: Your First Test
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Purpose: To demonstrate the object collision feature of Blender's Game Engine.

Object Collision Basics For The Blender Game Engine

With the mouse cursor over a 3D viewport, press NUMPAD-7 to switch to TOP view.

Press the spacebar and select Add >Mesh >Plane. Press TAB to leave edit mode and enter object mode. [5]
(http://img192.echo.cx/my.php?image=17bf.jpg) 

-Note: The higher the weight, the closer that vertice will stay to it's position in edit mode. By making it '1', we essentially "pinned" the top vertices where they are,
but will let  the other ones hang loosely.
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Enlarge the plane by pressing S and dragging the mouse cursor away from the center of the plane. Click to stop re-sizing. The 
plane will serve as the 'floor'.

Add A UVSphere using the same sequence for adding the plane object. Press TAB to enter object mode.

With the mouse cursor over a 3D viewport, press NUMPAD 1 for Front view, then press G and move the sphere above the 
plane. Click to exit Grab Mode. You may need to scale the sphere down. It will be the ball which collides with the floor.

Go to logic panel (move cursor over Button Viewport and press F4).

Click on actor button (in the upper left corner of the logic panel), then Dynamic, then Rigid Body. This activates physics 
properties for the sphere so it can bounce.

Change the value of "Radius" to 2.0. It may simply be called "dius", or "ius." Notice the dotted line that appears around the 
sphere. This dotted line marks how big the physics engine thinks this sphere is. For now, set it back to 1.0.

Next, you want to add some colour to the sphere and the plane (see Blender_3D:_Noob_to_Pro/Quickie_Material for details), 
so you can tell the two apart during simulation.

Move the cursor over a 3D viewport and press P. The sphere will drop down and collide with the plane. Press ESC to end 
simulation

For fun, try rotating the plane in front or side (NUMPAD 3) view and press P again. The ball will first hit the plane, then roll 
down. Add several more planes rotated to differing angles and position them in the falling path of the ball to keep it going.

Next Page: Your First Test
Previous Page: Simple_Cloth_Animation

Your First Test
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The Game Engine is an interesting feature of Blender. The Game Engine is basically a 3D environment in which 3D objects 
move around and react to each other upon contact. The Game Engine is most easily applied to 3D architectural tours.

As a start, we will teach you to make a ball roll realistically down the hill using Blender's game engine.

First, make a plane. Subdivide it a few times and scale it up a lot. Now, make a sphere. It can be any kind. With the sphere 
selected, go to the game engine settings (the little purple Pacman-icon). You will see something that says "Actor". Press it. 
Now press Dynamic. You will see a bunch of settings available now. Change Size to 1.4. This changes the boundary that iniates
reactions when made contact with by another object. You notice a dotted circle around the object; this is the boundary. Also 
enable Rigid body. This makes the ball roll, instead of staying completely upright the entire time. Edit the plane you made, 
pulling vertices up or down. For this example, make it look like a canyon. Put the ball at the start point and press the P-Key. 
You will see the ball fall in, and roll. If it doesn't go the way you wanted, Pull some vertices of the canyon downwards. If you 
just see white silhouettes, don't worry. Press escape to exit the game mode. Press Z key. Go back into game mode (P) and 
everything will be in wireframe while you play the game.

Now, how about adding a little color to this scene so it doesn't look all white. We will do this using a method called vertex 
paint. Press Z again for the normal, solid mode. From the object mode, locate a scroll-up menu on the 3d view task bar 
currently labelled "Object mode". Click it and select "Vertex Paint". Note that all the objects in the 3D view window are white 
silhouettes again and that your cursor also has a circle around it. Select the edit buttons menu below. Here, you will find a 
square for color selection. Pick a grayish brown color for the rock. Now go into the 3D view window and click on the rock. 
Every vertex in your cursor's circle should start to turn a shade of that color.

Next Page: Build a skybox
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Previous Page: Game Engine Basics

Build a skybox
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One way to add a realistic feeling to your 3d environment in a game engine is to create a skybox. A skybox is a large cube 
which has on its inside a projection of a 360° environment. When the player (camera) is inside this environment, the scene is
rendered with the illusion of being inside a gigantic world. This is a similar effect to Quicktime VR (see 
http://fullscreenqtvr.com for examples). And, by setting up the skybox as a simple cube shape, you place the least amount of 
strain on the graphics engine. It's a great advantage for your game with very little overhead.

This tutorial will show you how to create skyboxes relatively easily from panoramic photos. My favorite part is, you can do it 
easily using free tools such as Blender and the Gimp.

Using the Gimp to manipulate images is not really in the scope of this tutorial... check out some other page on using that 
software. You should have an understanding of how to edit images and apply alpha channels. (You could also use the Gimp to 
apply a polar coordinate texture to your rectangular image in order to create a fisheye image. Hint: it's not the sphereize filter.)

Gather your graphics

You can take panoramic images yourself using a regular digital camera and a tripod. A quick way to accomplish this is to draw 
marks on your tripod base at every 30 degrees (think of the hours on a clock face). Make a single mark on the swivel of your 
tripod to allow you to line up your shots -- twelve shots at 30 degrees each. Then, using a program such as the Gimp
(http://www.gimp.org) or the incredibly cool Autostitch (http://www.autostitch.net) to merge the photos into one big panorama.

Or, if you're lazy like me, you can just grab photos online to use as templates to create original images. There are also many 
places you can download non-copyrighted photos for free as well. One resource for cloudy sky textures, as well as panoramic 
photography instructions, is Philippe Hurbain's site Philo's Home Page (http://www.philohome.com) . This tutorial will use a 
fisheye sky photo from his copyright-free Panoramic Skies images collection.

You'll also probably want a photo for your ground, unless you prefer to use real models such as buildings in your skybox. This 
earlier chapter (http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Mountains_Out_Of_Molehills) on creating landscapes
can be incorporated into setting up your skybox. However, this tutorial will use the sky photo for the top half of our world, and 
a panoramic landscape with an alpha channel for the bottom half. I've created a ground image using copyright-free textures 
obtained from Accustudio (http://www.accustudio.com) .

Here are the images I'll be using (you'll want to use images with higher resolution): Note that the sky has trees, etc.
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Note: I've outlined the horizon of the ground texture with an alpha channel which will allow me to place the ground mesh right 
against the sky mesh with a very natural feel.

Create a dome for the sky

Open a new file in Blender. Your default new file will probably be a two-unit cube in the center of the screen, with a single 
light source and a camera. You can delete the light source because we won't be needing it. Leave the cube, because that is what 
will become our skybox.

The cube will be the center of our environment, so use Object->Snap->Cursor To Selection if your cursor is not centered. Then,
from the top view [KEYPAD-7], Use [KEY-SPACEBAR] to insert a new mesh; make it a UV sphere. I find a 32-segment, 
32-ring sphere to be sufficient. We create the sphere from the top view because that is the projection from which we want to 
add the sky texture.
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Scale up the sphere so it resembles a large "arena" in comparison to your cube, and select and delete the lower half of the 
vertices, using the front view [KEYPAD-1] and [KEY-B] to create a bounding box. It helps if "Select Visible" is turned off so 
you can select all of the vertices in one go.

Turn on proportional editing with [KEY-O], then select the bottom row of vertices and scale them up with [KEY-S] so that the 
bottom of the sphere gets a bell shape. Because the projection of the sky texture will be from the Y-axis (ceiling) we need the 
bottom faces of the sphere to be at an angle, to catch the texture. (Faces perpendicular to the projection will look like smears.) 
Alter the influence of proportional editing with [KEY-PAGEUP] and [KEY-PAGEDOWN]. Linear or Sharp falloff works best 
with the sphere shape.
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Now you're ready to add your sky texture to this mesh. In the Materials menu, create a new material and a new texture. Be sure 
to set your material not to recieve shadows by clicking the "Shadeless" button. Then, in the Texture menu, set the texture type 
to Image, and click the Load Image button to insert our sky texture. Back in the Materials->Texture->Map Input menu, you 
may need to scale your image to get rid of the distorted textures at the edges of the fisheye by setting the Size to, say, 0.950 for 
X, Y and Z.

At this point, if you wish, you can reposition the camera and render the scene to see how your sky mesh looks.

Create a dome for the ground

I found it easiest to move the sky dome to a new layer with the [KEY-M] move to layer command. Then you can select the 
cube, Object->snap cursor to selection if you need to, select the top view [KEYPAD-7] and insert another UV sphere just as 
before -- except this time, remove the top hemisphere of vertices. I left an extra row of vertices at the "equator", scaled up, to 
function as a "billboard" to display the the horizon of our ground texture with the alpha channel. This sphere should be slightly 
smaller than the sky hemisphere.
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This time, I will apply the ground texture with a tube projection, so it is projected onto the mesh horizontally [Materials panel | 
Map Input tab | Tube button]. Because I have an alpha channel on this texture, I click "Use Alpha" in the Texture menu and 
Map To -> both Col and Alpha buttons [Materials Panel | Map To Tab | -> both Col and Alpha buttons]. You will also need to 
set ZTransp in the Mirror Transp menu [Materials Panel | Links and Pipelines Tab | ZTransp button] so that your alpha channel 
shows up in the envmap (which will become your skybox), and Alpha to 0 [Materials panel | Material tab | A slider ] to allow 
the masked areas to be transparent. (Alpha channels appear to require Z buffering to appear on procedural textures.) Also, you 
may need to adjust the offset of the ground texture (Y-axis), so that the horizon appears properly on the "billboard" area of your
ground hemisphere.

Again, you can reposition the camera and render the scene to make sure everything is properly aligned. Be sure to activate the 
layer where you moved the sky mesh. Your results will look similar to the following image. Set OSA on in the render screen for
best results. Also, use higher resolution images with cleaner alpha channels -- the image below is rather blurry and you can see 
a halo around the horizon.
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Render the environment map

The last step is to use the procedural Envmap texture to project the dome textures onto the cube, which will become our 
skybox. Select the cube and create a new material. Set the material to "Shadeless" [Materials Panel | Materials Tab | Shadeless 
button]. Add a new texture and make its type Envmap. Set the CubeRes [Envmap tab | CubeRes setting ] to whatever you want 
the resolution of your skybox to be (512 is a good resolution for a game; 1024 or 2048 are fairly high-res; I stuck with low-res 
for this tutorial). If your sky & ground hemispheres are very physically large, you may also need to increase the ClipEnd value 
to include all of the faces. You may want to set the Envmap calculation to Anim so you don't have to keep freeing envmap data 
if you're experimenting. (Anim automatically clears Envmap data with every render, otherwise you must click 'Free Data' to 
reset the Envmap.)

Once you've created the Envmap texture, you should be ready to render the Envmap for your skybox. If you want to set your 
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file format such as JPG or PNG, you should do that first. Then, simply go to the render screen and click "Render." Again, make
sure all layers are visible. The rendering window appears. First, Blender renders the environment map of the cube. Afterward, 
the camera view is rendered, at which point you can hit [KEY-ESCAPE] to stop rendering -- we are only interested in the 
environment map which is already complete.

Select the cube again, then get to its texture menu. You will see the newly-rendered Envmap on the sample texture. Click "Save
EnvMap" in the texture menu to save the rendered Envmap.

Blender environment maps are saved as a 3x2 matrix of squares, as seen here:

The cube faces are in the following order.

You can now load this image as an envmap texture in a new cube, which you can incorporate into your game as a skybox. This 
file can also be edited in the Gimp to remove any unwelcome artifacts such as trees, buildings, jet trails, etc. Also, because I 
used a tube projection on the lower hemisphere, in the bottom face of the envmap you see a strange star shape at the "pole." 
You'll most likely have a floor in your game, so you probably won't see that face anyway, but sticklers can avoid it with clever 
use of the Filters->Distorts->Polar Coords filter in the Gimp or Filter->Distort->Polar Coordinates (Polar to Rect.) in 
Photoshop. Patching also works well.

To make the skybox appear as a static background in your game, vertex-parent it to your player object.
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A simple basic mouse pointer Making a simple mouse pointer in the game engine. This takes up a lot of resources but it is very 
simple.

A little python is involved but it is very easy to use and is only 2 lines of code.

First open up blender and split the screen in two.

Make the right screen a text editor and add a new text file with alt-n.

Type in the following code.

Now select an object that will always be available - preferably a camera - then go to the logic tab, add a property sensor, one 
python controller, one controller and a property actuator.

Activate the true level triggering - name the property switch (prop:switch) and make its value 0. Conect the property sensor to 
the python and and controllers

In the python controller's script type (Script:showpointer)

Now connect the and controller to the property actuator - name the property switch (prop:switch) and make its value 1 
(Value:1).

Make it a actor and click on add property make it a Int type then name it switch.

Now save the text as showpointer and open it up again.

Now press P to start the game and now you`ll see your mouse pointer.

Freakazo v2.1

How to make a .exe This tutorial will show you how to make an executable for your game made in blender. This is actually a 
very easy process.

First create a folder that will hold all your game information. Name it something meaningfull, like "Oblivion: Elder Scrolls."

The folder must contain four files that you can copy from your blender installation directory.(under windows it should be 
"C:\Program Files\Blender Foundation\Blender") They are:

SDL.dll1.
python24.dll2.
pthreadVC2.dll3.
zlib.dll4.

Now open blender with the game that you have created and open the file menu. Click on save runtime and then save to the new
folder that you have created and rename the file yourgamename.exe,

and then you can run the game!

import Rasterizer as r

r.showMouse(1)
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Other

Match Moving Next page: Blender 3D: Noob to Pro/HDRi
Previous page: Blender_3D: Noob to Pro/Build a skybox

Take a look at the WikiPedia article on Match Moving1.
Download the free Match Moving solver, Voodoo (http://www.digilab.uni-hannover.de/docs/manual.html) or the free 
(for educational use only!!!) Icarus (http://files.filefront.com/Icarus_209/;3922266;;/fileinfo.html) (the predecessor of 
PFTrack),

2.

and see a video tutorial howto du camera tracking with Icarus and Blender, [6]
(http://peerlessproductions.com/tuts/pages/Icarus.html) 

3.

Next page: Blender 3D: Noob to Pro/HDRi
Previous page: Blender_3D: Noob to Pro/Build a skybox

High Dynamic Range imaging (HDRi) You may have heard various people talk about HDR images. (WETA, Lucas, even Tim 
Sweeny). HDR images are part of a technology called HDRi which stands for "High Dynamic Range (image)". So... what on 
earth does that mean?

Here's a link to Wikipedia's article on the HDR format (http://en.wikipedia.org/wiki/High_dynamic_range_imaging) which I 
personally give all my credit to Paul Debevec for putting it to use for computer graphics purposes. Anyway, before you start 
trying to understand the usefullness of HDRi, please read the wikipedia link.

Also, visit Paul Debevec's website (http://www.debevec.org) if you've got some more time to spare.

To sum up the excitement of HDR CG, think of it like the hype of the next-generation videogames that are about to come out, 
except set the stage for 1996 instead of 2006. Paul Debevec pioneered paralax mapping, HDR lighting, image-based modeling, 
his latest work includes some even more amazing technologies, and for the record he's my hero too.

To use HDRi images for 3D rendering, you need something called a light probe...

HDRI stands for High Dynamic Range Imaging, and is basically a technique to use a picture of the environment to light your 
scene. This will result in very realistic and convincing shadows, higlights and reflections. This is very important for realistic 
emulation of chrome for example.

First of all, you'll need an HDR image. There is a whole range at http://debevec.org/Probes/ that you can download for free. I 
will use the Uffizi Gallery probe, but any other HDR image will do just fine.

To apply the HDRI environment to your scene:

Go to the shading settings (press F5) and click the World button.
In the "Texture and Input" tab, click "Add New" and "Angmap".
Then go to the "Map To" tab and deactivate "Blend" and activate "Hori".
Now go to the Texture settings (press F6) and change the "Texture Type" to "Image".
Click the "Load Image" button and locate your HDR image.
To be able to render using this environment, you need to enable YafRay. Press F10 and change the "Blender Internal" to 
"YafRay".

Creating a Light Probe The light probe is, in the simplest terms, a photograph of your environment. they work in very much the 
same way that reflection maps do, and are made the same way.

Equipment:

A pure silver ball. Try a plastic christmas tree ball ornament.1.
A camera, prefferably digital. If you have a high-end digital camera, you'll have less work ahead.2.

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P
http://www.digilab.uni-hannover.de/docs/manual.html
http://files.filefront.com/Icarus_209/
http://peerlessproductions.com/tuts/pages/Icarus.html
http://en.wikipedia.org/wiki/High_dynamic_range_imaging
http://www.debevec.org
http://debevec.org/Probes/
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A place you'd like to capture the lighting from. Try laying different things in your environment to get a good idea.3.
Something to fire the shutter without touching the camera. For digital cameras, Paul Debevec reccomends using a 
program that will take all the pictures for you.

4.

A tripod.5.

Set it up like so. Remember that the height of your camera and the height of the ball relative to each other controls the angle at 
which the horizon will be shot. In other words, shoot the ball at the same angle that you plan to shoot your 3D scene in. If your 
scene is animated... consider making a similar rig except attaching your reflective ball to a videocamera as was done for 
wikipedia:Flight_of_the_Navigator.

Note that the diagram is incorrect. The camera will see items reflected from behind the sphere as well.1.

The process:

Set up your rig and take1.

Create a Clayman

This page uses images which do not have the coyright status listed on the image summaries. These 
images must be deleted if the copyright information is not added.

If you were responsible for uploading these images, please make sure to add the appropriate copyright tag to 
avoid the disruption that will be caused to this page when the images disappear.

Create a Clayman

(under construction)

This Tutorial was made using Blender version 2.41

Upon completing this tutorial, you will have made something like this:

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P
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Completed Clayman Render

Making The Clayman

Upon start, delete the default cube (X-KEY) and switch to front view with NUM1. Now add a mesh plane and under The Edit 
Buttons Window, Mesh Tools Tab click the subdivide button. Now select the 3 vertices on the left and delete them. (B-KEY 
for Border Select Tool)

If you can't select the vertices then deselect the Limited Selection to Visible button.

Now select/deselect all vertices with A-KEY (we want them selected)In the Modifiers Tab in the Edit Buttons Window, Click 
Add Modifier > Mirror You should now see something like this.

Image:Mirror Modifier.jpg

I, the creator of this image, hereby release it into the public domain. This applies worldwide.
In case this is not legally possible:
I grant anyone the right to use this work for any purpose, without any conditions, unless such conditions are 
required by law.

Now select the 3 right vertices and extrude them on the X axis by movement of 1.0 units by pressing E-KEY (Extrude > Only 
Edges), X-KEY (to constrain it to the X axis) and holding CTRL to constrain it to simple movements. Do this twice.

Image:2.0.jpg

Now extrude the legs by selecting the 3 bottom-right vertices and extruding them on the Z axis by 1 unit. Do this twice as well.

Image:2 Legs.jpg

Now extrude the top of the clayman on the Z axis (in units of 1.0) 7 times so that it looks like this.

Image:Clayman Body.jpg

Now let's make the arms by extruding the 2 boxes that are 3 boxes down from the top. Let's extrude it on the X axis by 1 unit 4 

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P
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times so that it looks like this.

Image:Clay Arms.jpg

Now comes the extrusion of the whole body. As you can see, we only have a flat shape of a rough "Block". so lets move our 
view around with the NUMPAD arrows and extrude it on the Y axis. Select all vertices with A-KEY. Extrude > Region on the 
Y axis until it reaches 2.0 units. After done correctly, it should look like this.

Image:Extruded Clayman.jpg

With the Clayman successfully extruded, its now time to add some definition to him by adding a subsurface modifier. In the 
Edit Buttons window, under Modifiers, click Add Modifier > Subsurf and set the Levels bar to 2. It should look somewhat like 
this.

Image:Subsurf Modifier.jpg

Now, Select all vertices with A-KEY, and click the Set Smooth button in the Links and Materials tab. Let's get to shaping the 
Clayman.Using the Border Select Tool (press B to get the Border Select Tool), grab the according vertices to make a shape like 
this.

Image:Vertices.jpg

after thats done, select the head vertices and grab them on the Z axis and move them up by 0.2 to make it look like this.

Image:Moved up.jpg

Now select all vertices with A-KEY, and scale them down (S-KEY) on the Y axis until it reads 0.6000. And finally, select the 
underside of the foot (the vertices that make it up) and subdivide it to make ir more flat on the bottom.

Adding Materials

Start by going to the Material Buttons window (F5) and Clicking on Add New, and going down to the collumn of 3 rectangles 
that have one gray one and two blank white ones. Click on the gray one and in the top-right corner of the pop-up window, you'll
see a Hex Code. Click on the current hex code and type in this new hex code to get the right color: 73BCF7. Now hit F6 to go 
to the Texture buttons window and click on Add New. Change the Texture type to Stucci. Now you'll see a new tab appear. On 
it, for NoiseSize enter 0.150. Now go back to the Materials Buttons window. On the far right there will be three tabs in one. On
the Map To tab, Deselect Col and select Nor. Now your example should look like this.

Image:Texture sample.jpg

Inserting Armatures

Now lets move on to inserting armatures in our clayman. Lets start by going into object mode (alternate between Object and 
Edit mode with TAB) and adding an armature. Press Space > Add > Armature. It automatically puts you in Edit mode upon 
adding the object. Switch to Object mode and grab it along the Y axis by 1.0 units so that it's inside the clayman. Sure, you 
can't see it now, but turn on X-axis Mirror Edit and X-Ray in the Edit Buttons window.

Image:Buttons window.jpg

Now switch back to edit mode, and select the top of the bone. Etrude it on the Z axis by 1.4 units two times so that the tip of 
the second extrude is right in the center of the two arms. Now extrude it on the X axis by 3.0 units, then grab the tip of it and 
move it on the Z axis by 0.1700 units. Now extrude it on the X axis by 2.0 units twice. And do the same to the other side. It 
should look like this.

Image:Extruded bones.jpg

Now let's extrude the neck. Extrude the top bone along the Z axis by 1.0 units to make a pretty good size neck. Then extrude it 
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up on one side so that the position reads like so. If you can't get it exact then at least try to get it as closest to the number as you 
can.

Image:Correct Position.jpg

Then do the same to the other side so that it looks like 2 antennaes. Now let's extrude the hips and legs. Lets start by extruding 
the bottom bone by 2.0 units on the X axis and for the Z axis, -1.0 units. Then extrude the foot by -2.0 on the Z axis. And last, 
select a forearm bone (select a whole bone by clicking the middle of it) and in the Edit Buttons window, you'll see a tab called 
Armature Bones. Deselect the Con button in that tab, and do the same with the other forearm bone. This allows us to be able to 
move the forearm out, instead of having it locked to another bone.

Applying The Armature

Ok, now we're going to apply the armature to the mesh so that when we move the bones, the mesh moves along with them. Lets
start by switching to object mode and selecting the clayman mesh, and under the Modifiers tab, click apply on the Mirror 
modifier. You may see a pop-up, just click OK. Not only have we just made room in the Modifiers tab, we applied the mirror 
modifier to the mesh, so now we will have to edit both sides if we want to change something. But worry not, we wont need to 
change anything from here on. With that new space in the modiifers tab, let's add an Armature modifier. You may see a line 
that says "OB:" type in the name of the Armature in here (the default name for an armature is "Armature" unless you have made
more than one) also, deselect the Envelopes button,for we will not be using envelopes in this tutorial. Here is what you should 
have.

Image:Armature modifier.jpg

Now, select the Armature and press CTRL + TAB. If you already have a bone selected, it should be highlighted blue now. We 
have just switched to Pose Mode. Now, while in Pose Mode, select the clayman mesh (if you cant select it, zoom in closer to 
get some of the bones out of the way) and press CTRL + TAB on the clayman mesh. We have just entered Weight Paint Mode. 
This allows us to assign vertices to the bones so that the mesh moves with the bones. Let's start by setting up the weight 
painting. You should see a new tab called Paint in your Edit Buttons window. Adjust your settings so that they conform to this.

Image:Correct settings.jpg

Start by selecting the top-right bone of the head and start weight painting the front and back (you'll have to switch your view so 
that you can see the back to get the painting in there) Weight Paint it according to this.

Image:Front and back.jpg

Now Weight Paint the Neck. (pictures not shown of back view, but be sure to get the back anyway)

Image:WP Neck.jpg

Now the Shoulder.

Image:WP Shoulder.jpg

Now the Forearm.

Image:WP Forearm.jpg

Now The Hand.

Image:WP Hand.jpg

And after getting the other side of the body, let's get the upper chest.

Image:Upper Chest.jpg

Now the middle chest.

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P


Blender 3D: Noob to Pro - Beginner Tutorials/Print version - Wikib... http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P...

256 of 263 5.5.2007 21:39

Image:Middle Chest.jpg

Now the lower chest.

Image:Lower Chest.jpg

Now for the hips.

Image:WP Hips.jpg

Now the Feet.

Image:WP Feet.jpg

After doing the other side of the leg, switch back to Object Mode with CTRL + TAB, and select the Armature. You should 
already be in Pose Mode with the Armature. Now select a bone and grab it to move it. if you have Weight painted correctly, the
Clayman mesh should move with the bone. There's two tips to moving the bones around in Pose Mode.

1) In the Edit Buttons window, whether Automatic IK is turned on or not affects how the bones move.

2) Where your view is affects how the bones rotate. (unless you have it constrained to an axis)

If you find that a part of your clayman isn't moving, just switch back to Weight Paint mode for that bone and repaint it.

Back To Blender 3D: Noob to Pro (http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro) 

Organic Modeling Subsurface modelling

Organic modelling is usually done with subsurfaces. To make a subsurfaced object, select a Mesh object and press the subsurf 
button in the edit buttons. To make the shape smoother, increase the subsurfacing level using the parameters below the button - 
but preferably do not go above three. To make the object appear smooth click the set smooth button.

What you have done is create a smoother, higher-poly shape based on that of the original mesh. This is controlled by the 
vertices, edges and faces of the original. To have vertices, etc. of the original object snap to the subsurfaced shape press the 
Optimal button - although be careful, because this often hides very boxy modelling.

Now, start shaping your mesh into an organic shape. There are various tutorials for modelling bodies and faces, but it is often a 
good idea to use references. Only use quads - that is, shapes with four vertices. Triangles do not subsurface well, they create 
bad looking rough surfaces - avoid if at all possible.

To make the object shape properly, you will need good edgeloops. This means that all your faces line up in a continual line 
around your model. It is possible to select edgeloops - press alt-B and select the edgeloop. It is best not to have too many 
vertices to avoid making the subsurfaced shape look rough - in other words, the original shape should be quite low-poly.

Blender FAQ Please add in any FAQ or answers that you know. Remember it has to be covered by the GFDL if you didn't write
it yourself.

After installing I get an error message "A required .DLL file, MSVCR71.DLL, was not found"?

The file is part of the built in Python scripts. It's freely distributable and can be found with a quick search of google. 
MSVCR71 on dll-files.com (http://www.dll-files.com/dllindex/dll-files.shtml?msvcr71) 

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P
http://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro
http://www.dll-files.com/dllindex/dll-files.shtml?msvcr71
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How do I print from Blender?

You can't print from Blender. You can export the image to a image file, e.g. .png or .jpg and print that from a image program, 
e.g. Gimp (http://www.gimp.org/) , IrfanView (http://www.irfanview.com/) or MSPaint. If you want you can also print from a 
Word document, e.g. Corel or OpenOffice, but the quality is better in a proper image program.

How do I export an image to a file?

Press [F10] in the far right hand corner there is a drop down menu which allows you to select a file type. JPEG, PNG, GIF, etc. 
as well as different movie formats such as AVI, and MPEG.

Select the format you want the resultant image to be in.
Render the image by pressing [F12] or click "render" in the render buttons.
Press [F3] and the "save file" window comes up.
Type your file name and extension and press "save"

How do I accelerate rendering through a network?

Taken from BlenderArtists (http://blenderartists.org/forum/showthread?t=37709) and written by Pedro Doria Meunier 
(pdoria).

Here goes the "quick & dirty" solution:

Requirements: DrQueue (http://www.drqueue.org/) 

Go through the install procedure explained at DrQueue's (http://www.drqueue.org/) site.
Pay extra attention at those environment variables! You have to set them in your .bashrc file. Do whatever 
procedure you like to activate them (relogin, etc.)

1.

Make a NFS share (ex. /mnt/shared/DrqQueue). Chmod it so that you don't have any permission issues. The 
envirionment variables set in step 1 must match the NFS share! For example if you've created a NFS share 
/mnt/shared/DrQueue then DRQUEUE_ROOT must be set to /mnt/shared/DrQueue.

2.

Compile and install it. It'll get installed in that shared folder. Hold on to your hats! We're halfway through!3.

Now for a quick test

Execute /mnt/shared/DrQueue/bin/master — This'll start the master1.
Execute /mnt/shared/DrQueue/bin/slave — This'll start a client2.
Execute /mnt/shared/DrQueue/bin/drqman — This'll call the GUI. Check if there's a computer (your own!) listed in
that "Computers" tab. If it's there your master computer is set up!

3.

Now for the slaves

All you have to do is mount that NFS share somewhere, say /mnt/DrQueue.

Tip: Something that helps is to mount the share at boot time. Editing your /etc/fstab and adding the appropriate line 
will do the trick.

If you've mounted it there then execute /mnt/DrQueue/bin/slave.

Now go back to the master. You should see another computer listed there!

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P
http://www.gimp.org/
http://www.irfanview.com/
http://blenderartists.org/forum/showthread?t=37709
http://www.drqueue.org/
http://www.drqueue.org/
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Something important about the scene files and textures

You must place the scene files inside that shared folder. Same thing with the textures that are referenced inside the scene file. 
A neat trick is to pack the scene file and then unpack it inside the shared folder. This way all the textures are unpacked at 
/the/shared/folder/textures. Remember to save the scene file after doing this!

Happy Blending!

How do I fix the black lines that appear on my mesh when I click "set smooth"?

This happens when the normals of the object get flipped, so what you see in the lines is the inside of the 
mesh. To fix this problem, press [Ctrl] + [N] as it will recalculate the normals of the mesh to prevent 
flipping. This is not a problem when the mesh has been set to 'set solid'. If you would like to see which 
faces are pointing inwards and which are pointing outwards:

Go into edit mode.1.
Under "Mesh Tools 1" click "Draw Normals".2.
If the green line is pointing outwards the normal is facing outwards and vice versa.3.

Where is Subsurfacing in Blender 2.4x?

Subsurfacing is now a modifier and is found in the modifier list. This was added in Blender 2.40 
and now contains many of Blender's features such as "Array", "Mirror" and "Boolean" functions. 
When the little diagram next to the word 'subsurf' (same as render buttons diagram) is selected, the 
modifier will be used in a render. When the diagram next to it (the grid) is selected, the modifier 
will be used in object mode. When the diagram next to the grid (the square) is selected, the 
modifier will be used in edit mode. The button with no label which is separate to the other buttons 
is the same as the "optimal" button in versions 2.37a and before. When you "apply" the modifier, 
it's the same as converting the mesh ([Alt] + [C]) and deleting the original.

How do I change the active camera, and can I change it in animations?

To change the active camera, select the camera you want as the active camera and press [Ctrl] + [0]
(zero). Then, when you press [0] you will see through the new active camera. This feature does not
work in animations. To change to different camera angles in animations, you will need to use one 
camera and animate the camera using Object IPOs. If you are only using camera angles and no 
panning or zooming, you could animate the camera normally and convert the IPOs from "bezier" to
"constant" (shown in the screenshot), which will make the camera snap from one angle to the next. 
If you do have panning or zooming and would also like camera angles, you would need to animate 
in 'bezier' or 'linear' and animate a different way.

If you had the camera at one angle, snaps to the 2nd angle at frame 50, then pans to the 3rd angle at
frame 100 you would need to:

Set a key frame at frame 1 of the first angle1.
Set a key frame at frame 49 of the first angle2.
Set a key frame at frame 50 of the 2nd angle3.
Set a key frame at frame 100 of the 3rd angle4.

Sphere with 
flipped normals

Modifier list

Bezier IPO curves being 
converted to constant IPO 

curves
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This will stop the interpolation (moving between 2 different keyframes) of the 1st and 2nd angle, by forcing it to be the same 
between frames 1 and 49.

How can I give my Blender game to someone running a different operating system?

You can just give them the .blend file as it's universal to all operating systems, however they would need to have the same 
version of Blender you used to create your game. Jan Albartus (L0GAN) created a script to export different runtimes 
(executables). See these 2 URLs for more information.

http://www.albartus.com/blendstarter/
http://www.blendenzo.com/faqMakeExe.html

GNU Free Documentation License
Version 1.2, November 2002

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other functional and useful document "free" in the sense of 
freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially 
or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while 
not being considered responsible for modifications made by others.

This License is a kind of "copyleft", which means that derivative works of the document must themselves be free in the same 
sense. It complements the GNU General Public License, which is a copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software needs free documentation: 
a free program should come with manuals providing the same freedoms that the software does. But this License is not limited to
software manuals; it can be used for any textual work, regardless of subject matter or whether it is published as a printed book. 
We recommend this License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright holder saying 
it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free license, unlimited in 
duration, to use that work under the conditions stated herein. The "Document", below, refers to any such manual or work. Any 
member of the public is a licensee, and is addressed as "you". You accept the license if you copy, modify or distribute the work 
in a way requiring permission under copyright law.

A "Modified Version" of the Document means any work containing the Document or a portion of it, either copied verbatim, or 
with modifications and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of the Document that deals exclusively with the 
relationship of the publishers or authors of the Document to the Document's overall subject (or to related matters) and contains 

Copyright (C) 2000,2001,2002  Free Software Foundation, Inc.
51 Franklin St, Fifth Floor, Boston, MA  02110-1301  USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.
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nothing that could fall directly within that overall subject. (Thus, if the Document is in part a textbook of mathematics, a 
Secondary Section may not explain any mathematics.) The relationship could be a matter of historical connection with the 
subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The "Invariant Sections" are certain Secondary Sections whose titles are designated, as being those of Invariant Sections, in the 
notice that says that the Document is released under this License. If a section does not fit the above definition of Secondary 
then it is not allowed to be designated as Invariant. The Document may contain zero Invariant Sections. If the Document does 
not identify any Invariant Sections then there are none.

The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice 
that says that the Document is released under this License. A Front-Cover Text may be at most 5 words, and a Back-Cover Text
may be at most 25 words.

A "Transparent" copy of the Document means a machine-readable copy, represented in a format whose specification is 
available to the general public, that is suitable for revising the document straightforwardly with generic text editors or (for 
images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable 
for input to text formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made 
in an otherwise Transparent file format whose markup, or absence of markup, has been arranged to thwart or discourage 
subsequent modification by readers is not Transparent. An image format is not Transparent if used for any substantial amount 
of text. A copy that is not "Transparent" is called "Opaque".

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input 
format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML, PostScript or PDF designed 
for human modification. Examples of transparent image formats include PNG, XCF and JPG. Opaque formats include 
proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or 
processing tools are not generally available, and the machine-generated HTML, PostScript or PDF produced by some word 
processors for output purposes only.

The "Title Page" means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the 
material this License requires to appear in the title page. For works in formats which do not have any title page as such, "Title 
Page" means the text near the most prominent appearance of the work's title, preceding the beginning of the body of the text.

A section "Entitled XYZ" means a named subunit of the Document whose title either is precisely XYZ or contains XYZ in 
parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific section name mentioned 
below, such as "Acknowledgements", "Dedications", "Endorsements", or "History".) To "Preserve the Title" of such a section 
when you modify the Document means that it remains a section "Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the Document. 
These Warranty Disclaimers are considered to be included by reference in this License, but only as regards disclaiming 
warranties: any other implication that these Warranty Disclaimers may have is void and has no effect on the meaning of this 
License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this 
License, the copyright notices, and the license notice saying this License applies to the Document are reproduced in all copies, 
and that you add no other conditions whatsoever to those of this License. You may not use technical measures to obstruct or 
control the reading or further copying of the copies you make or distribute. However, you may accept compensation in 
exchange for copies. If you distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering more than 
100, and the Document's license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and 

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P


Blender 3D: Noob to Pro - Beginner Tutorials/Print version - Wikib... http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P...

261 of 263 5.5.2007 21:39

legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers 
must also clearly and legibly identify you as the publisher of these copies. The front cover must present the full title with all 
words of the title equally prominent and visible. You may add other material on the covers in addition. Copying with changes 
limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim 
copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit 
reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a 
machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a computer-network 
location from which the general network-using public has access to download using public-standard network protocols a 
complete Transparent copy of the Document, free of added material. If you use the latter option, you must take reasonably 
prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus 
accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your 
agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of 
copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided 
that you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document, 
thus licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you must 
do these things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous 
versions (which should, if there were any, be listed in the History section of the Document). You may use the same title 
as a previous version if the original publisher of that version gives permission.
B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in 
the Modified Version, together with at least five of the principal authors of the Document (all of its principal authors, if it 
has fewer than five), unless they release you from this requirement.
C. State on the Title page the name of the publisher of the Modified Version, as the publisher.
D. Preserve all the copyright notices of the Document.
E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.
F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified 
Version under the terms of this License, in the form shown in the Addendum below.
G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document's 
license notice.
H. Include an unaltered copy of this License.
I. Preserve the section Entitled "History", Preserve its Title, and add to it an item stating at least the title, year, new 
authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled "History" in the 
Document, create one stating the title, year, authors, and publisher of the Document as given on its Title Page, then add 
an item describing the Modified Version as stated in the previous sentence.
J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, 
and likewise the network locations given in the Document for previous versions it was based on. These may be placed in 
the "History" section. You may omit a network location for a work that was published at least four years before the 
Document itself, or if the original publisher of the version it refers to gives permission.
K. For any section Entitled "Acknowledgements" or "Dedications", Preserve the Title of the section, and preserve in the 
section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.
L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the 
equivalent are not considered part of the section titles.
M. Delete any section Entitled "Endorsements". Such a section may not be included in the Modified Version.
N. Do not retitle any existing section to be Entitled "Endorsements" or to conflict in title with any Invariant Section.
O. Preserve any Warranty Disclaimers.
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If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no 
material copied from the Document, you may at your option designate some or all of these sections as invariant. To do this, add
their titles to the list of Invariant Sections in the Modified Version's license notice. These titles must be distinct from any other 
section titles.

You may add a section Entitled "Endorsements", provided it contains nothing but endorsements of your Modified Version by 
various parties--for example, statements of peer review or that the text has been approved by an organization as the 
authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to 
the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text 
may be added by (or through arrangements made by) any one entity. If the Document already includes a cover text for the same 
cover, previously added by you or by arrangement made by the same entity you are acting on behalf of, you may not add 
another; but you may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to
assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in section 4 above 
for modified versions, provided that you include in the combination all of the Invariant Sections of all of the original 
documents, unmodified, and list them all as Invariant Sections of your combined work in its license notice, and that you 
preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with 
a single copy. If there are multiple Invariant Sections with the same name but different contents, make the title of each such 
section unique by adding at the end of it, in parentheses, the name of the original author or publisher of that section if known, 
or else a unique number. Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of 
the combined work.

In the combination, you must combine any sections Entitled "History" in the various original documents, forming one section 
Entitled "History"; likewise combine any sections Entitled "Acknowledgements", and any sections Entitled "Dedications". You 
must delete all sections Entitled "Endorsements."

6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this License, and replace the 
individual copies of this License in the various documents with a single copy that is included in the collection, provided that 
you follow the rules of this License for verbatim copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this License, provided you insert
a copy of this License into the extracted document, and follow this License in all other respects regarding verbatim copying of 
that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume 
of a storage or distribution medium, is called an "aggregate" if the copyright resulting from the compilation is not used to limit 
the legal rights of the compilation's users beyond what the individual works permit. When the Document is included in an 
aggregate, this License does not apply to the other works in the aggregate which are not themselves derivative works of the 
Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one 

http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P


Blender 3D: Noob to Pro - Beginner Tutorials/Print version - Wikib... http://en.wikibooks.org/w/index.php?title=Blender_3D:_Noob_to_P...

263 of 263 5.5.2007 21:39

half of the entire aggregate, the Document's Cover Texts may be placed on covers that bracket the Document within the 
aggregate, or the electronic equivalent of covers if the Document is in electronic form. Otherwise they must appear on printed 
covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 
4. Replacing Invariant Sections with translations requires special permission from their copyright holders, but you may include 
translations of some or all Invariant Sections in addition to the original versions of these Invariant Sections. You may include a 
translation of this License, and all the license notices in the Document, and any Warranty Disclaimers, provided that you also 
include the original English version of this License and the original versions of those notices and disclaimers. In case of a 
disagreement between the translation and the original version of this License or a notice or disclaimer, the original version will 
prevail.

If a section in the Document is Entitled "Acknowledgements", "Dedications", or "History", the requirement (section 4) to 
Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this License. Any 
other attempt to copy, modify, sublicense or distribute the Document is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights, from you under this License will not have their licenses 
terminated so long as such parties remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from time to time. 
Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. 
See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered 
version of this License "or any later version" applies to it, you have the option of following the terms and conditions either of 
that specified version or of any later version that has been published (not as a draft) by the Free Software Foundation. If the 
Document does not specify a version number of this License, you may choose any version ever published (not as a draft) by the
Free Software Foundation.
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